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Preface

This document describes how to create, configure and deploy adapter 
configurations using TIBCO ActiveMatrix Adapter Service Engine for SAP. 

Topics

• Related Documents, page viii

• Typographical Conventions, page x

• Terminology and Acronyms, page xii

• How to Contact TIBCO Support, page xiv
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Related Documents

This section lists documentation resources you may find useful.

TIBCO ActiveMatrix Adapter Service Engine for SAP Documentation

The following documents form the TIBCO ActiveMatrix Adapter Service Engine 
for SAP documentation set:

• TIBCO ActiveMatrix Adapter Service Engine for SAP Installation Read this 
manual to learn how to install TIBCO ActiveMatrix Adapter Service Engine 
for SAP.

• TIBCO ActiveMatrix Adapter Service Engine for SAP Configuration and 
Deployment This manual explains how to create and configure adapter 
projects. Information on deploying adapter projects is also included.

• TIBCO ActiveMatrix Adapter Service Engine for SAP Release Notes Read this 
document for information about new features, deprecated features, and open 
and closed issues.

Before TIBCO ActiveMatrix Adapter Service Engine for SAP can be installed and 
used, you have to install TIBCO ActiveMatrix Adapter for SAP. The following 
documents form the TIBCO ActiveMatrix Adapter for SAP documentation set:

• TIBCO ActiveMatrix Adapter for SAP Concepts Read this manual before reading 
any other book in the documentation set. This book describes the adapter, 
adapter features, and the applications that the adapter interacts with.

• TIBCO ActiveMatrix Adapter for SAP Installation Read this manual to learn how 
to install TIBCO ActiveMatrix Adapter for SAP.

• TIBCO ActiveMatrix Adapter for SAP Configuration and Deployment This manual 
explains how to create and configure standalone adapter projects. Information 
on deploying adapter projects is also included.

• TIBCO ActiveMatrix Adapter for SAP Examples This manual provides 
instructions to run the examples that demonstrate use of the adapter.

• TIBCO ActiveMatrix Adapter for SAP Release Notes Read this document for 
information about new features, deprecated features, and open and closed 
issues.

Other TIBCO Product Documentation

You may find it useful to read the documentation for the following TIBCO 
products. 
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• TIBCO ActiveMatrix BusinessWorks Service Engine

• TIBCO Runtime Agent™ 

• TIBCO ActiveMatrix® Service Grid

• TIBCO ActiveMatrix® Service Bus

• TIBCO Business Studio™

Third Party Documentation

• SAP R/3: Implementation Guide by Bradley D. Hiquet, available from 
Kelly-Lacey & Associates Inc. This is “A Manager’s Guide to Understanding 
SAP” that emphasizes the user’s point of view. Printed in 1998 by Macmillan 
Technological Publishing.

• SAP R/3 Business Blueprint by Thomas Curran and Gerhard Keller. Printed in 
1998 by Prentice Hall PTR.

• SAP R/3 System, A Client/Server Technology by Rudiger Buck-Emden. This is a 
general technical overview that is easy to read. Printed in 1996 by 
Addison-Wesley.
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Typographical Conventions

The following typographical conventions are used in this manual

Table 1   General Typographical Conventions

Convention Use

TIBCO_HOME 

ENV_HOME

AMX_HOME

Many TIBCO products must be installed within the same home directory. This 
directory is referenced in documentation as TIBCO_HOME. The value of 
TIBCO_HOME depends on the operating system. For example, on Windows 
systems, the default value is C:\tibco.

Other TIBCO products are installed into an installation environment. 
Incompatible products and multiple instances of the same product are installed 
into different installation environments. The directory into which such products 
are installed is referenced in documentation as ENV_HOME. The value of 
ENV_HOME depends on the operating system. For example, on Windows 
systems the default value is C:\tibco.

Other TIBCO products are installed into an installation environment. Products 
installed into different installation environments do not share components. 
Incompatible products and multiple instances of the same product must be 
installed into different installation environments. An installation environment 
consists of the following properties:

• Name Identifies the installation environment. The name is appended to the 
name of Windows services created by the installer and is a component of the 
path to the product in the Windows Start > All Programs menu. This 
directory is referenced in documentation as ENV_NAME. 

• Description Provides information about what the environment contains or is 
used for.

• Path The directory into which the product is installed. This directory is 
referenced in documentation as ENV_HOME. The value of ENV_HOME 
depends on the operating system. For example, on Windows systems the 
default value is C:\tibco.

TIBCO ActiveMatrix installs into a directory inside ENV_HOME. This directory is 
referenced in documentation as AMX_HOME. The value of AMX_HOME depends 
on the operating system. For example, on Windows systems the default value is 
C:\tibco\amx\.

TIBCO ActiveMatrix Adapter Service Engine for SAP is installed in a directory 
inside AMX_HOME.
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code font Code font identifies commands, code examples, filenames, pathnames, and 
output displayed in a command window. For example:

Use MyCommand to start the foo process.

bold code 

font 
Bold code font is used in the following ways:

• In procedures, to indicate what a user types. For example: Type admin. 

• In large code samples, to indicate the parts of the sample that are of 
particular interest.

• In command syntax, to indicate the default parameter for a command. For 
example, if no parameter is specified, MyCommand is enabled: 
MyCommand [enable | disable]

italic font Italic font is used in the following ways: 

• To indicate a document title. For example: See TIBCO BusinessWorks Concepts.

• To introduce new terms For example: A portal page may contain several 
portlets. Portlets are mini-applications that run in a portal.

• To indicate a variable in a command or code syntax that you must replace. 
For example: MyCommand pathname

Key 
combinations

Key name separated by a plus sign indicate keys pressed simultaneously. For 
example: Ctrl+C.

Key names separated by a comma and space indicate keys pressed one after the 
other. For example: Esc, Ctrl+Q.

The note icon indicates information that is of special interest or importance, for 
example, an additional action required only in certain circumstances.

The tip icon indicates an idea that could be useful, for example, a way to apply 
the information provided in the current section to achieve a specific result.

The warning icon indicates the potential for a damaging situation, for example, 
data loss or corruption if certain steps are taken or not taken.

Table 1   General Typographical Conventions (Cont’d)

Convention Use
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Terminology and Acronyms

Term Definition

ABAP Advanced Business Application Programming is a language in SAP used to 
write SAP specific code.

ALE/IDoc Application Link Enabling/Intermediate Documents.

API Application Program Interface.

Application Server The server on which the SAP processes run.

BAPI Business API (Functionally equivalent to RFC).

CIF Certified Intermediate Format.

Component A self-contained replaceable functional unit of the adapter that provides a set 
of interfaces. TIBCO ActiveMatrix Adapter Service Engine for SAP has two 
kinds of components; r3Outbound and r3Inbound. r3Outbound encapsulates 
functionality for outbound communication with the SAP system while 
r3Inbound encapsulates the functionality for inbound communication with 
the SAP system.

CPIC Common Programming Interface for Communications. Rarely used directly, 
it forms the basic communications interface of SAP. 

EDI Electronic Data Interchange.

EMS Enterprise Message Service

Gateway Server A server used to exchange data with the SAP system.

Inbound Instance An adapter configuration listening for messages inbound to the SAP system. 
Inbound instances transfer messages from the TIBCO environment to SAP.

Interface A functional sub-unit of the adapter that exposes one or more adapter 
services. For example, the RFCServer interface exposes RFC/BAPI 
Request-Response Invocation services.

JMS JAVA Messaging Service

MBCS Multi-byte character string.

One Way 
Invocation protocol

One way invocation protocol allows you to invoke the BAPI/RFC in the SAP 
system without waiting for a reply from the system.
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Outbound Instance An adapter configuration listening for messages outbound from SAP. 
Outbound instances transfer messages from SAP to the TIBCO environment.

RV TIBCO Rendezvous™ protocol; also in certain contexts refers to reliable 
message quality of service, as opposed to certified message.

RFC The SAP Remote Function Call Interface.

RFC Client A SAP term for any program that can post RFCs/BAPIs/IDocs from an 
external system into the SAP system.

RFC Server A SAP term for any external program that can accept and process 
RFCs/BAPIs/IDocs from the SAP system.

SAP Native data All SAP data that the adapter interacts with. It consists of RFC data types. 
This includes IDocs received as RFC tables in an RFC function call.

SSL Secure Sockets Layer.

TID Transaction ID. A globally unique identifier used by transactional RFCs to 
ensure exactly-once execution of a transaction.

TIDManager Transaction Identifier Manager.

Term Definition
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How to Contact TIBCO Support

For comments or problems with this manual or the software it addresses, please 
contact TIBCO Support as follows.

• For an overview of TIBCO Support, and information about getting started 
with TIBCO Support, visit this site:

http://www.tibco.com/services/support

• If you already have a valid maintenance or support contract, visit this site:

https://support.tibco.com

Entry to this site requires a username and password. If you do not have a 
username, you can request one.
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Chapter 1 Introduction

This chapter provides an introduction to TIBCO ActiveMatrix Adapter Service 
Engine for SAP.

Topics

• Overview, page 2

• Adapter Projects, page 3

• Adapter Service Engine Project Lifecycle, page 4
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Overview

TIBCO ActiveMatrix Adapter Service Engine for SAP is a gateway for TIBCO 
ActiveMatrix Adapter for SAP to the Service Oriented Architecture (SOA) world. 
The TIBCO ActiveMatrix Adapter Service Engine for SAP provides an 
ActiveMatrix container to deploy adapter projects using the TIBCO ActiveMatrix 
Administrator.

This manual describes the process of creating and configuring an adapter 
instance, packaging it into a service assembly and then deploying the services.

The design time tool used is TIBCO Business Studio and the services are deployed 
using TIBCO ActiveMatrix Administrator. 

Before proceeding you should familiarise yourself with the concepts and the 
terminology used by TIBCO ActiveMatrix Adapter for SAP and TIBCO 
ActiveMatrix platform

The folliwing figure shows the TIBCO ActiveMatrix product family

Figure 1   TIBCO ActiveMatrix Product Family
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Adapter Projects

Adapter projects contain adapter service engine configurations, related shared 
resources and business functionality that needs to be enabled for the functioning 
of the adapter service engines. Adapter projects are created using TIBCO Business 
Studio. See Creating Adapter Projects on page 11 for more information.

Adapter projects created using TIBCO Designer for the standalone component of 
the adapter, TIBCO ActiveMatrix Adapter for SAP can also be used by importing 
them into the TIBCO Business Studio environment. Importing Adapter Projects 
on page 13 provides more information on importing adapter projects.
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Adapter Service Engine Project Lifecycle

This section describes the high-level steps required to configure and deploy an 
adapter. Each of these steps are described in details in subsequent chapters. 
Adapter projects are configured using TIBCO Business Studio.

Configuration

Task A Create an Adapter Project 

The adapter project at this point contains the basic structure to which you later 
add adapter service engine configurations and configure connections to the SAP 
system

Task B Add an Adapter Service Engine Configuration

The adapter service engine configuration instance contains information about 
basic adapter configuration, adapter services, log sinks, and other settings.

See Configuring an Adapter Service Engine Instance, page 38 for more 
information.

Task C Configure Adapter Connections

One inbound connectionis created by default. The adapter communicates with 
the SAP system using this connection.

See Connection Resources, page 64 for more information.

Task A Configure the Vendor Application to work with the Adapter

This task is completed after installing the adapter and before configuring an 
adapter instance for the first time. The Business Object Importer is used to import 
schema from the SAP system into your project. The schemas are used by the 
adapter project.

See Using the SAP Business Object Importer, page 31 for more information.

Task D Add and Configure Adapter Services

For each adapter service that you create refers to a previously configured adapter 
connection and the schema to use. 

See Adapter Services, page 42 for more information.



 TIBCO ActiveMatrix Adapter Service Engine for SAP Configuration and Deployment

Adapter Service Engine Project Lifecycle | 5

Task E Create the Service Assembly

A service assembly is an unit of packaging in the ActiveMatrix world. Before you 
can deploy the adapter project it has to be packaged into a service assembly.

See Creating the Service Assembly and the Service Assembly Archive, page 144 
for more information.

Deployment

Task F Deploy and Start the Service Assembly

The service assembly is deployed using TIBCO ActiveMatrix Administrator.

See Deploying a Service Assembly Archive, page 151 for more information.
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Chapter 2 Working with TIBCO Business Studio

Topics

• Working with TIBCO Business Studio, page 8

• Creating Adapter Projects, page 11

• Importing Adapter Projects, page 13
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Working with TIBCO Business Studio

The TIBCO ActiveMatrix development tools consist of TIBCO Business Studio 
Workbench and a set of TIBCO ActiveMatrix plug-ins. This section describes how 
to start TIBCO Business Studio, create a new adapter Project, and import projects 
and files into the project. For information on TIBCO Business Studio, refer to the 
Workbench User Guide in the Workbench online help. To view the online help, 
select Help > Help Contents.

Starting TIBCO Business Studio

To start TIBCO Business Studio:
]

1. Execute one of the following platform-specific commands:

Microsoft Windows From the Start menu, follow the path All Programs > 
TIBCO > ENV_NAME > TIBCO Business Studio <version number> > TIBCO 
Business Studio. 

From the command line, run 
ENV_HOME/BusinessStudio/TIBCOBusinessStudio.exe.

UNIX Run TIBCO_HOME\BusinessStudio\TIBCOBusinessStudio.sh. 

2. The Workspace Launcher appears. Accept the default workspace or browse to 
a new workspace.

3. Click OK. 

4. TIBCO Business Studio displays a Welcome screen each time a new 
workspace is selected. Dismiss the screen by clicking the X next to Welcome. 
the following screen will be displayed:
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The screen contains the following area and views:

• Menu  See Help > Help Contents > Workbench User Guide.

• Toolbar See Help > Help Contents > Workbench User Guide.

• Project Explorer Displays a tree containing all the project resources such as 
project folders, shared resource definition files, WSDL files, composite files, 
service assembly files, and so on. 

• Editor Displays editors for the objects currently being edited. You switch 
between editors by clicking tabs at the top of the Editor area. The Composite 
Editor contains a canvas on which you can drop elements and a palette that 
organizes the elements that you can add to the composite. Other editors allow 
you to configure shared resources and service assemblies.

• Outline Provides a overview of the Composite Editor canvas. You can easily 
navigate from one part of a composite to another.

The Outline view also displays a content tree structure that contains the 
composite element inside the composite. In this view you can delete the 
contents of the composite. When you select a composite element in the 
Outline tree, the corresponding artifact in the composite becomes selected.

Editor

Notebook

Menu

Toolbar

Project
Explorer

Outline
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• Views Displays under the Editor Area. Contains the following views:

— Properties Displays property sheets for editing composites and composite 
elements. When you select a composite or composite element in the 
Composite Editor canvas, this view shows the properties of the selected 
object in a vertical tabbed notebook.

— Problems Displays validation and other errors.

— Registries Lists UDDI registries and the WSDL files returned from 
searching a registry.

You open a view by selecting Window > Show View > View.
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Creating Adapter Projects

To begin the configuration process, you must first create a project for the adapter.

To create a Adapter project:

1. Start TIBCO BusinessStudio.

2. Select File > New > Project> TIBCO ActiveMatrix Adapters > Adapter 
Project. 

3. Click Next. 

4. Type AdapterProjectName in the Project name field and click Next.

5. To specify custom names for Adapter Configurations and Shared Resources 
folders click Next.

To accept default values for the folder names, proceed to step 8

6. Specify a name for the Shared Resources folder and click Next.

7. Specify a name for the Adapter Configurations folder and click Next.

8. Click Finish. 

A new project is created with the following TIBCO Business Studio aspect folders:

• Adapter Configurations

• AESchemas

• defaultVars

• Shared Resources
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The following figure shows the structure of a project created using default values

Global variables are referred to as substitution variables.
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Importing Adapter Projects

Adapter projects created using TIBCO Designer can be imported into the TIBCO 
Business Studio environment. 

To import a Designer adapter project:

1. Select File>Import....

2. Select TIBCO ActiveMatrix Adapter > Import TIBCO Designer Projects.

3. Click Next

4. Choose between Select root directory and Select archive file. 

a. Click Browse...

b. Navigate to the folder where the Adapter project is located.

c. Click OK.

5. In the Projects pane, check the checkbox for the project you want to import as 
well as the services contained in the project.

The checkbox for the Copy projects into workspace checked by default and 
the projects are copied to the current workspace.
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6. Click Finish.

For information on the differences observed in the imported projects refer to 
Differences in Projects on page 160.
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Importing Projects into Workspace

Follow these steps to import projects created in another workspace to the current 
workspace: 

1. Select File > Import....

2. Select General > Existing Projects into Workspace.

3. Click Next.

4. Choose between Select root directory and Select archive file. 

a. Click Browse...

b. Navigate to the folder where the Adapter project is located.

c. Click OK..

5. In the Projects area, check the checkboxes next to the projects you want to 
import.

6. Check the Copy projects into workspace checkbox if you want to copy files 
belonging to the project into the current workspace..

7. Click Finish.
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Chapter 3 Getting Started

This chapter describes the pre-configured example that is packaged with the 
adapter.

Topics

• Working with the Example, page 18

• Running the Example, page 23
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Working with the Example

The GettingStarted example is available at: 
ENV_HOME\extensions\adsapse\samples.

This example contains two adapter configurations which between them contain 
all four adapter service configurations. The example helps show the interaction 
between the adapter and the SAP system.

The following sections describe the projects and the steps that were involved in 
creating them before providing information on how to run the example.

Import the example

1. Unzip the file.

In addition to the project files, the zip contains a folder SampleDataFiles. 
This folder contains files that are used when running the example.

2. Start TIBCO Business Studio.

3. Click Import > General > Existing Projects into Workspace.

The following projects are imported:

GettingStarted This contains the adapter service engine configurations and 
services.

GettingStartedSOA This contains the SOA artifacts for the adapter service engine 
project and the composites. This example references the following Java projects:

— com.tibco.SAPInbound.java 

— com.tibco.SAPOutbound.java
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The following figure shows the projects as seen in the Project Explorer view in 
TIBCO Business Studio.

View the business objects

The SAP schema, business objects, have been downloaded in the folder BAPI and 
IDOC. Open these folders and click on the .bo files to view the BOs (business 
objects).

The following figure shows the BOs contained in the 
BAPI_SALESORDER_GETLIST.bo.
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Adapter configurations

The GettingStarted project contains the following configurations:

• SAPAdapterInboundConfiguration

This configuration has two adapter services defined one RPC Server and one 
Subscriber.

• SAPAdapterOutboundConfiguration

This configuration has two adapter services defined one RPC Client and one 
Publisher.

Go through the configuration tabs for each configuration instance to see how they 
have been configured.

Configuring composites

The ActiveMatrix SOA project, GettingStartedSOA, has also been configured. The 
WSDL files generated for each of the adapter configurations refer to this SOA 
project.

For each WSDL, one composite is created. For each composite, add services. This 
is done by selecting the composite and selecting the Services tab.

Adding service elements

A Java component is added from the available Palette. There is one Java 
component for each composite. 

References to the adapter services are added and configured using the References 
tab.

References are made to the Java project by clicking on the Implementation tab 
and choosing the Class.
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The following figure shows the composite for the Inbound configuration and the 
associated Java component.

Each Java component has properties defined which can be seen by clicking on the 
Properties tab that appears below the Editor pane. The following figure shows 
the properties defined for the Java component for the Inbound configuration.

For the Inbound Java component, the following properties are created

• SubscriberInputFile

• BAPIServerRequestFile

• BAPIServerResponseFile

For the Outbound Java component, the following properties are created

• PublisherOutputFile

• BAPIClientRequestFile



TIBCO ActiveMatrix Adapter Service Engine for SAP Configuration and Deployment

22 | Chapter 3  Getting Started

• BAPIClientResponseFile

Values for these properties should be specified at the time of deployment.

After the configuration is complete, the service assemblies for each composite are 
created by right- clicking the composite and selecting Service Assembly.

Deploying the example

Each of the service assembly archives can be deployed using TIBCO ActiveMatrix 
Administrator.

Before you can deploy the service assembly archive make sure the nodes and 
containers that the service unit will deploy into are up and running. 

Upload the service assembly archives.

Specify values for the properties that were defined during the design phase. 
These properties specify the locations of the files used by the example and the 
locations where the response files will be written.

Deploy the service assembly archives.

Refer to the TIBCO ActiveMatrix Administrator documentation for detailed 
information on the deployment process.

If the absolute path is not specified, the bin folder for the node is considered as 
the root folder.

For example, if you configure the PublisherOutputFile variable as 
/ex/pubout.xml, the file is created in the /node/bin/ex/pubout.xml.
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Running the Example

The following sections describe how to run each of the configured services.

RPC Server

The SampleDatFiles folder contains a file, ServerReq.xml which is used by this 
example.

Edit this file and for the CUSTOMER_NUMBER and SALES_ORGANIZATION 
fields provide values that are available for your system.

When you save the file, the Java component reads the input file and sends the 
contained information to the SAP system.

The response from the SAP system is written to the response file. The following is 
a part of the response file:

<?xml version="1.0" encoding="UTF-8"?>

<ns:__caret_reply_caret_BAPI__SALESORDER__GETLIST_caret_BAPI__SALE

SORDER__GETLIST 

xsi:type="ns:__caret_reply_caret_BAPI__SALESORDER__GETLIST_caret_B

API__SALESORDER__GETLIST" 

xmlns:ae="http://www.tibco.com/xmlns/ae2xsd/2002/05" 

xmlns:ns="http://www.tibco.com/xmlns/ae2xsd/2002/05/ae/sap/basic/f

unctionModules" 

xmlns:ns1="http://www.tibco.com/xmlns/ae2xsd/2002/05/ae/SAPAdapter

40/classes" 

xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"><__caret_use

rClosure_caret_ 

xsi:type="ns1:RFCCLOSURE"><GUID/><bMore>0</bMore><maxRowCount>0</m

axRowCount><currentRowCount>0</currentRowCount></__caret_userClosu

re_caret_><RETURN><TYPE xsi:nil="true"/><CODE 

xsi:nil="true"/><MESSAGE xsi:nil="true"/><LOG__NO 

xsi:nil="true"/><LOG__MSG__NO>000000</LOG__MSG__NO><MESSAGE__V1 

xsi:nil="true"/><MESSAGE__V2 xsi:nil="true"/><MESSAGE__V3 

xsi:nil="true"/><MESSAGE__V4 

xsi:nil="true"/></RETURN><SALES__ORDERS><item><SD__DOC>0000000042<

/SD__DOC><ITM__NUMBER>000010</ITM__NUMBER><MATERIAL>DORITO</MATERI

AL><SHORT__TEXT>Doritos</SHORT__TEXT><DOC__TYPE>TA</DOC__TYPE><DOC

__DATE>20070322</DOC__DATE><REQ__QTY>20.000</REQ__QTY><REQ__DATE>2

0070322</REQ__DATE><PURCH__NO>po06</PURCH__NO><BATCH 

xsi:nil="true"/><VALID__FROM>00000000</VALID__FROM><VALID__TO>9999

1231</VALID__TO><BILL__BLOCK xsi:nil="true"/><DLV__BLOCK 

xsi:nil="true"/><SOLD__TO>CUST01</SOLD__TO><NAME>customer 01 - 

test</NAME><EXCHG__RATE>1.00000</EXCHG__RATE><DLV__QTY>0.000</DLV_

_QTY><BASE__UOM>EA</BASE__UOM><NET__PRICE>2.00</NET__PRICE><COND__

P__UNT>1</COND__P__UNT><COND__UNIT>EA</COND__UNIT><NET__VAL__HD>40

.00</NET__VAL__HD><NET__VALUE>40.00</NET__VALUE><DIVISION>01</DIVI

SION><DOC__STATUS>Not delivered</DOC__STATUS><SALES__GRP 

xsi:nil="true"/><SALES__OFF 

xsi:nil="true"/><SALES__ORG>0001</SALES__ORG><SALES__UNIT>EA</SALE

S__UNIT><SHIP__POINT>0001</SHIP__POINT><DISTR__CHAN>01</DISTR__CHA
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N><GI__DATE>20070322</GI__DATE><CURRENCY>USD</CURRENCY><PLANT>0001

</PLANT><STORE__LOC xsi:nil="true"/><ORD__REASON xsi:nil="true"/>

Subscriber

The SampleDatFiles folder contains a file, SubIn.xml which is used by this 
example.

Edit this file and for the SNDPRN, SNDPRT, RCVPRN, RCVPRT fields provide 
values that are appropriate for your system.

When you save the file, the Java component reads the input file and sends the 
IDoc to the SAP system.

You can verify that the IDoc was received in the SAP system by executing the 
we02 command. The following screen shows the result of executing the we02 
command.
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RPC Client

From the SAP system, execute the se37 command and then select the BAPI for 
BAPI_SALESORDER_GETLIST.

The request is received by the adapter which send a fixed response back to the 
SAP system.

Publisher

From the SAP system, execute the bd10 command. 

Specify values for the Material and Logical System fields, and send the IDoc.

On receiving the IDoc the adapter sends it to the Java component that writes it to 
the specified file. 
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The following is a part of the file that contains the IDoc received from the SAP 
system:

<?xml version="1.0" encoding="UTF-8"?>

<ns:MATMAS05-4x xsi:type="ns:MATMAS05-4x" 

xmlns:ae="http://www.tibco.com/xmlns/ae2xsd/2002/05" 

xmlns:ns="http://www.tibco.com/xmlns/ae2xsd/2002/05/ae/sap/basic/I

DOCS" 

xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"><EDI__DC><TA

BNAM>EDI_DC40</TABNAM><MANDT>500</MANDT><DOCNUM>0000000001411350</

DOCNUM><DOCREL>700</DOCREL><STATUS>30</STATUS><DIRECT>1</DIRECT><O

UTMOD>2</OUTMOD><EXPRSS xsi:nil="true"/><TEST 

xsi:nil="true"/><IDOCTYP>MATMAS05</IDOCTYP><CIMTYP 

xsi:nil="true"/><MESTYP>MATMAS</MESTYP><MESCOD 

xsi:nil="true"/><MESFCT xsi:nil="true"/><STD 

xsi:nil="true"/><STDVRS 

xsi:nil="true"/><STDMES>MATMAS</STDMES><SNDPOR>SAPBAM</SNDPOR><SND

PRT>LS</SNDPRT><SNDPFC 

xsi:nil="true"/><SNDPRN>SRILOG</SNDPRN><SNDSAD 

xsi:nil="true"/><SNDLAD 

xsi:nil="true"/><RCVPOR>A000000029</RCVPOR><RCVPRT>LS</RCVPRT><RCV

PFC xsi:nil="true"/><RCVPRN>ZKRISLOG</RCVPRN><RCVSAD 

xsi:nil="true"/><RCVLAD 

xsi:nil="true"/><CREDAT>20090212</CREDAT><CRETIM>170751</CRETIM><R

EFINT xsi:nil="true"/><REFGRP xsi:nil="true"/><REFMES 

xsi:nil="true"/><ARCKEY 

xsi:nil="true"/><SERIAL>20090212170245</SERIAL></EDI__DC><CHILDREN

><E1MARAM><item><FIELDS><EDI__DD><SEGNAM>E2MARAM006</SEGNAM><MANDT

>500</MANDT><DOCNUM>0000000001411350</DOCNUM><SEGNUM>000001</SEGNU

M><PSGNUM>000000</PSGNUM><HLEVEL>02</HLEVEL></EDI__DD><MSGFN>005</

MSGFN><MATNR>CORN</MATNR><ERSDA>20070321</ERSDA><ERNAM>SUNDAR</ERN

AM><LAEDA>20080602</LAEDA><AENAM>NIVEDITA</AENAM><PSTAT>KEDLBS</PS

TAT><MTART>ROH</MTART><MBRSH>1</MBRSH><MATKL>01</MATKL><MEINS>LBR<

/MEINS><BLANZ>000</BLANZ><BRGEW>0.000</BRGEW><NTGEW>0.000</NTGEW><

VOLUM>0.000</VOLUM><WESCH>0.000</WESCH><LAENG>0.000</LAENG><BREIT>

0.000</BREIT><HOEHE>0.000</HOEHE><ERGEW>0.000</ERGEW><ERVOL>0.000<

/ERVOL><GEWTO>0.0</GEWTO><VOLTO>0.0</VOLTO><FUELG>0</FUELG><STFAK>

0</STFAK><MHDRZ>0</MHDRZ><MHDHB>0</MHDHB><MHDLP>0</MHDLP><VPSTA>KE

DLBZXS</VPSTA><MSTDE>00000000</MSTDE><MSTDV>00000000</MSTDV><COMPL

>00</COMPL><GEWTO__NEW>0.0</GEWTO__NEW><VOLTO__NEW>0.0</VOLTO__NEW

><SLED__BBD>B</SLED__BBD></FIELDS><CHILDREN><E1MAKTM><item><FIELDS

><EDI__DD><SEGNAM>E2MAKTM001</SEGNAM><MANDT>500</MANDT><DOCNUM>000

0000001411350</DOCNUM><SEGNUM>000002</SEGNUM><PSGNUM>000001</PSGNU

M><HLEVEL>03</HLEVEL></EDI__DD><MSGFN>005</MSGFN><SPRAS>E</SPRAS><

MAKTX>Corn</MAKTX><SPRAS__ISO>EN</SPRAS__ISO></FIELDS></item></E1M

AKTM><E1MARCM><item><FIELDS><EDI__DD><SEGNAM>E2MARCM004</SEGNAM><M

ANDT>500</MANDT><DOCNUM>0000000001411350</DOCNUM><SEGNUM>000003</S

EGNUM><PSGNUM>000001</PSGNUM><HLEVEL>03</HLEVEL></EDI__DD><MSGFN>0

05</MSGFN><WERKS>0001</WERKS><PSTAT>EDLBS</PSTAT><EKGRP>001</EKGRP

><DISMM>ND</DISMM><PLIFZ>0</PLIFZ><WEBAZ>0</WEBAZ><PERKZ>M</PERKZ>

<AUSSS>0.00</AUSSS><BESKZ>F</BESKZ><MINBE>0.000</MINBE><EISBE>0.00

0</EISBE><BSTMI>0.000</BSTMI><BSTMA>0.000</BSTMA><BSTFE>0.000</BST

FE><BSTRF>0.000</BSTRF><MABST>0.000</MABST><LOSFX>0</LOSFX><AUSDT>

00000000</AUSDT><BEARZ>0.00</BEARZ><RUEZT>0.00</RUEZT><TRANZ>0.00<

/TRANZ><BASMG>0.000</BASMG><DZEIT>0</DZEIT><MAXLZ>0</MAXLZ><UEETO>

0.0</UEETO><UNETO>0.0</UNETO><WZEIT>0</WZEIT><VZUSL>0.00</VZUSL><U
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MLMC>0.000</UMLMC><LGRAD>0.0</LGRAD><OBJID>00000000</OBJID><MTVFP>

01</MTVFP><VRVEZ>0.00</VRVEZ><VBAMG>0.000</VBAMG><VBEAZ>0.00</VBEA

Z><TRAME>0.000</TRAME><FXHOR>000</FXHOR><VINT1>000</VINT1><VINT2>0

00</VINT2><LOSGR>0.000</LOSGR><KAUSF>0.00</KAUSF><TAKZT>0</TAKZT><

VRBDT>00000000</VRBDT><VRBFK>0.00</VRBFK><PREND>00000000</PREND><P

RENG>00000000</PRENG>
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Chapter 4 Configuring An Adapter Instance
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Overview

Each adapter instance contains one or more instances of the adapter service 
engine configuration. This configuration is accessed whenever an adapter 
application is started.

Configuration Tasks

A typical sequence of creating and configuring an adapter instance is as follows:

1. Using TIBCO Business Studio, create a new adapter project. 

Alternatively you can work with an imported project.

2. Add an SAP adapter service engine configuration.

3. Configure the InboundConnection. 

4. Download business objects (schema) from the SAP system.

5. Configure adapter service engine instance.

6. Create and configure services

7. Create an TIBCO ActiveMatrix SOA project.

8. Generate the WSDL into the SOA project.

9. Create composites.

10. Generate the service assembly.

The project is now ready for deployment.
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Using the SAP Business Object Importer

TIBCO ActiveMatrix Adapter  Service Engine for SAP introduces the concept of a 
business object. In the simplest sense a business object (BO) is the representation of 
the data model of the entities business entities like invoice, orders, customers, 
vendors.

For example, when the adapter connects to a SAP system, the business objects are 
the schema belonging to the IDocs and RFCs.

The business object also encapsulates the data, its attributes, types, functions and 
the operations as well as the relationships between other business objects.The 
schema that is downloaded can be used by adapter services in an adapter project. 

The Business Object (BO) importer is used to download IDocs, RFCs, and BAPIs 
from the SAP system. 

1. Select File > Import > TIBCO ActiveMatrix Adapter> Metadata> SAP 
Objects.

2. Click Next.

3. Enter a Name for the business object schema.

4. Click Browse button to choose the location where you want to save the 
schema.

5. Click OK.

6. Click Browse button to choose the Adapter Connection which is a previously 
configured client connection resource. 

7. Click OK.

8. Click Test Connection to verify the connection parameters.

If you are able to successfully connect to the SAP system, proceed to the next 
step by clicking Next.

If you are not able to successfully connect to the SAP system, you will have to 
exit out of the BO import.

9. In the SAP Browser Configuration dialog box, choose either RFC or IDOC in 
the Applications pane.

If using extended or custom IDocs, make sure you have released the IDoc 
segment before importing the schema.
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Figure 2   SAP Browser Configuration

If you choose RFC, specify values for the Name or the Group. 

The RFC Filter used to restrict the number of RFCs or BAPIs returned from the 
SAP system. The RFC Filter can be used to restrict the number based on the 
actual name of the RFC or BAPI. There is no restriction on the usage of *. 
Values like BAPI*ORDER are allowed.

If you choose IDOC, specify a value for the Filter. 

The IDoc filter used to restrict the number of IDocs returned from the SAP 
system. Values like CRE*01* cannot be used, the * can appear only at the 
beginning or the end of the expression. Example: MAT*

10. Click Fetch from Backend.

The SAP Business Objects pane lists the business objects that match the filter 
criteria as shown in the following figure:



 TIBCO ActiveMatrix Adapter Service Engine for SAP Configuration and Deployment

Using the SAP Business Object Importer | 33

Figure 3   SAP Browser Configuration: Choosing Business Objects

Narrow your filter criteria by adding characters to the filter name and then 
click Apply Filter. The filter is now applied to the fetched objects.

For example, if your initial filter criteria was ’*BAPI*, you could modify it to 
*BAPI_* to restrict the number of objects.

To specify a new filter name, enter the filter value and click Fetch from 
Backend.

11. Check the checkboxes for the SAP business objects that you want to choose 
and click Finish.

The selected SAP business objects are stored in the specified location in a named 
file with a .bo extension.

Using Filters

To download the list of BAPIs/RFCs with namespaces, you can enter the entire 
name of the RFC or give a partial filter in the RFC Filter. Ensure that the RFC 
Group Filter is blank.

To download a list of all BAPIs/RFCs with namespaces give RFC Filter as "/*" 
and leave the RFC Group Filter blank.

The default RFC Filter expression "*' does not download BAPI/RFCs with 
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namespaces.

The character '/' is a reserved character in the TIBCO environment. To support 
namespaces, the adapter performs a literal translation and replaces '/' with 
'__SLASH__'

The "/" in a BAPI or a RFC name in a namespace will be replaced with 
"__SLASH__" at design-time and saved to project with this name.

At run-time, the adapter replaces the "__SLASH__" with the "/" character in all its 
interactions with the SAP system.

Example: The RFC /tibco/MY_CUSTOM_RFC will be visible in the TIBCO 
environment as __SLASH__tibco__SLASH__MY_CUSTOM_RFC.

This applies to parameters referred to by the BAPI/RFC as well.
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SAP Business Object Viewer

Objects imported using the SAP Object Importer can be viewed using the SAP 
Business Object Viewer. The imported SAP business objects are stored in files 
with a .bo extension.

Double-click any .bo file from the Project Explorer view to display the contained 
SAP business objects. The following figure shows a sample screen of the SAP 
Business Object Viewer.

Figure 4   SAP Business Object Viewer: BAPI

The following figure shows a sample SAP Business Object Viewer screen 
displaying IDocs.

Figure 5   SAP Business Object Viewer: IDocs
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Creating an Adapter Service Engine Configuration

To create an adapter service engine configuration:

1. Right click the Adapter Configurations folder and select New>Other>TIBCO 
ActiveMatrix Adapters>Configurations> SAP Adapter.

2. In the File name field type the adapter configuration name or accept the 
default name.

3. Click Finish.

The following folders are created:

• SAPAdapterConfiguration_connections

• SAPAdapterConfiguration_genresources

Additionally the adapter configuration, ConfigName.adr3model is created, where 
ConfigName is the name of the adapter configuration. The configuration contains 
the following tabs:

• Configuration

• Log Sinks

• Adapter Services

• TIDManagement

• Valid Destinations

• SAP ConnectionPool Configuration

Configuring an Adapter Service Engine Instance on page 38 describes in detail the 
configuration process.

SAPAdapterConfiguration_connections

This folder contains the SAP Application Server Client Shared Resource which is 
created by default. This folder contains one inbound connection and one 
outbound connection created by default.

SAPAdapterConfiguration_genresources

This folder contains the following shared resources that are created by default:

• R3HawkDefault

• TIDManagerSession

• DefaultRVCMQSession
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• DefaultRVCMSession

• R3RVSession
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Configuring an Adapter Service Engine Instance

This section describes how to configure an instance of the adapter service engine:

• Configuration on page 39

• Adapter Services on page 42

• TIDManagement on page 51

• Valid Destinations on page 55

• ConnectionPools on page 57

• Log Sinks on page 61

Mandatory fields are indicated with an asterisk * and are marked in bold.
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Configuration

In this tab you provide basic information for the adapter. You can accept all 
defaults or specify new values.

Table 2   Adapter Configuration Tab

Field Description

SAP Adapter Configuration

Adapter Name (Read only) The value of this fields is set to SAPAdapter.

Instance Name (Read only) This is the name that was specified when creating the adapter configuration.

See Guidelines for Choosing an Adapter Configuration Name on page 40 for more 
information.

Description A short description of the adapter configuration.

Adapter 
Encoding

Choose between ASCII, ISO8859-1, ISO8859-2, ISO8859-5, ISO8859-7, ISO8859-8, 
ISO8859-9, UTF-8, Shift_JIS (CP943), Shift_JIS (TIBCO), Shift_JIS (932), KSC-5601, Big5.

Startup

Show Startup 
Banner

This field is enabled by default and indicates that the startup banner will be displayed at 
run time. The startup banner contains information about the runtime adapter version, the 
infrastructure version and the copyright information.

Clear this check box if you do not want the startup banner to be displayed. 

Monitoring

Enable Standard 
MicroAgent

Check this checkbox to enable the standard TIBCO Hawk microagent.

Allows you to turn on or off the standard TIBCO Hawk Microagent. 

Standard 
MicroAgent 
Name

The name for the standard microagent that will be registered with the TIBCO 
Hawk system. In most cases the default value is used.

Standard 
MicroAgent 
Timeout (ms)

The timeout for the standard microagent.

Enable Class 
MicroAgent

Check this checkbox to enable instance or class specific standard TIBCO Hawk 
Microagent. 
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Guidelines for Choosing an Adapter Configuration Name

• An adapter configuration name must use alphanumeric characters. An 
underscore (_) character can be used. The entire instance name must be less 
than 80 characters. The space character cannot be used in an instance name. 

• An adapter configuration name must be unique with respect to other adapter 
instances for the same adapter in the project. The same instance name can be 
used to name an adapter instance for a different adapter in the same project. 
For example, an SAP adapter instance named TEST and a Siebel adapter 
instance named TEST can coexist in the same project.

• Each adapter configuration name must be unique per adapter within a project 
even if each instance is defined in a different folder. That is, configuring 
same-named adapter instances in different folders will not make their names 
unique.

For more information on monitoring the adapter using TIBCO Hawk and the 
available microagent methods, see Monitoring the Adapter Using TIBCO Hawk 
on page 101.

The following figure shows an example of Configuration tab.

Class 
MicroAgent 
Name

The name for the class microagent that will be registered with the TIBCO Hawk 
system. In most cases the default value is used.

Class 
MicroAgent 
Timeout (ms)

The time out for the class microagent.

Default 
MicroAgent 
Session

(Read only) The value of this field is set to R3HawkDefault.

SAP Adapter 
Micro Agent 
Name

The name of the adapter microagent used to configure microagents specific to the 
adapter. The name specified appears in the TIBCO Hawk monitoring console and 
the methods associated with the microagent are made available. 

By default, the name is SAPAdapterMicroAgent.

Table 2   Adapter Configuration Tab

Field Description
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Figure 6   Adapter Configuration Tab
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Adapter Services

This page is used to create and configure the adapter services. The adapter 
provides the following services:

• Publisher, page 42

• Subscriber, page 45

• RPC Server, page 47

• RPC Client, page 49

Adding a Publisher

A publisher is used to publish an IDoc from an SAP system. 

A publisher is required for every IDoc that needs to be published. If the same 
IDoc must be published in different modes, a separate publisher is required for 
each mode. In cases where the mode is not explode, the service still needs to be 
associated with an IDoc although the IDoc schema will not be used.

An Outbound Connection and a ConnectionPool configuration is required for a 
Publisher and can be used by multiple Publishers.

To add a publisher, click Add Publisher and specify values for:

Table 3   Adapter Services: Publisher

Field Description

Publisher Configuration

Name Name and Description for the publisher.

Description

Log IDoc to 
Directory

This is the directory where the IDoc files will be saved.

Publication 
Mode

 Choose between explode and explodedbatch. 

Schema

Class Reference The schema of the BO referenced in the Class Reference from BO field.

Class Reference 
from BO

Select Browse from the menu t that appears on the right side of the Class Reference from 
BO field and choose from any of the previously imported BOs.
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The following figure show an example of a Publisher configuration.

Publication Modes

You can select from the publication modes available by using the drop-down box 
in the Publish Mode field.

The Mode options include:

• Explode means that the message is expanded and self-describing because it 
includes IDoc metadata. IDocs are initially received in compressed form as 

Enable Custom 
Scalars

Check this checkbox to enable custom scalars. 

Custom Folder The location of the custom folder.

IDOC Version This is the IDoc packaging format. 

From the drop-down list, choose whether the Idoc version is 4x or 3x.

Control Fields

See Using Control Fields on page 85 for more information.

Table 3   Adapter Services: Publisher

Field Description
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RFC tables. If multiple IDocs are received in a batch, then each IDoc in the 
batch is split from the other IDocs and sent individually.

The SAP system sends out data to the adapter with padded blanks wherever a 
field in the IDoc segment does not occupy the complete field length or a field 
is not populated at all.

By default, the adapter trims off the trailing spaces from blank padded fields, 
and cuts out blanks-only fields.

To override this behavior and allow the adapter to pass on all fields received 
from the SAP system as is to the TIBCO environment, you can specify the 
following parameter in the adapter properties file.

adr3.preserveFieldBlanks=ON

This flag causes the adapter not to trim any of the blank-padded fields or filter 
out empty fields coming from the SAP system.

• Exploded Batch means the message contains a batch of self-describing IDoc 
data, each IDoc in an exploded format. Using the Batched Explode mode, the 
adapter sends a batch of IDocs in the explode mode. Similarly on the 
subscriber side, the adapter receives the IDocs in a batch and processes them 
in SAP. This improves the performance of the adapter.

If the ALE outbound profile for an IDoc-type is set up to Collect IDocs, 
IDocs are collected within the SAP system till the packet size value is 
reached and then sent to the adapter in one shot.

The Exploded Batch publication mode ensures that individual IDocs are 
'exploded' to a self-describing format and also maintained as a batch. The 
batch of exploded IDocs is then published as one single message by the 
adapter.
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Adding a Subscriber

A subscriber is used to receive IDocs from the TIBCO environment and then send 
it to the SAP system. A separate subscriber is required for every IDoc to be sent to 
the SAP system.

To add a subscriber, click Add Subscriber and specify values for:

Table 4   Adapter Services: Subscriber

Field Description

Subscriber Configuration

Name Name and Description for the subscriber.

Description

Log IDoc to 
Directory

This is the directory where the IDoc files will be saved.

Receive IDocs 
in Exploded 
Batch Mode

Check this checkbox to receive IDocs in the exploded batch mode.

The default mode is explode.

Schema

Class 
Reference

The schema of the BO referenced in the Class Reference from BO field.

Class 
Reference from 
BO

Select Browse from the menu t that appears on the right side of the Class Reference from 

BO field and choose from any of the previously imported BOs

Enable 
Custom 
Scalars

Check this checkbox to enable custom scalars.

Custom Folder The location of the custom folder.

IDOC Version From the drop-down list, choose whether the Idoc version is 4x or 3x.
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The following figure show an example of a Subscriber configuration:
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Adding a RPC Server

An RPC server is used to invoke a RFC or BAPI, in the SAP system from the 
adapter. A separate RPC Server configuration is required for every RFC or BAPI.

To add a request response invocation service, click Add RPC Server and specify 
values for:

Table 5   Adapter Services: RFC Server

Field Description

RFC Server Configuration

Name The name and description of the RPC server.

Description

Client 
Connection 
Reference

The Client Connection Pool reference to use for the service.

Click the that appears on the tight side of the field and choose Browse to select a previously 
defined client connection.

Schema

Class Reference The schema of the BO referenced in the Class Reference from BO field.

Class Reference 
from BO

Select Browse from the menu t that appears on the right side of the Class Reference from 
BO field and choose from any of the previously imported BOs

Enable Custom 
Scalars

Check this checkbox to enable custom scalars.

Custom Folder The location of the custom folder.

Advanced Configuration

Commit 
Required

Check this checkbox if an external commit is required.

Commit Expiry 
(ms) 

The maximum time (in milliseconds) for the adapter to hold the transaction context for 
each invocation. Upon expiry of this time interval, the transaction context for an invocation 
is released. A commit/ rollback request for this invocation sent to the adapter after the 
commit expiry time will not be executed.

The default value is 6000ms.
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The following figure show an example of a RPC Server configuration:
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Adding a RPC Client

An RPC Client is used to invoke an RFC or BAPI from the SAP system to the 
adapter. A separate RPC Client is required for every RFC or BAPI to be invoked.

An Outbound Connection and a ConnectionPool configuration is required for a 
RPC Client and it can be used by multiple RPC Clients.

To add a RPC Client, click Add RPC Client and specify values for:

Table 6   Adapter Services: RPC Client

Field Description

RFC Client Configuration

Name The name and description of the RPC Client.

Description

Schema

Class 
Reference

The schema of the BO referenced in the Class Reference from BO field.

Class 
Reference from 
BO

Select Browse from the menu t that appears on the right side of the Class Reference from 
BO field and choose from any of the previously imported BOs

Enable 
Custom 
Scalars

Check this checkbox to enable custom scalars.

Custom Folder The location of the custom folder.
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The following figure show an example of a RPC Client configuration:
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TIDManagement

This page is used to configure information for connecting to the TID Manager. For 
information on setting up a TIDManager see TIDManager on page 76. The 
TIDManager uses RV or JMS for communication.

The setting in this pane can be modified only if a publisher has been defined.

Publisher TID Configuration

Specify values for the following fields:

Select local TID Management if there is only one adapter instance and is run in a 
single threaded mode using only one outbound connection.

The TIDManager uses the Program IDs defined in any server connections defined 
in the instance. If there are multiple instances sharing the same Program ID they 
must share the same TIDManager. Else, it is not possible to ensure that data is 
being sent only once from the SAP system.

Select Remote TIDManagement under the following scenarios:

• if the adapter is multi threaded, 

• if more than one adapter instance is used,

• if the adapter has multiple connections,

• if the adapter is load balanced. 

Table 7   TIDManagement: Publisher TID Configuration

Field Description

Publisher TID Configuration

TID 
Management 
Type 

Choose between local and remote.

Local TID Configuration

(displayed only when the TID Management Type is set to Local)

TID File Name The TID file used by the TIDManager to maintain state information on the 
transaction IDs (TID) sent from the SAP system.

By default, the name of the TID file is tidFile.tid.
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Subscriber TID Configuration

Specify values for the following fields:

Remote TID Configuration

(displayed only when the TID Management Type is set to Remote)

Subject The subject used by the TIDManager Server Session.

The default value is SAP.TIDMANAGER.INBOUND

Wire Format (read only)

Invocation 
Timeout (ms)

Table 7   TIDManagement: Publisher TID Configuration

Field Description

Table 8   TIDManagement: Subscriber TID Configuration

Field Description

Subscriber TID Configuration

TID 
Management 
Type 

Choose between none, local, and remote.

Local TID Configuration

(displayed only when the TID Management Type is set to Local)

TID File Name The TID file used by the TIDManager to maintain state information on the 
transaction IDs (TID) sent from the SAP system.

By default, the name of the TID file is tidFileInbound.tid.

Remote TID Configuration

(displayed only when the TID Management Type is set to Remote)

Retry Count The number of retries from the Adapter to the TIDManager server after which the 
adapter should conclude that the TIDServer is down.

Retry Interval The time interval in milliseconds between any two ping attempts to the TIDManager 
server. This will be used when the TIDManager server is unreachable.

Session 
Reference

The session reference to use for the remote TID configuration.
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Subject The subject used by the TIDManager Server Session.

The default value is SAP.TIDMANAGER.INBOUND

Wire Format (read only) Set to ActiveEnterprise.

Invocation 
Timeout (ms)

RV 

(displayed only when the Session Reference uses RV transport.

Subject The subject used by the RV reference.

Wire Format (Read only) The wire format is set to ActiveEnterprise Message.

JMS

(displayed only when the Session Reference uses JMS transport.

Destination The destination used by the JMS reference.

Delivery Mode Choose between:

Non-Persistent Messages are not stored and may be lost due to failure. 

Persistent Messages are stored and forwarded. 

TIBCO EMS Reliable  The server never sends the producer a receipt confirmation or 
access denial and the producer does not wait for it. Reliable mode decreases the 
volume of message traffic, allowing higher message rates. 

The default value is Non-Persistent.

Wire Format (Read only) The wire format is set to XML Message.

Table 8   TIDManagement: Subscriber TID Configuration

Field Description
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The following screen show the Publisher TID Configuration with the TID 
Management Type set to Local and the Subscriber TID Configuration with the 
TID Management Type set to Remote.
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Valid Destinations

Using this page you can configure the a list of destinations to which the IDocs will 
be sent. This list of destinations applies globally to all IDoc types that are sent 
from the SAP system or to the SAP system. Typically, these destinations are SAP 
logical system names, but they can be a bank identifier, a customer identifier, or 
any Partner Type currently configured. 

The RCVPRN field of an IDoc's control record specifies the receiving partner 
(destination) for the IDoc. If an IDoc's RCVPRN field has a value that is not 
configured as a valid destination, the IDoc is not published to the TIBCO 
environment. The IDoc will be logged (saved) into an ASCII text file under the 
configured directory. 

Follow these steps to configure a valid destination:

1. Click Add Destination in either the Publisher Valid Destinations section or 
the Subscriber Valid Destination section.

2. Specify values for the following parameters.
Table 9   Valid Destinations Configuration Parameters

You can delete a valid destination by highlighting it and clicking Delete 
Destination. 

As entries get saved, they are automatically converted to uppercase. This is 
done to ensure consistency with the syntax of logical systems in SAP. 

Field Description

Display Name The name 

Destination A valid destination for an IDoc.

Example TIBRVID.

Description Description of the configured destination.
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The following figure shows a sample configuration screen for valid destinations
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ConnectionPools

Adapter connections can be specified by configuring connection pools. A 
connection pool enables an adapter to efficiently share connection resources 
between different adapter threads. More than one connection pool may be 
specified. A connection pool may create, recycle or close a connection based on its 
frequency of use. Multiple adapter threads on the other hand may share the same 
connection between them. Connection pools allow optimal usage of available 
resource like memory, processor and threads.

For an inbound instance the connections are specified at the service level. This 
means, you can have different connections for different services. When the 
adapter instance is configured all the services have a default connection. You can 
add new connections to the adapter and then for each service specify one of the 
newly added connections. 

For an outbound instance, the server connections are specified at the instance 
level. The configured services can use all the connections created for the instance.

By default one client connection pool configuration, DefaultInboundConnection, 
is created. This configurations refer to the default shared connection references.

InboundConnection

This connection is created along with an adapter instance. It references the default 
inbound connection under SAPConnection_connections.

Click DefaultInboundConnection in the All ConnectionPool Configurations 
section to view the default values. You can modify any of the following 
parameters.

Table 10   Client ConnectionPool Configuration Parameters:

Field Description

Name The default value is DefaultInboundConnection.

Description A short description of the connection.

Maximum Connections The number of SAP connections in the client connection. By default, it is set to 1. 
A maximum of 99 connections is allowed.

The Max Connections option is used to configure the maximum number of 
threads in the adapter instance.
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Adding a Client ConnectionPool

To add a new client connectionpool configuration, click Add Client Connection 
Pool in the All ConnectionPool Configuration section and specify values for 
parameters listed in Table 10.

Figure 7   Connection Pool tab: Default Inbound Connection (Client Connection)

Retry Interval (ms) The time interval between two successive retries, in milliseconds. The 
default value is 30000ms.

Retry Attempts The maximum number of times the adapter will retry to establish a 
connection to the SAP system. By default, it is set to 3. This has to be 
greater than or equal to the value in the Number of retries before 
suspend field. 

Reconnection Attempts 
Before Suspend

The number of times the connection management process tries to 
connect to the application before the listener for a subscription or a 
one-way Request-Response invoke service is suspended. 

The default value for this field is 1.

Connection Configuration The connection reference to use for the inbound connection.

Field Description



 TIBCO ActiveMatrix Adapter Service Engine for SAP Configuration and Deployment

ConnectionPools | 59

OutboundConnection

To add a new server connectionpool configuration, click Add Server Connection 
Pool in the All ConnectionPool Configuration section and specify values for 
parameters listed in Table 11.

Table 11   Server ConnectionPool Configuration Parameters:

The following figure shows a sample Server ConnectionPool configuration.

Field Description

Name The default value is DefaultOutboundConnection.

Description The description of the connection.

Maximum Connections The number of SAP connections in the client connection. By default, it is set to 1. 
A maximum of 99 connections is allowed.

The Max Connections option is used to configure the maximum number of 
threads in the adapter instance.

Retry Interval (ms) The time interval between two successive retries, in milliseconds. The 
default value is 30000ms.

Retry Attempts The maximum number of times the adapter will retry to establish a 
connection to the SAP system. By default, it is set to 3. This has to be 
greater than or equal to the value in the Number of retries before 
suspend field. For retry to continue forever, set the value to -1.

Connection Configuration The connection reference to use for the outbound connection.
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Figure 8   Connection Pools tab: Server Connection Pool
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Log Sinks

In this tab specify the output destination (sinks) for the trace messages and set the 
tracing level for the roles selected 

Table 12   Log Sink Configuration Parameters

Field Description

File Sink

Name The name and description for the File sink.

Description

File Name The path and name of the trace file.

File Limit (bytes) Maximum size of the file, in bytes. 

The default value is 3000.

File Count The number of rollover files.The default value is 3.

Append Mode If checked, traces are added to the existing file at startup. If unchecked, the existing file is 
overwritten at startup if one of the same name exists. Only true and false are legal values. 

STDIO Sink

Name The name and description for the STDIO sink.

Description

Output Stream Choose between out and error.

Hawk Sink

The Hawk sink uses the hawk session, created and used by the adapter for monitoring purposes, to 
send tracing messages to the TIBCO Hawk monitor or Display.

Name The name and description for the Hawk sink.

Description

Microagent 
Name

Name of the microagent for traces from this Hawk sink. 
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Adding Roles to Sinks

Click the Add Log Sink Role button to add additional roles. You can add debug, 
error, warning, or informational roles to sinks by selecting the corresponding 
roles from the Role drop-down list.

Network Sink

The Network sink is used to publish tracing message. 

Name The name and description for the Network sink.

Description

Subject Subject of TIBCO Rendezvous messages to be sent. 

Session 
Reference

Click the Browse icon and select one of the previously defined sessions. 

General Options

Trace messages of the selected level(s) will be collected in the configured log sinks. You can 
configure what levels of trace messages you want logged. 

Log Info 
Messages

Check this checkbox to log Informational messages.

Log Debug 
Messages

Check this checkbox to log Debug messages.

This trace level is reserved and should not be enabled unless requested by the TIBCO 
Support. This trace level writes a lot of information to the log file and significantly reduces 
the speed of the adapter.

Log Warning 
Messages

Check this checkbox to log Warning messages.

Log Error 
Messages

Check this checkbox to log Error messages.

Table 12   Log Sink Configuration Parameters

Field Description
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Connection Resources

A connection resource represents a connection to an SAP Client or an SAP RFC 
Server. Connection references are stored in the SAPConnection_resources folder.

SAP Client Connections

The SAP client connections represent connections between the adapter and the 
SAP system where the adapter act as a client and the SAP system act as a server. 
These connections are used during design time and runtime. The subscriber 
service and the RPC Server service use client connections to communicate with 
the SAP system using RFC protocol.

• Dedicated Client Connection on page 65

• SAP Client INI File Connection on page 66

• SAP Adapter Message Server Connection on page 67

SAP Server Connections

These represent connections between the SAP system and the adapter where the 
adapter acts as server and the SAP System act as a client This connection reference 
is only used by the run time adapter. The publisher service and the RPC client 
service refer to the RFCServer connections. The SAP systems communicates to the 
adapter using this connection using the RFC protocol.

• SAP Server Connection on page 69

• SAP Server INI File Connection on page 69

Default Connection References

When an adapter instance is created, the following connection references are 
created by default:

• DefaultInboundConnection

This represents the connection between the adapter and the SAP system. 

Multiple server connections are required in those cases where an outbound 
adapter instance needs to connect to multiple Gateway Host servers or connect to 
SAP system using multiple Program IDs. 

See ConnectionPools for more information.
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See InboundConnection on page 57 for more information.

• DefaultOutboundConnection

This represents the connection between the adapter and the SAP system.

See OutboundConnection on page 59 for more information.

Dedicated Client Connection

This connection is created by default and represents a direct connection to the 
SAP system. This connection is used during design time by the BO importer. 

Table 13   SAP Dedicated Client Connection.

Field Description

Configuration

Name The name and description for the dedicated client connection.

Description

SAP Dedicated Client Connection

Application Server The network name of the host SAP application server machine.

If the SAP system is behind a firewall, the SAP router string should be 
mentioned along with the application server name.

System Number The SAP database instance number.

Client The SAP client number

User Name The valid user name and password to log into the SAP client specified.

Password

Language Select the language to be used when logging into the SAP system.

The selected value is only used during design time.

Code Page (read only) Value set to 1100

SAP application server code page. Set this to view IDoc/RFC /BAPI schema 
descriptions in non LATIN-1 character sets.

The selected value is only used by the non-unicode adapter at runtime.

Is Unicode Check the checkbox if this connection is to an Unicode SAP system.

Debug Settings

ABAP Debug Check the checkbox to turn on the ABAP Debug
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SAP Client INI File Connection

This connection uses the saprfc.ini file which contains information needed to 
connect to a SAP system. 

• The file must exist in the current working directory of the process making the 
connection request.

or 

• An environment variable named RFC_INI must be defined that points to the 
directory and filename.

The filename does not have to be saprfc.ini. Assuming that the file was named 
tibco.txt and it was located under the temp directory on the C drive, the 
environment variable would be defined with the value C:\temp\tibco.txt.

Appendix A on page 155 lists sample saprfc.ini files.

To add a SAP Client INI File Connection, click File > New> Other> TIBCO 
ActiveMatrix Adapters> Shared Resources> SAP Client (INI File).

Provide values for the parameters listed in the following table:

Table 14   SAP Client Connection (using INI File)

RFC Trace Check the checkbox to turn on the RFC Debug

Use SAPGUI Valid values are 0, 1, or 2.

The SAP GUI is launched only during the invocation of an RFC.

Field Description

Field Description

Configuration

Name Name and Description for the connection.

Description

SAP INI File Client Connection

Destination The destination application server name. Used in conjunction with the saprfc.ini 
file, the name defines the set of attributes to be retrieved from the INI file during 
the registration of the connection to SAP.

Client The SAP client number.
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SAP Adapter Message Server Connection

To use load balancing, the client machine initiating the request must have a 
service named sapmsXXX defined on the system, where XXX is the value of 
systemName. The default service value is 3600/tcp, and can be changed.

To add a SAP Adapter message Server connection, click File > New> Other> 
TIBCO ActiveMatrix Adapters> Shared Resources> SAP Message Server.

Provide values for the parameters listed in the following table:

Table 15   SAP Client (Message Server)

User Name The user name and password to log into the specified SAP client.

Password

Language The language to be used when logging into the SAP system.

The selected value is only used during design time.

Set this to view IDoc/RFC /BAPI schema descriptions in non LATIN-1 
character sets.

Code Page Value set to 1100

SAP application server code page.

The selected value is only used by the non-unicode adapter at runtime.

Is Unicode Check the checbox if this connection is to an Unicode SAP system.

Debug Settings

ABAP Debug Check the checkbox to turn on ABAP Debug

RFC Trace Check the checkbox to turn on the RFC Debug

Use SAPGUI Valid values are 0, 1, or 2.

The SAP GUI is launched only during the invocation of an RFC.

Field Description

Field Description

Configuration

Name Name and Description for the connection.

Description
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SAP Message Server Client Connection

Message Server  The message server used in conjunction with load balancing. For example, 
SAPSVR.

System Name The SAP R/3 system ID used in conjunction with load balancing. For example, 
TIB.

Logon Group The SAP logon group that is used in conjunction with load balancing. For 
example, PUBLIC.

Client The SAP client number.

User Name The user name and password to log into the specified SAP client.

Password

Language The language to be used when logging into the SAP system

The selected value is only used during design time.

Code Page (read only) Value set to 1100

SAP application server code page. Set this to view IDoc/RFC /BAPI schema 
descriptions in non LATIN-1 character sets.

The selected value is only used by the non-unicode adapter at runtime.

Is Unicode Check the checkbox if this connection is to an Unicode SAP system.

Debug Settings

ABAP Debug Check the checkbox to turn on ABAP Debug.

RFC Trace Check the checkbox to turn on RFC Debug.

Use SAPGUI Valid values are 0, 1, or 2.

The SAP GUI is launched only during the invocation of an RFC.

Field Description
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SAP Server Connection

To add a SAP RFC Server connection, click File > New> Other> TIBCO 
ActiveMatrix Adapters> Shared Resources> SAP Server.

Provide values for the parameters listed in the following table:

Table 16   SAP Server Connection

SAP Server INI File Connection

To add a SAP RFC Server connection, click File > New> Other> TIBCO 
ActiveMatrix Adapters> Shared Resources> SAP Server (INI File).

Provide values for the parameters listed in the following table:

Table 17   SAP RFC Server Connection (using INI File)

Field Description

Configuration

Name Name and Description for the connection.

Description

SAP RFC Server Connection

Program ID A valid existing program ID defined in the RFC destination inside the SAP 
system (sm59). The program ID identifies the RFC server program for the SAP 
system. 

Gateway Service The SAP gateway service. The default value is sapgw00

Gateway Host The gatewayHost name, IP address or router string. If there is no machine acting 
as a gateway host, it is the same as the application server

RFC Trace Check the checkbox to turn on RFC Debug

Field Description

Configuration

Name Name and Description for the connection.

Description
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SAP RFC Server INI File Connection

Destination The destination application server name. Used in conjunction with the saprfc.ini 
file, it defines the set of attributes to be retrieved from the INI file during 
registration of the connection to SAP.

Field Description
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Working with Substitution Variables

Substitution variables provide an easy way to set defaults for use throughout 
your project. You can override these values at runtime using TIBCO ActiveMatrix 
Administrator.

When an adapter project is created, a file named defaultvars.substvar is 
automatically added to the project in the defaultVars folder. Table 18 lists and 
explains the predefined global variables.

To assign values to the predefined default variables:

1. From the Project Explorer view, double click defaultVars > 
defaultVars.substvars

The list of predefined variables is listed.

2. Click on a variable.

The Details pane lists properties of the selected variables.

3. Specify the Value for the variable.

4. Save the project.

Table 18   Predefined Variables

Variable Description

AppServer The network name of the SAP application server host machine. 

If the SAP system is behind a firewall, then the SAP router string 
should be mentioned along with the application server name.

Client SAP client number. 

CodePage SAP application server code page. Set this to view IDoc/RFC 
/BAPI schema descriptions in non LATIN-1 character sets in 
TIBCO Designer.

Deployment This maps to adapter project name in TIBCO Business Studio for 
new projects. But the name takes effect first time you add an SAP 
adapter configuration.

DirLedger Specifies the path name of the TIBCO Rendezvous certified 
messaging ledger file. The default is the root installation 
directory.

DirTrace Specifies the path name for log file used by the adapter. The 
default is the root installation directory. 
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Domain The default value for file-based local projects is MyDomain. The 
value for server-based projects is the domain to which the project 
was saved.

GatewayHost The gatewayHost name or IP address or router string. If there is 
no specified machine acting as a gateway host, this is the same as 
the Appserver. 

GatewayService The SAP gateway service. The default value is sapgw00. 

HawkEnabled Indicates whether TIBCO Hawk is used to monitor the adapter. 
True indicates that a TIBCO Hawk microagent is defined for the 
adapter. False indicates the microagent is not to be used. 

JmsProviderUrl Tells applications where the JMS daemon is located. Setting this 
value mostly makes sense in early stages of a project, when only 
one JMS daemon is used.

JmsSslProviderUrl Specifies applications where the JMS SSL daemon is located. 

Password Valid password corresponding to the user name. 

ProgramID Valid existing program ID that identifies the RFC Server program 
for the SAP system. 

RemoteRvDaemon TIBCO Rendezvous routing daemon (rvrd) to be used. See 
TIBCO Administrator Server Configuration Guide for details about 
setting up a domain using rvrd.

RvaHost Computer on which the TIBCO Rendezvous agent runs. This 
variable is only relevant if you are using the TIBCO Rendezvous 
Agent (rva) instead of the TIBCO Rendezvous daemon, and if 
you have configured a non-default setup. See TIBCO Rendezvous 
Administration for details about specifying the rva parameters.

RvaPort TCP port where the TIBCO Rendezvous agent (rva) listens for 
client connection requests. See TIBCO Rendezvous Administration 
for details about specifying the rva parameters. Defaults to 7501.

RvDaemon TIBCO Rendezvous daemon. Sessions use this daemon to 
establish communication. The default value is 7500.

Table 18   Predefined Variables

Variable Description
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RvNetwork TIBCO Rendezvous network. This variable need only be set on 
computers with more than one network interface. If specified, the 
TIBCO Rendezvous daemon uses that network for all outbound 
messages. 

In most cases, you can leave the default. 

RvService TIBCO Rendezvous service. The Rendezvous daemon divides the 
network into logical partitions. Each transport communicates on 
a single service. A transport can communicate only on the same 
service with other transports. 

Unless you are using a non-default TIBCO Rendezvous 
configuration, you should leave the default (7500). 

SystemNumber SAP database instance number. 

TIBHawkDaemon TIBCO Rendezvous daemon used in the TIBCO Hawk session. 
See the TIBCO Hawk Installation and Configuration manual for 
details about this parameter. 

TIBHawkNetwork TIBCO Rendezvous network used by the TIBCO Hawk session. 
See the TIBCO Hawk Installation and Configuration manual for 
details about this parameter.

TIBHawkService TIBCO Rendezvous service used by the TIBCO Hawk session. 
See the TIBCO Hawk Installation and Configuration manual for 
details about this parameter.

UserName Valid user name to log into the SAP client specified.

Table 18   Predefined Variables

Variable Description
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Chapter 5 Advanced Features

This chapter describes advanced features for TIBCO ActiveMatrix Adapter  
Service Engine for SAP.

Topics

• TIDManager, page 76

• Handling Large Internal Tables from SAP, page 77

• Program Internalization, page 80

• Managing Logging, page 84

• Using Control Fields, page 85

• Inbound BAPI Transactional Support, page 86

• Invoking BAPIs/RFCs Using Transactional Semantics in SAP, page 89

• Multithreading, page 91

• Multiple Connections, page 92

• Connecting an Adapter Instance to Two SAP Systems Using a Single Connection, 
page 97
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TIDManager

The Transaction Identity Manager (TIDManager) is used to ensure exactly-once 
delivery when tRFCs or IDocs are exchanged with the SAP system. The 
TIDManager component ensures that no transactional data is lost or duplicated in 
case of communication errors between the adapter and the SAP system.

The TIDManager server configuration is required in one of the following two 
scenarios:

• Outbound Configurations — Scenario where multiple publication service 
configurations (for IDocs) or Request-Response Invocation service 
configurations (for tRFCs) use the same program IDs and running in a load 
balanced fashion.

• Inbound Configurations — Scenarios where multiple Subscription service 
configurations (for IDocs) or Request-Response service configurations (for 
tRFCs) run in a load-balanced fashion.

Outbound configurations sharing the same program ID should reference the same 
remote TIDManager server configuration.

The TIDManager is configured using the standalone adapter. The standalone 
adapter project that includes a TIDManager instance is deployed using TIBCO 
Administrator.

Refer to TIBCO ActiveMatrix Adapter for SAP Configuration and Deployment for 
information on configuring and deploying an instance of the TIDManager.

The TIDManagement tab of the adapter service engine configuration contains 
parameters used to communicate with the TIDManager.

If more than one TIDManager is maintained for the same Program ID, once-only 
delivery from SAP cannot be guaranteed.
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Handling Large Internal Tables from SAP 

Certain BAPIs/RFCs configured as Request-Response services query the SAP 
system based on specific search criteria. Depending on the queries executed in the 
SAP system, the records retrieved by the adapter could vary between a few to 
many hundreds. Example: BAPI_SALESORDER_GETLIST returns the list of sales 
orders for a given customer within specific dates for a sales organization to the 
TIBCO environment.

The adapter allows you to retrieve controlled number of records for convenience 
and easy processing and handling at the speed of requesting client-side in the 
TIBCO environment. The BAPI itself is executed only once in the SAP system. The 
adapter caches the entire result set retrieved from the SAP system, say 1000 sales 
orders, and splits the 1000 sales orders into multiple chunks.

The client can make multiple requests to the adapter to retrieve each chunk. The 
cache maintained by the adapter can be browsed in the forward and backward 
directions. The adapter also indicates to the client by means of a return variable 
whether all chunks have been returned or not. The adapter also allows you to 
clear the maintained cache from the client.

A typical usage would be displaying of Salesorders from the SAP system to 
multiple users on Web-browsers over the internet. Each user specifies the number 
of salesorders to be displayed on each screen and navigates using Previous and 
Next buttons. The client-side only converts the user actions into suitable requests 
to the adapter and formats the data chunks. This feature is called data chunking.

Enabling Data-Chunking 

To enable data-chunking, you must set appropriate attributes in the closure 
argument in the userClosure attribute of the request class. The userClosure 
class is a packet that is associated with the actual application request from the 
client and defines the nature of the actual request to the adapter.

The adapter provides a userClosure class, RFCCLOSURE. This class contains 
attributes for defining data-chunking requests.

The RFCCLOSURE class is included by default in every Repository project 
containing a TIBCO ActiveMatrix Adapter  Service Engine for SAP configuration 
and is available under in the adapter project tree in 
/AESchemas/ae/SAPAdapter40/classes.schemamodel.

The following table lists the input and output parameters for the RFCCLOSURE 
class. The input parameters should be set by the client for every data-chunking 
request and the output parameters are returned to the client based on which the 
client takes necessary action. 
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Table 19   Input Parameters for RFCCLOSURE 

Name Description Valid Values

GUID A globally unique identifier. This associates the 
client request with adapter-side cache. Each 
cache is identified solely by the GUID passed by 
the client.

Unique String

bUseCache Identifies if the request from the client is a 
data-chunking request. When this is set, caching 
is turned on in the adapter.

Boolean (0/1)

packetSize The number of records the adapter should send 
back to the client in the reply. If multiple tables 
are returned from the SAP system with different 
number of records, then every table in the reply 
will contain those many rows specified by the 
packetSize. If the number of remaining rows is 
less than the packetSize for a table, that table 
returns all the remaining rows.

If there are multiple tables in the reply and if all 
the records for a table have been sent, the next 
invocation would not contain any records for 
that table.

An integer number

cacheDirection Indicates to the adapter which direction to 
browse the cache in. A "forward" direction 
returns the next set of records in the cache. A 
"backward" direction returns the previous set of 
records from the cache. Defaults to "+" if not set.

Forward '+'Backward '-'

bClearCache Indicates to the adapter whether to clear the 
cache or not. This attribute is meaningful only 
for caches already created in the adapter. The 
GUID specifies which cache to clear. A separate 
request has to be made for each cache for the 
BAPI/RFC concerned. On receipt of the 
clear-cache request, the adapter simply clears 
the cache and returns a success message to the 
client.

Boolean (0/1)
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Table 20   Output Parameters for RFCCLOSURE

Also, note the following while enabling the client to make use of the 
data-chunking feature:

— Since browsing in the negative direction is possible at anytime during a 
chunking call sequence, the adapter does not automatically clear the cache 
after sending back all retrieved records. The cache is automatically cleared 
if a new chunking request is issued with cacheDirection attribute not set.

— The client has to explicitly clear the cache by setting the bClearCache 
attribute to true. A separate cache-clearing request has to be made for the 
same RFC/BAPI for which caching is enabled. The GUID associated with 
the cache should also be set to identify the cache to be cleared.

Name Description

bMore Indicates the status of the cache. If there are more chunks to be return to the 
client from the adapter cache, this returns true else false. The client can take 
necessary action based on this flag.

CurrentRowCount Maintains the current count of the rows returned to the client in a cache. For 
example, if there are 1000 records totally and packetSize is 100, and the 
adapter returns records 801-900 in the course of the chunking requests, 
currentRowCount is set to 900. In case records from multiple tables are 
returned, this attribute always indicates the row count of the table with the 
maximum records.

maxRowCount Maintains the total size of the cache in terms of records. For example, if 
there are 1000 records totally, maxRowCount is always set to 1000. In case 
records from multiple tables are returned, this attribute always indicates the 
size of the table with the maximum records.

If the cache is not cleared, the adapter memory usage will go up with each 
caching call.
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Program Internalization

This section describes Unicode and how to apply it using the adapter.

SAP Language Support

Single and Multi-byte Codepages

SAP provides multi-lingual support through simple single-byte codepage 
(ISO8859-1,ISO8859-2) and multi-byte codepage (like ShiftJIS, Big5 etc.) 
installations. 

Simple codepage installations of SAP cannot support characters outside of the 
codepage with which the system is installed.

Blended Code Pages

In order to support more languages from unrelated code pages, SAP introduced 
the notion of blended code pages. A SAP blended code page comprises characters 
from the intersection of two or more code pages and from a disjoint set of these 
code pages. Creating a code page in such a way allows users to use some 
characters from any of the code pages.

Unicode 

SAP Enterprise and higher versions of SAP support Unicode. A single Unicode 
installation of SAP can support all the characters defined by the Unicode 
character set.

Support for Non-Unicode SAP Systems

The Outbound adapter receives multi-byte character data from Non-Unicode SAP 
systems, converts it to Unicode, and passes on the data to the TIBCO 
environment. The conversion from multi-byte to Unicode is based on the 
logon-language and code page of the SAP user invoking the adapter from the 
SAP system.

The adapter supports single-byte, multi-byte and blended codepage installations 
of SAP. The adapter communicates to the Unicode and Non-Unicode SAP systems 
through the Unicode interface of the SAP RFC C++ libraries.
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The Inbound adapter receives character data in Unicode from the TIBCO 
environment, converts them to multi-byte character data based on the logon 
language and code page chosen for the adapter connection and passes on the data 
to the SAP system.

Support for Unicode SAP Systems

The Outbound and the Inbound adapters operate in a homogenous mode. They 
receive character data in Unicode from the SAP system or the TIBCO 
environment, and pass on the data to the target environment without any 
conversions for character data in the adapter.

Getting Ready to Run Unicode

Complete the following steps prior to running the adapter so that it can handle 
Character data correctly.

1. Configure inter-communication encoding 

The wire format encoding used for communication between adapters and 
TIBCO applications is determined by the encoding property set in the project. 

If an adapter configuration is saved in a local project, the inter-communication 
encoding is determined by the encoding property of the project file. The 
adapter requires the project encoding is set to UTF-8. This is irrespective of the 
character set being processed in the adapter and the SAP system the adapter 
connects to.

2. Configure adapter encoding for explosion of IDoc data in Publication services.

The adapter publication service receives IDoc data from the SAP system in 
Native RFC format. The Native format is then exploded into a self-describing 

Repo encoding is always UTF-8 in the TIBCO ActiveMatrix environment.

To communicate with other TIBCO components using the same encoding, the 
project file encoding property setting for all TIBCO components must be identical. 

At runtime, a set of Non-Unicode adapter binaries (adr3 and adr3u shared 
libraries .exe and adr3.tra) exists in the adapter which is compatible with the 
earlier 5.x releases of the adapter. This set of binaries can exchange data with 
Non-Unicode SAP systems only. To communicate with Unicode SAP systems and 
exchange data, you must use the Unicode executable adr3u.exe and adr3u.tra 
files. The Unicode binaries can communicate with Non-Unicode SAP systems as 
well.
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IDoc structure. The explosion is performed by chopping down the Native RFC 
table data into individual segments and individual fields under segments. To 
ensure correct explosion, perform the following configuration. 

This configuration step for publishing IDocs in exploded mode is required for 
IDoc data posted from Non-Unicode SAP systems only:

Configure the adapter for the appropriate encoding. To specify the encoding 
for the adapter configuration, navigate to the General tab, and choose an 
encoding from the drop-down. 

In the figure below, the adapter is configured for processing Shift-JIS character 
data, Shift JIS(932). The equivalent SAP code page value is "8000".

The setting maybe overridden from the adapter properties file by setting the 
adr3.encoding parameter. 

Example: adr3.locale=ibm-943

Refer to Table 21, “Encoding/Locale Table,” on page 82 for possible values.

The adapter does not perform any validation for the encoding value upon 
startup. Appropriate errors are thrown at run-time incase of conversion errors.

Table 21   Encoding/Locale Table

Character data-types in SAP IDoc/RFC/BAPI schema are single-byte 
representations. 

A field, say KUNNR in RFC_CUSTOMER_GET, of type char.10 means that the KUNNR 
field can hold 10 bytes of data. 

International characters belonging to multi-byte character sets can be 
accommodated only to the extent of the total number of bytes as specified in the 
schema description.

As an illustration, consider the field KUNNR in RFC_CUSTOMER_GET. The field can 
hold 10 characters of English data (single-byte), but can hold only 5 characters of a 
double-byte character set. When more than 5 double-byte characters are set to the 
KUNNR field, the field is not guaranteed to be processed completely.

Encoding/Locale Encoding Value

ASCII ascii

ISO8859-1 LATIN_1

ISO8859-2 ibm-912

ISO8859-5 ibm-915



 TIBCO ActiveMatrix Adapter Service Engine for SAP Configuration and Deployment

Program Internalization | 83

ISO8859-7 ibm-813

ISO8859-8 ibm-916

ISO8859-9 ibm-920

UTF-8 UTF8

Shift_JIS (CP943) ibm-943

Shift_JIS (TIBCO) tibx-943

Shift_JIS (932) tibx-932

KSC_5601 ibm-949

Big5 ibm-1370

GBK ibm-1386

Encoding/Locale Encoding Value
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Managing Logging

Trace messages are used to trace and troubleshoot an exception condition when 
an exception occurs at runtime.

You can configure the logging of trace messages using the TIBCO Common 
Logging framework by leveraging on the availability of Common Logging 
libraries in the ActiveMatrix environment. The Common Logging framework 
provides common messages and error codes that can be used across TIBCO 
products to log messages in a uniform manner. 

To enable the common logging feature, the following properties are used:

• application.ase.consoleoutput

• tibco.env.ADAPTER_ENABLE_CL

The following table describes the usage of these properties.

Property Values Behavior

application.ase.consoleoutput = false

tibco.env.ADAPTER_ENABLE_CL = false

The common logging feature is disabled and the 
trace messages are written to the adapter log 
files.

application.ase.consoleoutput = true

tibco.env.ADAPTER_ENABLE_CL = false

The common logging feature is disabled and the 
trace messages are displayed on the console.

When the application.ase.consoleoutput 
property is set to true, any value assigned to 
the tibco.env.ADAPTER_ENABLE_CL property 
is ignored.

application.ase.consoleoutput = false

tibco.env.ADAPTER_ENABLE_CL = true

The common logging feature is enabled.
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Using Control Fields

The following table lists, in alphabetical order, the available control fields.

The control fields are listed in the Control Fields pane of a publication service. The 
default values for the control fields are null.

To specify an new value,

1. Select the control field name.

2. Type a value in the corresponding Value field.

Table 22   IDoc Control Record Fields

Control Fields

ARCKEY CIMTYP CREDAT CRETIM STD

DIRECT DOCNUM DOCREL DOCTYP STDMES

EXPRSS IDocTYP MANDT MESCOD STDVRS

MESFCT MESTYP OUTMOD RCVLAD TEST

RCVPFC RCVPOR RCVPRN RCVPRT TABNAM

RCVSAD REFGRP REFINT REFMES

SERIAL SNDLAD SNDPFC SNDPOR

SNDPRN SNDPRT SNDSAD STATUS
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Inbound BAPI Transactional Support

An external system invoking a BAPI Request-Response service in the adapter has 
the choice to explicitly commit or rollback the changes applied to one or more 
business objects by the BAPI in the SAP system. The explicit commit or rollback is 
not a mandatory requirement for all BAPIs but is needed wherever the 
underlying BAPI in SAP is implemented this way.

For example, an invocation of BAPI_SALESORDER_CREATEFROMDAT2 in the SAP 
system from the adapter does not effect permanent changes to database till an 
explicit commit invocation is made with BAPI_TRANSACTION_COMMIT. 

Before configuring a BAPI Request-Response service for explicit commit, run 
through the checklist given below to ensure that the service really requires 
configuration for explicit commit.

Explicit configuration for this feature is required only when one or more of the 
following conditions are satisfied:

• The BAPI requires explicit commit/ rollback in the SAP system.

• Multiple connections are configured for the client, which invokes the BAPI in 
the SAP system.

• The adapter configuration is to be run in a load-balanced fashion.

To configure a BAPI RPC server for explicit commit, select the service and expand 
the Advanced Configuration pane.

1. Check the checkbox for the Commit Required field.

2. Select a value for the Commit Expiry field.

This field defines the maximum time, in milliseconds, for the adapter to hold 
the transaction context for each invocation of the BAPI. It starts from the 
moment the BAPI invocation in SAP is complete. Upon expiry of this 
time-interval, the transaction context for an invocation is released. A 
Commit/rollback request for this invocation sent to the adapter after 
commitExpiry will not be executed in the SAP system.

3. Configure the RPC server in the same configuration for the standard SAP 
commit/rollback BAPIs, API_TRANSACTION_COMMIT and 
BAPI_TRANSACTION_ROLLBACK.
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See the table given below for descriptions of these BAPIs.

Load-balanced configurations with BAPIs requiring explicit commit

The commit/rollback BAPI is required to be executed in the same adapter 
instance as the one that executes the BAPI requiring the commit/rollback. 

In load-balanced Inbound adapter configurations, it is not guaranteed that the 
commit/rollback BAPI invocation will be performed on the same adapter 
instance that received the invocation of the BAPI requiring commit. 

Exactly-once execution of commit/rollback in the SAP system from the correct 
adapter instance in a load-balanced setup is achieved as follows:

1. Configure the RPC Server for BAPI_TRANSACTION_COMMIT and 
BAPI_TRANSACTION_ROLLBACK.

2. Startup each instance of the adapter in the load-balanced configuration, 
setting the following parameter in the properties file adr3.commitid to a 
unique value for each instance.

The parameter value can be any unique string, and should not contain spaces.

Example: adr3.commitid=InstID001

adr3.commitid=InstID002

BAPI Task

BAPI_TRANSACTION_COMMIT • Ends current transaction

• Commits changes

• Initiates new transaction

BAPI_TRANSACTION_ROLLBACK • Ends current transaction

• Discards changes

• Initiates new transaction

If BAPI Commit is being used with multithreading feature of the adapter, then it 
is recommended that you use a separate session for servicing the BAPI Commit 
request.
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Sample Scenario

Assume a scenario where a sales order is to be created. Depending on the result 
the sales order will either be committed or rolled back using the appropriate 
external BAPI. When the sales order creation BAPI is sent to the adapter with the 
Commit Required flag enabled, the adapter instance generates a session ID, 
which is passed in the user closure (RFCclosure) argument of the reply schema. 
This session ID needs to be mapped to the request event of 
BAPI_TRANSACTION_COMMIT or BAPI_TRANSACTION_ROLLBACK and sent to the 
SAP system. 
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Invoking BAPIs/RFCs Using Transactional Semantics in SAP 

The BAPIs and RFCs can be invoked using transactional semantics in the SAP 
system.

The transactional semantics in SAP ensures data consistency and exactly-once 
execution, in case of exception situations (network outages or system failures) in 
SAP while the call is being executed.

Transactional RFCs (tRFCs) are always executed as one-way invocations and are 
best suited for transferring transactional data into the SAP in real-time. To execute 
a BAPI/RFC in a transactional mode, the BAPI/RFC has to be downloaded and 
saved to the adapter configuration as a one-way operation. 

Any one-way Request-Response service can be executed as a tRFC in SAP. To 
execute a one-way BAPI/RFC as a tRFC, each invocation of the BAPI/RFC 
should be accompanied by userClosure information, as defined in the class 
RFCCLOSURE under /AESchemas/ae/SAPAdapter40/classes.schemamodel.

The parameters that need to be set in the RFCCLOSURE class and sent along with 
each tRFC request are:

• bTransactional — This boolean variable determines whether the call must 
be invoked transactionally or not in SAP. Set this to true for a tRFC 
invocation.

• TID — Each tRFC invocation has to be carried out with a globally unique 
transaction identifier (TID) that uniquely identifies each tRFC invocation. 
Based on this parameter SAP internally ensures exactly-once invocation for 
the transaction associated with this TID. The sending system is responsible for 
generating and setting this parameter for each tRFC call.

With valid values for bTransactional and TID, a one-way Request-Response 
invocation is recognized as a tRFC call by the adapter and the call is invoked with 
transactional semantics in the SAP system.

Support for qRFCs

qRFC is an enhancement on tRFC. qRFC allows tRFC invocations to be handled 
sequentially in the target SAP system. The adapter allows external systems in the 
TIBCO environment to invoke tRFCs as qRFCs in the SAP system.

Ensure that the TID parameter is a non-null unique identifier for each tRFC 
invocation.
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Inbound qRFC

Any tRFC can be invoked as a qRFC in the inbound adapter. No design-time 
configuration is required. All parameters necessary to invoke a tRFC as a qRFC 
can be provided at run-time as part of the RFCCLOSURE class discussed in the 
previous section.

The qRFC parameters that have to be set in the RFCCLOSURE for performing a 
qRFC invocation in the SAP system are discussed below:

• bQueue

This boolean variable determines whether the call must be invoked as a qRFC or 
not in SAP. Set this to true for a qRFC invocation. This value is applicable only if 
the bTransactional attribute is also set to true.

• qName

Every qRFC invocation is made in the SAP system for a specific queue defined in 
the system. Set this field to indicate which queue the qRFC call is to be inserted 
into.

• qCount

This is the counter for the receiving queue in the SAP system. Specify unique 
integer values for each qRFC invocation inserting into a specific queue.

Outbound qRFC

Outbound qRFC calls can be invoked in the adapter from the SAP system. The 
adapter extracts the queue parameters for each qRFC invocation from the SAP 
system and appends them in the request's RFCCLOSURE class that is passed on to 
the TIBCO environment. 

The queue-name and queue-count values are extracted from the SAP system for 
each qRFC invocation. They are set to the qName and qCount attributes of the 
RFCCLOSURE class respectively. The attribute bQueue is set to true.

This allows receiving systems in the TIBCO environment to recognize 
tRFC/qRFC invocations made by the outbound adapter.
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Multithreading

Multithreading of an application allows the application to simultaneously process 
multiple, independent events. Multithreading is supported in both inbound and 
outbound instances. 

The number of threads required can be configured for each Client Connection 
(Inbound) and Server Connection (Outbound) by setting the value for the 
Maximum Connections field for each defined connection pool configuration. The 
number of threads can also be set through the adr3.maxconnections property in 
the adr3.tra file.

By default, every additional thread created is assigned a stacksize of 1.25MB. To 
avoid stack overflows at runtime, ensure that this stack limit is sufficient for the 
largest message that you would expect by sending out a single message of this 
size to the adapter. 

The stack size for an adapter configuration can be increased by specifying it as a 
parameter from the command-line during startup or in the adapter TRA file.

For example, to set the stacksize to 2MB, specify the following parameter in the 
TRA file, adr3.stacksize 2097152 or provide the following command line 
argument while starting up

Note that the stacksize value must be specified in bytes.

The number of threads should be equal to the number of connections required. 
The maximum limit is eight threads per client connection or server connection.

For details on setting up number of threads ConnectionPools on page 57 for more 
information.

To use the adapter in the multi threaded mode, the value specified for the Max 
Connections parameter for the RFC destination should match the value for the 
Max Connections parameter set in the adapter configuration file (.dat file).

This configuration change can be done using the transaction code SMQS. 
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Multiple Connections

The adapter can connect to multiple gateways or program IDs on the outbound 
side and multiple application servers on the inbound side. 

Posting BAPIs/RFCs/IDocs from multiple gateways in the Outbound Adapter

The SAP gateway enables communication between different SAP application 
servers or between an application server and an external program.

The host machine on which the SAP gateway resides is called the Gateway Host. 
Each SAP application server can communicate to external systems through its 
own gateway often residing on the same machine as the application server. 
Alternatively, the gateway process may also reside on a machine entirely different 
from the one where the application server runs. In such cases, multiple 
application servers can share the same gateway and the gateway host acts as a 
centralized gateway server.

The Outbound adapter can service requests to invoke or post BAPIs/RFCs/IDocs 
in the TIBCO environment from one or multiple SAP gateways. This is achieved 
by configuring the adapter for multiple Outbound connections. See 
ConnectionPools on page 57 for details.

Posting BAPIs/RFCs/IDocs from multiple RFC Destinations in the Outbound 
Adapter

From within a single SAP gateway, RFCs/BAPIs/IDocs are passed on to the 
Outbound adapter from RFC destinations. When an RFC/BAPI or an IDoc is 
executed on a specific RFC Destination, the SAP system passes on the request to 
the adapter registered on the Program ID that is mapped to the RFC Destination.

A single instance of the Outbound adapter can service RFCs/BAPIs/IDocs from 
multiple RFC destinations. This is achieved by configuring the adapter for 
multiple Outbound connections. Outbound Adapter Registering on Multiple 
Program IDs on One Gateway

Responding to dynamic changes in the Application Server environment 

Load balancing Outbound messaging on the SAP side is achieved by clustering 
multiple application servers under a central SAP Instance. 



 TIBCO ActiveMatrix Adapter Service Engine for SAP Configuration and Deployment

Multiple Connections | 93

The Outbound adapter can respond to dynamic changes to such clustered 
environments in terms of detecting addition or removal of application servers to 
or from the cluster. The Outbound adapter automatically registers itself with all 
active application servers in a cluster and receives and processes messages from 
the servers.

To achieve this, the Outbound adapter is to be run in conjunction with a discovery 
agent that is supplied with the adapter Run-time environment installation. The 
figure given next explains the steps involved in this dynamic discovery scenario. 
gw1, gw2 in the figure are the gateway hosts through which the SAP application 
servers communicate to the Outbound adapter.

Figure 9   Discovery Agent

The Discovery Process

The discovery agent is a special pre-configured Inbound adapter. The discovery 
agent is configured using the standalone adapter.

SAP
Application 

Servers

gw1 gw...ngw2

DiscoveryAgent

TIBCO 

ActiveMatrix 

Adapter Service 

Enginefor SAP 

Outbound 

Adapter

Poll SAP 

Instance. Query  

and construct list 

of active 

application 

servers

Publish 

Discovery 

Message
Subscribe to 

Discovery 

Message 

1

22

33

Connect to 

application server 

gateway hosts

44

SAP  Instance

Messaging

TIBCO Environment



TIBCO ActiveMatrix Adapter Service Engine for SAP Configuration and Deployment

94 | Chapter 5  Advanced Features

The discovery process involves the following steps, also schematically presented 
in the above figure.

1. Discovery Agent polls the central SAP instance, retrieves the list of application 
servers connected to the central Instance.

2. The discovery agent publishes the list as a message to the TIBCO 
environment. 

3. The Outbound adapter configuration(s) pick up the discovery message.

4. The Outbound adapter configurations(s) register on the gateway hosts of 
discovered application servers.

The Outbound adapter automatically disconnects from application servers that 
have gone down and cleans up connections after all attempts to retry to the 
application server are exhausted. The Outbound adapter does not create a new 
connection to a gateway host, if it is already connected to it.

Configuring the Outbound Adapter

The Outbound adapter does not need additional configuration to be able to 
respond to dynamic changes to the application server environment.

The following properties need to be set in the adapter launcher file to enable this 
feature for an Outbound adapter configuration.

• adr3.discovery — This property can be used to turn on/off the 
dynamic-discovery feature. The feature is commented by default. To turn it 
on, it needs to be uncommented.

• adr3.discovery.pid— This property allows you to specify the program-ids 
on which to register with the discovered application server's gateway. 
Multiple program-ids can be specified as comma-separated values.

Example:

adr3.discovery.pid=tibcotest

adr3.discovery.pid=tibcotest,idoctest

If the dynamic-discovery feature is turned on, this is a mandatory property. 
The adapter will exit on starting up with an appropriate error if this property 
is not specified.

• adr3.discovery.listenerSubject — This specifies the subject to listen on 
to subscribe to the discovery message published by the discovery agent. The 
discovery message contains the list of active application servers. If not 
specified, this property defaults to R3.APPSERVERS.ACTIVE

Ensure that the discovery-listener subject matches the publish subject on 
the discovery agent side.
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Example:

adr3.discovery.listenerSubject=APPSERVER.DISCOVERY.DYNAMIC

• adr3.discovery.listenerSession — This specifies the TIBCO 
Rendezvous or JMS session to be used by the discovery listener. 

Example:

adr3.discovery.listenerSession=MyDiscoverySession

A valid session by this name should be available in the project. If not 
specified, this property defaults to the default adapter session R3RVSession

• adr3.discovery.maxconnections —This property specifies the maximum 
number of connections that can be established to the gateway of each 
discovered application server. If not specified, it defaults to 1.

adr3.discovery.maxattempts

adr3.discovery.retryinterval

These parameters together define the behavior of the outbound adapter in the 
event of connection loss to a gateway. Connection loss could be due to 
network glitches or because of a planned shutdown. Because the adapter 
cannot distinguish between the two causes, it will behave in exactly the same 
way in both situations.

If an application server has been brought down because of a planned 
shutdown, it will still continue to establish a valid connection till all attempts 
are exhausted.

Example:

adr3.discovery.maxattempts=10

adr3.discovery.retryinterval=30000

Note that the retry interval must be specified in milliseconds.

If not specified, maxattempts defaults to 3, and retryinterval to 30000 
milliseconds.

Configuring the Discovery Agent

The discovery agent is a preconfigured Inbound adapter. The configured 
repository is available in the adapter bin directory as adr3Discoverer.dat.

Bring up the discovery-agent with the following command from command line

Do not open this configuration in TIBCO Designer. All parameters that may need 
to be customized are exposed in the launcher file, adr3Discoverer.tra.
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adr3 --propFile adr3Discoverer.tra

Configuring the Inbound Adapter for multiple application servers

Typically, an Inbound adapter is configured to connect to a messaging server 
belonging to a central SAP instance, which distributes load across multiple 
application servers. 

The Inbound adapter can also establish dedicated connections to multiple 
application servers that may not be part of a messaging server configuration. To 
achieve this, the Inbound adapter should be configured for multiple Inbound 
Connections in the TIBCO Designer palette. During configuration, ensure that 
each BAPI/RFC/IDoc Service configured points to that application server to 
which Inbound messages for that service are posted. 
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Connecting an Adapter Instance to Two SAP Systems Using a 

Single Connection

This section describes how to configure an adapter instance to connect to two SAP 
systems with a single connection.

Sample Scenario 

Assume a sample scenario with two SAP systems, one named CER and the other, 
LCM. Each has RFC destinations named RFCTEST with program id = RFCTEST 
(sm59 transaction). Assume also that you have configured an adapter instance 
(Outbound) to run on CER (for example). Refer to the following procedure to 
configure the other system (LCM) so that it can use the same SAP adapter 
instance.

Procedure

1. Log in to the second system, LCM, and invoke sm59 transaction. 

Figure 10   RFC Destinations
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2. Click on Find, and enter the name of your RFC Destination as shown in 
Figure 11. (This example assumes the name RFCTEST.)

Figure 11   Find RFC Destinations Screen

3. Click on Continue and the following screen appears:

Figure 12   RFC Destination RFCTEST Screen
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4. Enter the values for Gateway host and Gateway Service that corresponds to 
the system against which the adapter is already running (recall in this 
scenario, it is CER).

5. Save the destination.

6. Test the connection using the Test Connection button on the button bar. It 
should show OK.

When assigning a specific gateway host to an RFC destination, you must ensure 
that this gateway host is available at all times. Regardless of whether or not you 
are able to make an RFC request from another host, if the specified gateway host 
is unavailable, then the RFC request to the adapter will not be successful.
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Figure 13   Test Connection Button

Now, you're ready to run the adapter from the other system (LCM in our 
scenario).

However, the disadvantage in this scenario is that if the SAP system’s CER is 
down, the adapter instance cannot obtain messages from the other SAP system’s 
LCM. In a scenario where one instance of the adapter can connect to multiple 
program IDs of multiple SAP systems the problem does not arise.
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Monitoring the Adapter Using TIBCO Hawk

TIBCO Hawk is a sophisticated tool for enterprise-wide monitoring and 
managing of all distributed applications and systems. System administrators can 
use it to monitor adapters in a wide area network of any size. TIBCO Hawk can be 
configured to monitor system and adapter parameters and to take actions when 
predefined conditions occur. These actions include: sending alarms that are 
graphically displayed in the TIBCO Hawk display, sending email, paging, 
running executables, or modifying the behavior of a managed adapter. 

TIBCO Hawk is a purely event-based system that uses alerts. The agents are 
configured with rules that instruct them on everything from what and how to 
monitor to what actions to take when problems are discovered. Thus the 
workload is fully distributed throughout the enterprise. Every agent is 
autonomous in that it does not depend on other components to perform its 
functions. 

The TIBCO Hawk Enterprise Monitor consists of these components:

• Display—GUI front end that displays alarms and provides editors to create 
rule bases, create tests, view messages, and invoke microagents to request 
information or initiate an action. 

• Agents—Intelligent processes that perform monitoring and take actions as 
defined in rules. 

• Rulebases—Rules that are loaded by agents to determine agent behavior.

• Application Management Interface (AMI)—Manages network applications 
via TIBCO Rendezvous and supports communication between a network 
application and monitoring TIBCO Hawk agents, including the ability to 
examine application variables, invoke methods, and monitor system 
performance. 

• Microagents—Feed information back to TIBCO Hawk and expose action 
methods to rulebases. 

For more information on starting TIBCO Hawk, using the Display, invoking 
microagent methods, see the TIBCO Hawk documentation.
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Available Microagents

A set of default microagents is loaded when a TIBCO Hawk Agent is started. 
When you install and start the adapter, its microagents are dynamically added to 
the local agent. 

Each adapter has three microagents, a standard TIBCO Hawk microagent named 
COM.TIBCO.ADAPTER.xyz where xyz is the adapter configuration name, a custom 
microagent and a class microagent. The microagents provide:

• Business level statistics—statistics that report the progress of the adapter as it 
interacts with the vendor application. For example, in a database adapter such 
statistics might indicate whether objects were successfully or unsuccessfully 
inserted, updated, or deleted in the database.

• Queries that return information about the state of the adapter. This can be an 
important tool for seeing the internals of an adapter and debugging it if 
something appears wrong. For example, methods can return information 
about threads, internal queues, or connections to the target system. Using 
these methods, one might be able to identify certain bottlenecks or gauge how 
successfully an adapter is scaling with respect to the current environment.

• Updates of the adapter runtime parameters. This includes retrieving the 
current runtime parameters and setting new runtime parameters without 
restarting the adapter. An example of this is getting and setting the polling 
interval. Updating a runtime parameter through the Hawk microagent only 
affects the setting of the instance that is running. It does not make a 
permanent change of the setting in either the repository or the .tra file.

By default all microagents, custom, standard and class microagents are available 
at runtime.

The perfMon property value set in the adapter’s property file affects the business 
statistics related methods. If this property is set to on, the adapter does all the 
performance related calculations. When you invoke the methods, if the perfMon 
property is set to off, default values are displayed and not the valid values. 

You can disallow adding custom methods to the class microagent when 
deploying the adapter by changing the addCustomHawkMethodstoClassMAgent 
property value in the adapter’s property file. If this property is set to on, custom 
methods are added to the class microagents. If set to off, these methods are not 
visible. 

Custom microagents are deprecated in this release. All business statistics related 
methods which were part of the custom microagent are now available in the class 
microagent.
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The following table lists each method available for the adapter and page on which 
the method is explained.

Table 23   TIBCO Hawk Microagent Methods

Method Description Page

activateTraceRole() Activates a mapping of a role to a 
sink at runtime.

106

deactivateTraceRole() Deactivates a mapping of a roles to 
sinks at runtime.

107

getActivityStatisticsByOpera
tion(Operation)

Returns statistics about one 
operation.

108

getActivityStatisticsBySchem
a(SchemaName)

Returns statistics about any activities 
on a particular object or schema.

109

getActivityStatisticsByServic
e(ServiceName)

Returns statistics about the data 
handled by a particular adapter 
service since it was started.

110

getAdapterServiceInformati
on() 

Returns information about the 
services implemented by this adapter.

111

getComponents() Returns information about the 
publisher, subscriber and 
IODescriptor.

112

getConfig() Returns basic configuration 
information. More specific 
information is accessed by the more 
specific methods. 

113

getConfigProperties() Returns a list of publishers and 
subscribers.

114

getConfiguredRFCs() Returns a list of all configured RFC 
functions.

115

getConnectionStatistics() Returns the state and statistics for all 
the current connections used by the 
adapter.

116

getHostInformation() Returns standard and extended 
application information.

117
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getPerfMonSetting() Returns the setting of the perfMon 
option.

118

getQueueStatistics() Returns the current count of elements 
in any internal queue used by the 
adapter.

119

getRvConfig() Returns information about all TIBCO 
Rendezvous sessions defined. 

120

getStatus() Returns general status information, 
such as the number of TIBCO 
Rendezvous messages received and 
published, the number of errors since 
the last call, the PID of the 
application, and more. 

121

getThreadStatistics() Returns the operation counts of the 
current threads.

122

getTraceSinks() Returns information about sinks to 
which traces currently go.

123

getVersion() Returns the instance ID, application 
name, version, and date for this 
adapter instance. 

124

_onUnsolictedMsg() Displays alert messages sent to the 
current adapter.

125

preRegisterListener() Preregisters an anticipated listener. 126

refreshABAPContext() Refreshes the ABAP context held by 
the adapter connections.

127

resetActivityStatistics() Resets all the counts for the activity 
statistics.

128

resetConnectionStatistics() Resets all the counts for the 
connection statistics.

129

resetThreadStatistics() Resets all the counts for the thread 
statistics.

130

Table 23   TIBCO Hawk Microagent Methods (Cont’d)

Method Description Page
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reviewLedger() Returns information retrieved from 
the ledger file of a certified 
messaging session for a publisher 
adapter.

131

setTraceSinks() Adds a role or changes the file limit 
of a previously specified sink.

133

stopApplicationInstance() Stops the running adapter instance. 134

unRegisterListener() Unregisters a currently preregistered 
listener.

135

Table 23   TIBCO Hawk Microagent Methods (Cont’d)

Method Description Page
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activateTraceRole()

Activates a mapping of a role to a sink at runtime. This replaces the 
now-deprecated setTraceSink() TIBCO Hawk method.

Parameters Type Description

Role Name string Name of the role to activate.

Sink Name string Name of the sink for which to activate the role.
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deactivateTraceRole()

Deactivates a mapping of a roles to sinks at runtime.

Parameters Type Description

Role Name string Name of the role to activate.

Sink Name string Name of the sink for which to activate the role.
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getActivityStatisticsByOperation(Operation)

Returns the total number of objects processed for all the schemas by each service 
that is associated with a specified operation. Also, returns the number of success 
and error objects.

Parameter Type Description

Operation string Type of operation - read or write.

Returns Type Description

Service Name string Name of the service that is associated with the 
specified operation.

Total string Total number of objects processed for this schema 
for a publication service. 

Total number of objects received for this schema 
for a subscription service.

Success string The number of objects that were successfully 
identified for this schema which will be 
published or written to a file.

Error string The number of objects that were identified for this 
schema but were not published because the 
header of the schema failed validation for the 
publication service, or was written to a file 
because the schema was not associated with the 
subscriber for a subscription service.
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getActivityStatisticsBySchema(SchemaName)

Returns the total number of objects processed for the given schema by each 
service that uses the schema. Also, returns the number of success and error 
objects.

Parameter Type Description

Schema Name string Name of the schema.

Returns Type Description

Service Name string Name of the service that is associated with the 
specified schema.

Total string Total number of objects processed for this schema 
for a publication service. 

Total number of objects received for this schema 
for a subscription service.

Success string The number of objects that were successfully 
identified for this schema which will be 
published or written to a file.

Error string The number of objects that were identified for this 
schema but were not published because the 
header of the schema failed validation for the 
publication service, or was written to a file 
because the schema was not associated with the 
subscriber for a subscription service.
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getActivityStatisticsByService(ServiceName)

Returns the total number of objects processed for each of the schemas associated 
with the specified service. Also, returns the number of success and error objects.

Parameter Type Description

Service Name string Name of the service.

Returns Type Description

Operation string Type of operation that the service performs.

Schema Name string Name of the schema that is associated with the 
service.

Total string Number of objects processed for this schema for a 
publication service. 

Number of objects received for this schema for a 
subscription service.

Success string The number of objects that were successfully 
identified for this schema which will be 
published or written to a file.

Error string The number of objects that were identified for this 
schema but were not published because the 
header of the schema failed validation for the 
publication service, or was written to a file 
because the schema was not associated with the 
subscriber for a subscription service.
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getAdapterServicesInformation()

Returns information about the services implemented by this adapter. The 
information is a summary of available adapter services.

Parameter Type Description

Service Name string Name of the service from which to get 
information. Default is ALL.

Returns Type Description

Line integer Sequential row number.

Service Name string Name of the service as defined at design-time.

Endpoint Name string Name of the endpoint used for this service.

Type string Type of the endpoint, for example, publisher or 
subscriber.

Quality of 
Service

string Quality of service for the endpoint. For example 
RVCM or JMS Persistent.

Subject string Subject defined for this endpoint. 

Class string Class associated with the endpoint.

Number of 
Messages

integer Number of messages processed for this endpoint.
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getComponents()

Returns information about the currently active TIBCO Hawk components such as 
publishers, subscribers, or timers.

Parameters Type Description

Component Name string Name of the component. If no value is entered, 
all components display. 

Component Type string Any of Publisher, Subscriber, Timer, or 
IODescriptor. The default value is All.

Returns Type Description

Instance ID string Name of this adapter instance as defined at 
design-time. 

Adapter Name string Name of the adapter. 

Component Name string Name of the component.

Component Type string The name of the TIBCO Adapter SDK class for 
this component, such as MPublisher, 
MSubscriber, or MIODescriptorSource. For 
more information about the class, see your 
TIBCO Adapter SDK documentation.

Session Name string Name of the session.

Description string Information about this component, for 
example, time interval, signal type, validating 
publisher (or subscriber) etc. 
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getConfig()

Retrieves generic configuration information. More specific configuration 
information is accessed through separate methods.

Returns Type Description

Instance ID string Configuration ID of this adapter.

Adapter Name string Name of the adapter. 

Repository 
Connection

string URL of the repository used for adapter instance.

Configuration 
URL

string Location of the adapter project; either a file name 
or configuration URL. 

Command string Command line arguments used to start the 
adapter.
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getConfigProperties()

Returns all attributes and elements for the given repository object. 

Parameter Type Description

Property string Name of the property for which elements (tags) 
and attributes are desired. For example, 
agentone/startup. 

If no value is given, all properties are returned.

Returns Type Description

Element Name string Repository directory for the property.

Attribute Name string Name of the repository object attribute.

Attribute Value string Value of the repository object attribute.

Line integer Line number in which this property is defined 
in the project file. 
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getConfiguredRFCs()

Returns a list of all configured RFC functions.
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getConnectionStatistics()

Returns runtime statistics for the specified SAP connection pool. 

Parameter Type Description

Pool Name string Name of the SAP connection pool.

You can use the connection pool name that is 
returned by the getHostInformation() method.

Returns Type Description

SerialNo integer The sequence number of the connection pool.

Connection 
Name

string The name of the connection pool.

Connection Type string A type or key that will match this connection to 
a thread or queue.

Connection 
Status

string Current state: CONNECTED or 
DISCONNECTED. Returns UNKNOWN when 
perfMon property is set to off.

CurrentNumOpe
rations

integer Total number of operations processed by this 
connection since the last reconnection.

TotalNumOperat
ions

integer Total number of operations processed by this 
connection since the adapter started.

NumRetries integer Total number of times this connection had to be 
reestablished.
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getHostInformation()

Returns standard and extended application information set. It returns the 
following information.

Returns Type Description

Name string Name of the property.

Value string Value of the property.
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getPerfMonSetting()

Returns the setting of the perfMon option. It returns the following information.

Returns Type Description

Setting string Value of the perfMon option.
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getQueueStatistics()

Returns the current count of elements in any internal queue used by the adapter. 
This includes the TIBCO Rendezvous event queues automatically spawned by 
Rendezvous for each adapter.

Returns Type Description

QueueID string A unique identification of a particular queue.

QueueType string A type or key that will match this queue to a 
thread or connection.

QueueCount integer Current number of elements in the queue.

MaxQueueSize integer Maximum number of elements in the queue.
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getRvConfig()

Returns information about the TIBCO Rendezvous session defined by this 
adapter. Information about all currently defined sessions is returned if no 
sessionName is provided.

Parameter Type Description

Session Name string Name of the TIBCO Rendezvous session for 
which configuration is required (default is all). 

Returns Type Description

Instance ID string The configuration ID of this adapter.

Adapter Name string Name of the adapter. 

Session Name string Name of the session.

Service string Service parameter for this session. 

Daemon string Daemon parameter for this session. 

Network string Network parameter for this session.

Synchronous? boolean Returns 1 if this is a synchronous session, 0 
otherwise. 

Session Type string Type of session; one of M_RV, M_RVCM, or 
M_RVCMQ.

Certified Name string Name of this certified session.

Ledger File string Ledger file for this certified messaging session. 
Returns the empty string for sessions that are 
not certified messaging sessions. 

CM Timeout string Timeout for this certified messaging session. 
Returns the empty string for sessions that are 
not certified messaging sessions. 
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getStatus()

Retrieves basic status information about the adapter. 

This information is fairly limited. For more detail, additional methods are 
provided in getConfig() on page 113 and getRvConfig() on page 120.

Returns Type Description

Instance ID string Configuration ID for this adapter instance.

Adapter Name string Name of the adapter. 

Uptime integer Number of seconds since startup.

Messages Received integer Number of TIBCO Rendezvous messages 
received.

Messages Sent integer Number of TIBCO Rendezvous messages 
published.

New Errors integer Number of errors since the last call to this 
method.

Total Errors integer Total number of errors since startup.

Process ID integer Process ID of the application.

Host string Name of host machine on which this adapter 
is running. 
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getThreadStatistics()

Returns the operation counts of the current threads.

Returns Type Description

ThreadID string A unique identification of a particular thread.

ThreadType string Type that tells what part of the adapter this 
thread belongs to. Valid types include 
"Publisher", "Subscriber", "RPC", or 
"Connection".

TaskType string Short description of the tasks this thread 
processes. 

TaskCount integer Number of tasks processed by this thread.



 TIBCO ActiveMatrix Adapter Service Engine for SAP Configuration and Deployment

getTraceSinks() | 123

getTraceSinks()

Returns information about sinks to which traces currently go. 

Parameters Type Description

Sink Name string Name of the sink for which you need information. 
If no name is specified, information about all sinks 
is returned. Default is all. 

Role Name string Name of the role for which you need information 
for the specified sink or sinks. Default is all. 

Returns Type Description

Instance ID string Name of this adapter instance as a string. 

Adapter Name string Name of the application for this sink. 

Sink Name string Name of the sink

Sink Type string Type of this sink. One of fileSink, rvSink, 
hawkSink, stderrSink. 

Roles string Roles this sink supports, as a string. For example 
“warning, error, debug”.
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getVersion()

Retrieves version information for the current application. Two lines may be 
returned, one for the TIBCO Adapter SDK, one for the adapter.

Returns Description

Instance ID The configuration ID as a string, for example SDK.

Adapter Name Name of the adapter as a string, for example agentone. 

Version Version number as a string, for example 1.1. 
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_onUnsolictedMsg()

Displays all alert messages sent from the adapter or an error if not successful.
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preRegisterListener()

Preregisters an anticipated listener. Some sending applications can anticipate 
requests for certified delivery even before the listening applications start running. 
In such situations, the sender can preregister listeners, so TIBCO Rendezvous 
software begins storing outbound messages in the sender’s ledger. If the listening 
correspondent requires old messages, it receives the backlogged messages when it 
requests certified delivery.

Returns OK if the listener was preregistered successfully, false otherwise.

Parameters Type Description

Session Name string Name of the session that anticipates the 
listener. 

Publisher Name string Name of the component for which the 
listener should be preregistered. 

Listener Session 
Name

string Name of the listener to preregister. 
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refreshABAPContext()

Refreshes the ABAP context held by the adapter connections. 

Parameters

None

Returns

None
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resetActivityStatistics()

Resets all the counts for the activity statistics.
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resetConnectionStatistics()

Resets all the counts for the connection statistics.
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resetThreadStatistics()

Resets all the counts for the thread statistics.
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reviewLedger()

Returns information retrieved from the ledger file of a TIBCO Rendezvous 
certified messaging session. 

Before invoking this method, ensure that the certified messaging publisher 
adapter has established a certified delivery agreement with its subscriber agents.

Parameters Type Description

Session Name string Name of the TIBCO Rendezvous session for 
which ledger information is desired (default is 
all). 

Subject string Name of the subject for which ledger 
information is desired. 

Returns Type Description

Session Name string Name of the TIBCO Rendezvous CM session 
to which this information applies. 

Subject string Subject name for this session.

Last Sent Message integer Sequence number of the most recently sent 
message with this subject name. 

Total Messages string Total number of pending messages with this 
subject name.

Total Size integer Total storage (in bytes) occupied by all 
pending messages with this subject name. 

If the ledger contains ten messages with this 
subject name, then this field sums the storage 
space over all of them. 

Listener Session 
Name

string Within each listener submessage, the Listener 
Session Name field contains the name of the 
delivery-tracking listener session. 
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Last Confirmed string Within each listener submessage, the Last 
Confirmed field contains the sequence 
number of the last message for which this 
listener session confirmed delivery. 

Line integer Row number in ledger file.

Unacknowledged
Messages

integer Number of RVCM messages pending for this 
listener. The value is computed by subtracting 
the last sent sequence number from the last 
acknowledged sequence number.

Returns (Cont’d) Type Description
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setTraceSinks()

Adds a role or changes the file limit of a previously specified sink. 

Returns OK if successful or an error if not successful. 

Parameters Type Description

Sink Name string Name of the sink for which you want to add a 
role or change the file limit.

Role Name string Name of the role you want to add to this sink 
(warning, error, debug, or user defined). Default 
is all. 

File Size integer Maximum file size for this sink. 

This parameter is ignored if the sink specified 
by sinkName is not a file sink. 
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stopApplicationInstance()

Stops the specified adapter by calling the internal stop() method. This method 
returns OK if successful or an error if not successful.
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unRegisterListener()

Unregisters a currently preregistered listener

This method returns true if the listener was unregistered successfully, false 
otherwise. 

Parameters Type Description

Session Name string Name of the session that anticipates the 
listener. 

Publisher Name string Name of the component for which the listener 
should be preregistered. 

Listener Session 
Name

string Name of the listener to unregister. 
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Chapter 6 Working with SOA Projects

Topics

• Working with the Composite Editor, page 138

• Generate SOA Artifacts, page 139

• Creating the Service Assembly and the Service Assembly Archive, page 144
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Working with the Composite Editor

In the ActiveMatrix platform, a composite exports a cohesive set of business 
functions as services. A composite contains of one or more components. A 
component contains a configured implementation, where the implementation 
provides the business functions. The component configures the implementation 
with specific values for custom properties and by connecting component 
references to component services or composite references. The connections 
between references and services are represented by wires.

For more information refer to the TIBCO ActiveMatrix Service Grid 
documentation.

Previous chapters described how to create an adapter project and to configure an 
adapter instance. This chapter describes the process of creating an adapter 
component, adding services and references to the adapter component, and 
creating a service assembly.

Create a SOA Project

To create a new ActiveMatrix SOA project:

1. Click File -> New > Project>TIBCO ActiveMatrix> ActiveMatrix SOA 
Project. 

2. Type a name for the project and click Finish.

If your project has the Custom Scalars property enabled, make sure you have the 
property added to the BusinessStudio.ini file before generating the WDSLs.

Dcom.tibco.xml.schema.parse.ae.AE_CUSTOM_SCALARS=true
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Generate SOA Artifacts

The adapter WDSL file describes the adapter services. To generate an adapter 
wsdl:

1. Right click the adapter configuration in the adapter project and select 
Generate Adapter WSDL. 

2. Choose the SOA project that you want to use. See Create a SOA Project, 
page 138 for information on creating a new SOA project.

The following folders are created:

• adapter configuration filename_genresources, and

This following folders and files are created: 

adapter configuration filename_number.dat This file contains information used 
by the Adapter container. 

adapter configuration filenameSE.dat This file is used by the adapter service 
engine.

adapter configuration filename.adendpoints The adapter service endpoints file 
contains information about the service endpoints supported by the adapter. 
The file is used later to help in the selection of service types.

adapter configuration filename.wsdl The generated WSDL file which references 
the schema and .dat files contains the service definition endpoints.

adapter configuration filename.substvar The substitution variables are 
imported from the adapter configuration file.

SAPAdapter.substvar This file contains properties belonging to the TRA.

The shared resource that defines the transport used to communicate with the 
adapter is created. If the adapter project referenced global variables, the 
shared resource will reference substitution variables defined in adapter 
configuration filename_number.substvar. 

• schema

This folder contains the Adapter XSD schema.

Add Composite Elements

The Composite folder contains the composite file, SOA Project name.composite.

After using a WSDL in a composite make sure you do not overwrite the WSDL.
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To add composite elements:

1. Double click the SOA Project name.composite file. 

The Palette displays the SAP adapter component as shown in the following 
figure.

2. Drag and drop the SAP adapter component into the canvas.

3. Type in a name for the component. 

4. Select the Services tab and click Add.

5. Expand the tree displayed in the Resource Picker dialog box (see following 
figure) and choose a service and click Add. 

6. Click OK.

The following table lists the fields displayed in the Component tab

Property Names Description

Name The adapter component name. 

Description The adapter component description.
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Add Service Elements

To add a service element:

1. Drag and drop a service, say SOAP, from the palette onto the canvas.

2. Give it a name.

3. Save the project.

Choosing a service

A message exchange pattern (MEP) defines the sequence and cardinality of 
messages sent between provider and the consumer. The MEPs contain both 
normal and fault messages. An adapter in the ActiveMatrix environment is 
always the provider of the service. 

MEPs define the interaction pattern between the consumer and the provider, the 
direction and the number of messages that could be exchanged in one 
consumer-provider interaction. It also defines who, the consumer or the provider, 
initiates the message exchange by sending the first message. A provider can also 
initiate an exchange by sending the first message. On the composite however, you 
will see a consumer wired to a provider. The wiring of components in the 
composite is not indicative of the direction of the message flow. Even if an adapter 
RPC Client or a Subscriber appears to be consuming a service because it 
subscribes to a message or invokes a RPC call on the external application that is 
part of the SOA composite definition, it is in reality a provider of the service.

The mapping between various MEPs and adapter services are as follows:

• One-Way (In-Only) maps to a adapter Subscriber

Version The adapter component version number.

Type (Read-only) The adapter type.

SDK Application Name (Read-only) The instance name of your adapter configuration.

Configuration URI (Read-only) The adapter configuration that the service uses.

Repository URI (Read-only) This file contains information used by the container 
to communicate with the adapter.

TRA File Name For the unicode adapter specify adr3u.tra and for the 
non-unicode specify adr3.tra.

Property Names Description
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• Request-Response (In-Out) maps to a adapter RPC Server

• Solicit-Response (Out-In) maps to a adapter RPC Client

• Notification (Out-Only) maps to a adapter Publisher

While the MEP defines the direction (sequence) and the cardinality, the WSDL 
defines the contract between the consumer and the provider who have agreed to 
be bound by the WSDL definitions. Therefore MEPs play an important role 
between the consumer and the provider. Under the contract a consumer can only 
bind with services provided by the provider that share the same MEP. 

The MEPs are dictated in the WSDL by the WSDL PortType definitions. Refer to 
the mapping given above and see if you want the SOAP service to consume 
adapter's RPC Server (In-Out) service, you must use add a Reference that 
supports In-Out and wire it with the adapter's service.

Add Shared Resources

In order for the service elements created in the previous step to be accessible from 
external client, an HTTP connection resource has to be created.

1. In the Project Explorer panel, select New> TIBCO Shared Resources> HTTP 
Server.

2. Type in a name for the shared resource or accept the default.

To add this shared resource to the composite:

3. Open the composite by double clicking the composite in the Project Explorer.

4. Click the canvas.

5. Click the Shared Resource Profiles tab below the canvas.

6. Click on the  field. A row is created in the table.

7. Type in a name or accept the default. 

8. In the type column, choose HTTP.

9. In the Target column, click  to bring up the Select Shared Resource dialog.

10. Choose the shared resource and click OK.
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11. Open the service and from the Properties view click the Target tab.

12. In the table, click the radio button next to the component service. 

A wire will be drawn between the service and the component service as shown in 
the following figure.

For each adapter configuration there is one component and one component per 
service unit.



TIBCO ActiveMatrix Adapter for SAP Configuration and Deployment

144 | Chapter 6  Working with SOA Projects

Creating the Service Assembly and the Service Assembly Archive

In order to deploy the services and components that were created in the previous 
sections, they have to be packaged in a service assembly.

To create the service assembly archive, in the Project Explorer panel right click the 
composite and choose Service Assembly.

The deployment package, projectname.saf is created in the Deployment Packages 
folder.

To create the service assembly archive, in the Project Explorer panel, right click the 
deployment package and choose Build Archive.

The service assembly archive, projectname.zip is created in the Deployment 
Packages folder.

This service assembly archive can now be deployed and started using TIBCO 
ActiveMatrix Administrator. 

Using Substitution Variables

At design-time, you can assign default values to all the custom properties 
(substitution variables) from the .tra file using TIBCO Business Studio:

1. In Project Explore panel>adapter configuration filename_genresources folder, 
find the substitution variable file adapter configuration filename.substvar.

2. Double click the .substvar file to bring up the Defined Substitution 
Variable editor. 

3. Modify the default properties for the substitution variables. 

See TIBCO ActiveMatrix Composite Editor User’s Guide for details on working with 
substitution variables. 

At run-time, you can update the values of the substitution variables using TIBCO 
ActiveMatrix Administrator.
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The following figure shows the Substitution Variables editor in TIBCO 
ActiveMatrix Administrator, where you can specify runtime values for 
substitution variables
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Chapter 7 Deploying the Service Assembly

This section describes how you can deploy a service assembly archive using 
TIBCO ActiveMatrix Administrator.

Topics

• Overview, page 148

• Preparing for Deployment, page 149

• Using the EAR2SA tool, page 150

• Creating the Service Assembly and the Service Assembly Archive, page 144

• Deploying a Service Assembly Archive, page 151
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Overview

The adapter service engine enables the adapter to run in the ActiveMatrix 
environment as a container and to provide services.

Adapter projects created using Designer can also be packaged for deployment in 
the ActiveMatrix environment. Adapter projects can be designed to run in the 
following modes

• Wired Mode 

The adapter component is wired with other composite elements in the 
ActiveMatrix SOA project. Projects running in this mode interact with other 
components in the ActiveMatrix environment.

Projects created using TIBCO Business Studio always run in the wired mode.

• Unwired Mode 

The adapter component in the ActiveMatrix SOA project is not wired with 
other composite elements and does not participate in the ActiveMatrix 
environment. Projects running in the unwired mode do not provide services 
to or consume services from other ActiveMatrix components. The adapter 
configurations merely run in the ActiveMatrix node but the deployments can 
be life-cycled using TIBCO ActiveMatrix Administrator.



 TIBCO ActiveMatrix Adapter for SAP Configuration and Deployment

Preparing for Deployment | 149

Preparing for Deployment

The adapter services that were created in the design phase have to be packaged 
into a service assembly before they can be deployed.

A service assembly contains service units and a descriptor that indicates the 
container into which each service unit is to be deployed into. The service 
assembly is then used to created a deployable archive, the service assembly 
archive.

Working with SOA Projects on page 137 describes in detail the steps involved in 
creating the service assembly archive. The service assembly runs in the wired 
mode.

To run in the unwired mode, use the EAR2SA tool. See Using the EAR2SA tool on 
page 150 for more information.

Once the service assembly archive is created, follow steps outlined in Deploying 
the Service Assembly on page 152 to deploy the adapter.
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Using the EAR2SA tool

An adapter EAR file created using TIBCO Designer is first imported into TIBCO 
Business Studio. To create a service assembly archive from an EAR file:

1. Select File > New > Project> New SOA Project.

2. Type a name in the Project name field and click Finish.

3. In the Project Explorer view, right click the folder and select Import....

4. Choose General > File System.

5. Click the Browse button to navigate to the directory where the .ear file is 
located. 

6. Choose the .ear file and click OK.

7. In the Project Explorer view, right-click on the imported .ear file and select 
Build Service Assembly Archive.

8. The service assembly archive, EAR_fileName.zip, is created under the folder 
Deployment Packages. 

Projects imported using the .ear file always run in the non-wired mode.

The service assembly archive that is created can now be deployed. See Deploying 
the Service Assembly on page 152 for more information.

The project will continue to use the encoding set in the Designer project.

For more information, refer to TIBCO ActiveMatrix Adapter for SAP Configuration 
and Deployment.
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Deploying a Service Assembly Archive

This section describes the tasks to configure and deploy a service assembly. These 
tasks are performed using TIBCO ActiveMatrix Administrator. Deploying a 
service assembly archive involves the following activities:

• Uploading a Service Assembly Archive

• Configuring the Service Assembly

• Deploying the Service Assembly

• Starting the Service Assembly

Uploading a Service Assembly Archive

The following steps describe how to upload the service assembly archive:

1. Click Upload Service Assembly.

2. In the Name field, enter a name for the service assembly.

3. Click Browse... to choose a service assembly archive from the file system.

4. Check the Import Shared Resource Definitions check box to create shared 
resources definitions from the definitions in the service assembly archive.

5. Click OK.

The service assembly will appear in the Service Assemblies table.

Configuring the Service Assembly

The following activities need to be performed to configure a service assembly:

• Specify the nodes on which the service units in the service assembly will be 
deployed.

• Map the shared resource profiles to shared resources as appropriate for the 
service assembly.

Configuring the Service Unit

The following steps describe how to configure the adapter Service Unit in a 
service assembly:

1. In the Service Assemblies table, select the service assembly.

2. Click Service Units to view the service units in the selected service assembly.
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3. Select the service unit listed in the Service Units table.

The service unit properties are displayed in the following tabs:

• Node Mapping - you can map the nodes to service units. See TIBCO 
ActiveMatrix Administration for details.

• Substitution Variables - you can specify the value of the service unit’s 
substitution variables. See TIBCO ActiveMatrix Administration for details.

Setting Logging Configurations

Follow these steps to modify the logging options:

1. Select Logging Configuration.

2. Choose the service unit.

3. Choose the level from the Severity drop-down list.

4. Click Service Unit Logging.

Mapping the Shared Resource Profiles to Shared Resource

A shared resource profile specifies the kind of physical resource needed by 
services. The shared resource profiles are defined in ActiveMatrix design-time 
and are packaged in the service assembly. Before deploying the service assembly, 
you must map the shared resource profile to a shared resource available in the 
node that the service unit is mapped to. See TIBCO ActiveMatrix Administration for 
details.

Deploying the Service Assembly

A service assembly is ready to be deployed once the service assembly is uploaded 
and configured. Before actually deploying the service assembly, verify the 
following:

• All nodes required for deployment are running.

• All containers required for deployment are activated.

• All shared resources are installed on the node.

To deploy a service assembly, select the service assembly in the Service 
Assemblies table and click Deploy. Once the service assembly is deployed, the 
status changes to Deployed.
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Starting the Service Assembly

After a service assembly has been successfully deployed, you can start it, and if 
required, stop it.

Following steps describe how to start and stop service assemblies.

1. In the Service Assemblies table, select one or more service assemblies.

2. To start the selected service assemblies, click Start. The status changes to 
Running.

3. To stop the selected service assemblies, click Stop. The status changes to 
Deployed.
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Appendix A Sample saprfc.ini Files

Topics

• Sample saprfc.ini Files, page 52
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Sample saprfc.ini Files

The following sample demonstrates using the saprfc.ini file for: 

• Register RFC Server programs

• Connect RFC Client programs to SAP

Refer to the SAP Documentation accompanying your SAP installation for 
additional information.

Example: Registering an RFC Server Program Example

The following parameters register an RFC server program at an SAP gateway, in 
SAP using transaction SM59. To reference the block, the destination field in the 
server connection should be defined as DEST-TIB-R. See SAP Client INI File 
Connection on page 66 for details.
DEST=DEST-TIB-R

TYPE=R

PROGID=UseAUniqueProgramID

GWHOST=sapsvr

GWSERV=sapgw00

RFC_TRACE=0

It is important to note that if PROGID is not defined, the value of DEST is used 
instead.

The RFC server program is registered as follows:

• Program ID is UseAUniqueProgramID

• SAP gateway is sapsvr

Using Logon Groups to Connect an RFC Client to SAP Example

The next parameter connects an RFC Client program to SAP using logon groups. 
In SAP using transaction SMLG, the logon group defined is SPACE

The SAP System ID (SID) is TIB and the message server is sapsvr.

In this example, there is no RFC tracing since RFC_TRACE is defined with a value 
of 0.

In this example, there is no RFC trace and ABAP debugging since RFC_TRACE 
and ABAP_DEBUG are defined with a value of 0.
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To reference the parameters given below, the destination field in the client 
connection should be defined as DEST-TIB-B. See Configuring Client Connection 
with Load Balancing on page 122 for details.

Note that if R3NAME is not defined, the value of DEST is used instead.
DEST=DEST-TIB-B

TYPE=B

R3NAME=TIB

MSHOST=sapsvr

GROUP=SPACE

ABAP_DEBUG=0

USE_SAPGUI=0

Using a Dedicated Application Server to Connect an RFC Client Program to 
SAP 

The parameters given below connect an RFC Client program to SAP using a 
dedicated application server.

The application server is sapsvr and the system number is 00.

Similar to the load balancing example, there is no RFC trace and ABAP 
debugging.

To reference the parameters given below, the destination field in the client 
connection should be defined as DEST-TIB-A. See Configuring Dedicated 
Application Server Client Connection on page 120 for details.

In this example, it is assumed that running on the same machine as the 
application server is a gateway service. If this is not the case, you need to define 
the additional parameters GWHOST and GWSERV. These parameters are similar to the 
ones available under Registered RFC Server programs (see Using Logon Groups 
to Connect an RFC Client to SAP Example on page 52).
DEST=DEST-TIB-A

TYPE=A

ASHOST=sapsvr

SYSNR=00

RFC_TRACE=0

ABAP_DEBUG=0

USE_SAPGUI=0
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Appendix B Differences in Adapter Projects

This section describes the differences observed in adapter projects created using 
TIBCO Designer and TIBCO Business Studio.

Topics

• Differences in Projects, page 160
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Differences in Projects

The following features are observed between projects created using TIBCO 
Business Studio and TIBCO Designer.

• The names of the adapter configuration and the folders for the connection 
references and the shared resouces are named as follows:

— R3AdapterConfiguration.adr3model

— R3AdapterConfiguration_genresources

— R3Connections_genresources

• The value of the Class MicroAgentName field (located in the 
R3AdapterConfiguration->Monitoring tab in Designer) has been changed 
from COM.TIBCO.adr3.%%Deployment%%.%%InstanceId%% to 
COM.TIBCO.adr3.%%Deployment%%.<AdapterConfigurationInstanceName>.

• The value of the Standard MicroAgentName field (located in the 
R3AdapterConfiguration->Monitoring tab in Designer) has been changed 
from COM.TIBCO.ADAPTER.adr3.%%Deployment%%.%%InstanceId%% to 
COM.TIBCO.ADAPTER.adr3.%%Deployment%%.<AdapterConfigurationInstanceNam

e>.

• The Enable Custom Scalar field which was configured using a property in the 
designer.tra file in not imported. This property is now configured at the 
service level. 

• Projects with a TID Manager server configuration and Generic Adapter 
Configuration are not imported.

• The features associated with the following fields are not supported:

— IDoc Acknowledgement

— User Exit

— Confirm 

— ReadIDocPlugin

• The following fields are not imported:

— Startup Connectionless

— Adapter Termination Criteria

— Enable Connectionless

— Advanced Logging
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Appendix C Trace Messages

This appendix explains the trace messages that are logged to a location specified 
at configuration time.

Topics

• Overview, page 162

• Trace Message Fields, page 164

• Status Messages, page 167
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Overview 

Trace messages provide information about adapter activities. The messages are 
logged to the console where the runtime adapter was started and to a log file. 
Trace messages can also be redirected to the TIBCO Hawk Display application, or 
sent to other applications using the TIBCO Rendezvous transport. 

Each trace message can include the following fields: 

<Timestamp> <Adapter Identifier> <Role> <Category> <Status Code> 

<Tracking Identifier> 

The above fields are explained in Trace Message Fields on page 164. The 
following diagram shows an example trace message and calls out the fields.

Example Trace Messages

The following trace messages were written during a session where the adapter 
received a message from the SAP system.

The first message indicates that the adapter has started. The timestamp indicates 
when the adapter started, and the role indicates that the trace message is 
informational, which means the activity is normal for the adapter. The category is 
identified, and the corresponding status code is displayed. The status code 
indicates that the adapter started successfully. 

2003 Jan 24 10:46:10:486 GMT 5 SAPAdapter.SALESORDER-OUT Info 

[Adapter] AER3-000082 Successful initialization of Adapter 

The next set of trace messages indicates the adapter received a message from the 
SAP system. The #-0Y--C--DX1ALUbc--4zzzw-TEzzw# tracking identifier 
included in the trace message uniquely identifies the message. 

2003 Feb 22 20:15:12:937 GMT -8 

SAP Adapter.SAP AdapterConfiguration Info [Adapter] 

tracking=#MU3oTJ/WWCV1MU96J0zzwA9kzzw#

Timestamp

Adapter Identifier Role Category

Status Code

Tracking Identifier

AER3-000114 Received invocation request for..... 
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2003 Jan 24 10:47:18:644 GMT 5 SAPAdapter.SALESORDER-OUT Info 

[Adapter] AER3-000114 Received invocation request for 

BAPI_SALESORDER_CREATEFROMDAT1 from SAP R/3 System 

tracking=#-0Y--C--DX1ALUbc--4zzzw-TEzzw#
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Trace Message Fields

Each trace message includes the following fields: 

Table 24   Tracing Fields

Field Name Description

Timestamp Timestamp of occurrence. For example, 2003 Feb 22 20:14:51:718 GMT -8.

Adapter 
Identifier

Name of the adapter that wrote the trace message. This is a combination of the 
adapter acronym and adapter configuration name. For example, the 
application identifier, ADB.publisher1 identifies a TIBCO ActiveMatrix 
Adapter for Database service named publisher1.

Role A role can be: 

• Info. Indicates normal adapter operation. No action is necessary. A tracing 
message tagged with Info indicates that a significant processing step was 
reached and has been logged for tracking or auditing purposes. Only info 
messages preceding a tracking identifier are considered significant steps.

• Warn. An abnormal condition was found. Processing will continue, but 
special attention from an administrator is recommended.

• Error. An unrecoverable error occurred. Depending on the error severity, 
the adapter may continue with the next operation or may stop altogether.

• Debug. A developer-defined tracing message. In normal operating 
conditions, debug messages should not display. 

When configuring the adapter you define what roles should or should not be 
logged. For example, you may decide not to log Info roles to increase 
performance.
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Category One of the following:

• Adapter. The adapter is processing an event.

• Application. The adapter is interacting with the SAP system.

• Configuration. The adapter is reading configuration information.

• Database. The adapter is interacting with a database.

• Schema. The adapter is retrieving metadata from the SAP system.

• Publication. The publication service is reporting this trace message.

• RequestResponseInvocation. The Request-Response invocation service is 
reporting this trace message.

• RequestResponse. The Request-Response service is reporting this trace 
message.

• Shutdown. The adapter is shutting down.

• Startup. The adapter is starting.

• Subscription. The subscription service is reporting this trace message.

• Connection. This is an application connection related trace message.

• System. This category is not linked to a specific event process. The trace 
message may be related to a Windows service related messages, memory 
allocation, file system error, and so on.

• TibRvComm. The adapter is communicating with TIBCO Rendezvous.

• XML. The adapter is parsing XML documents.

Status Code Unique code for the message and description. Status codes are identified by a 
unique number and description. If a trace message includes an error or warn 
role, the status code documentation includes a resolution. See Status Messages 
on page 167 for details.

Tracking 
Identifier

A unique identifier that is "stamped" on each message by the originating 
adapter. The tracking identifier remains in effect from a message’s beginning 
to its completion as it is exchanged by TIBCO applications. If the adapter is 
the termination point of the message, the tracking identifier is not displayed 
in the trace message. 

You cannot modify the tracking identifier format or configure what 
information is displayed.

Table 24   Tracing Fields

Field Name Description
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Application 
Information

Application-specific information added to the tracking info to trace the 
message back to its source. Set initially by the originating adapter and carried 
forward. It is augmented by each intermediate component.

Table 24   Tracing Fields

Field Name Description
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Status Messages

The following table lists all the new error messages introduced in this release.

Status Code Role Category Resolution

AER3-910003 Startup Error. The command-line parameter(s): configurl, repourl have not 
been specified

Error Startup Specify the command-line parameters 
configURL and repoURL. 

AER3-910005 Startup Error. SDK Error %1 received during initialization. The Repository 
URL is %2 and the Configuration URL is %3

Error Startup Verify your repository settings. 

AER3-910006 Startup Error. SDK Exception %1 occurred while creating a shutdown 
listener with parameters %2. The Repository URL is %3 and the 
Configuration URL is %4

Error Startup Verify your repository settings for validity 
of configuration for the shut down listener.

AER3-910007 Startup Error. Unable to create a connection with the target application %1 
using connection parameters %2 and the target application error is %3

Error Startup Verify your repository settings for validity 
of connection parameters.

AER3-9100012 Startup Error. Unable to create a Custom Hawk Micro Agent Named %1 used 
for %2

Error Startup Verify your repository settings for validity 
of the stop-subscriber session parameters.

AER3-940001 Request Response error. Request Response service %1 listening on %2 
received unexpected null data in incoming request. Expects event %3. The 
Repository URL is %4 and the Configuration URL is %5

Error RequestResponse Check the configuration of the application 
that is requesting the event and make sure 
that it matches the inbound event 
definition for the above Request-Response 
service. 



TIBCO ActiveMatrix Adapter Service Engine for SAP Configuration and Deployment

168 | Trace Messages

AER3-940005 Request Response error. Request Response service %1 failed to deserialize 
the received Request to MInstance: Received event on subject %2, event = 
%3, SDK exception = %4. The Repository URL is %5 and the Configuration 
URL is %6

Error RequestResponse Check the configuration of the application 
that is requesting the event and make sure 
that it matches the inbound event 
definition for the above Request-Response 
service. 

AER3-940008 Request Response error. Connection error in invocation of Request 
Response service %1 listening on subject %2. Connection Parameters are %3

Error RequestResponse Check if the end application is up and 
running. Also verify the connection 
parameters that are specified in the 
repository.

AER3-940009 Request Response error. Request Response service %1 listening on subject 
%2 failed due to target application invocation error %3. Target application is 
%4 and inbound event is %5

Error RequestResponse Check the validity of the incoming 
request-data to the Request-Response 
Service.

AER3-940010 Request Response error. Request Response service %1 listening on subject 
%2 failed to create reply. Error : %3

Error RequestResponse Verify the data received from the SAP 
system and make sure it matches the 
schema associated to the 
Request-Response Service.

AER3-920001 Subscription error. Subscription service %1 listening on %2 received an 
unexpected event of type = %3, Expects event %4. The Repository URL is %5 
and the Configuration URL is %6

Error Subscription Check the configuration of the application 
that is publishing the event and make sure 
that it matches the inbound event 
definition for the above subscription 
service. 

Status Code Role Category Resolution
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AER3-920002 Subscription error. Subscription service %1 failed to deserialize the event 
received on subject %2 and SDK exception thrown is %3. The Repository 
URL is %4 and the Configuration URL is %5

Error Subscription Check the configuration of the application 
that is publishing the event and make sure 
that it matches the inbound event 
definition for the above subscription 
service. 

AER3-920003 Subscription error. Subscription service %1 listening on subject %2 received 
inbound event with null data. The Repository URL is %3 and the 
Configuration URL is %4

Error Subscription Check the configuration of the application 
that is publishing the event and make sure 
that it matches the inbound event 
definition for the above Subscription 
Service. 

AER3-920007 Subscription error. Subscription service %1 listening on subject %2 could 
not get the class description of %3. The Repository URL is %4 and the 
Configuration URL is %5

Error Subscription Check the repository configuration for this 
service. 

AER3-920008 Subscription error. Subscription service %1 listening on subject %2 could 
not find the mandatory property %3 in class %4. The Repository URL is %5 
and the Configuration URL is %6

Error Subscription Check the configuration of the application 
that is publishing the event and make sure 
that it matches the inbound event 
definition for the above Subscription 
Service. 

AER3-9200015 Subscription error. Subscription service %1 listening on subject %2 failed 
due to target application invocation error %3. Target application is %4

Error Subscription Verify the structure of the incoming 
message. Check in the SAP system for 
more detailed information on the cause of 
the error.

Status Code Role Category Resolution
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AER3-950001 Request Response Invocation error. Request Response Invocation service %1 
with subject as %2 received event from target application %3. It failed while 
converting event to request, as it could not get the class description for %4.  
Repository URL is %5 and the Configuration URL is %6

Error RequestResponse
Invocation

Verify the configuration of the 
Request-Response Invocation Service and 
check that the schema/class definitions are 
present in the repository. 

AER3-950003 Request Response Invocation error. Request Response Invocation service %1 
with subject as %2 received event from target application %3. It failed while 
converting event to request. Repository URL is %5 and the Configuration 
URL is %6

Error RequestResponse
Invocation

Verify the configuration of the 
Request-Response Invocation Service and 
check that the schema/class definitions are 
present in the repository. 

AER3-950008 Request Response Invocation error. Request Response Invocation service %1 
with subject %2 received error while requesting event over the wire. Error 
%3

Error RequestResponse
Invocation

Check repository settings for valid 
configuration of the Request-Response 
Invocation endpoint for this service. 

AER3-950009 Request Response Invocation error. Request Response Invocation service %1 
with subject %2 received error while requesting event over the wire. Error 
%3

Error RequestResponse
Invocation

Check repository settings for valid 
configuration of the Request-Response 
Invocation endpoint for this service.

AER3-9500010 Request Response Invocation error. Request Response Invocation service %1 
with subject %2 received null reply while requesting event over the wire

Error RequestResponse
Invocation

Check the target application, if it is 
running or not. Check the configuration of 
Request-Response Invocation  Service.

Status Code Role Category Resolution
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AER3-9500011 Request Response Invocation error. Request Response Invocation service %1 
with subject %2 received timeout error while requesting event over the wire

Error RequestResponse
Invocation

Check repository settings for valid 
configuration of the Request-Response 
Invocation endpoint for this service. 

AER3-9500012 Request Response Invocation error. Request Response Invocation service %1 
with subject %2 received error while processing reply message. Error %3

Error RequestResponse
Invocation

Check repository settings for valid 
configuration of the Request-Response 
Invocation endpoint for this service. 

AER3-930003 Publication error. Publication service %1 with publishing subject as %2 
received event from target application %3. It failed while converting event to 
MInstance as it could not get the class description for %4. Repository URL is 
%5 and the Configuration URL is %6'

Error Publication Verify the configuration of the publication 
service and check that the schema/class 
definitions are present in the repository. 

AER3-930006 Publication error. Publication service %1 with publishing subject %2 
received the event from target application %3. It failed while converting 
event to MInstance attribute %4 of class %5 is missing. RepositoryURL is %6 
and the ConfigurationURL is %'

Error Publication Verify the configuration of the publication 
service and check that the schema 
definitions are present in the repository. 

AER3-9300014 Publication error. Publication service %1 with publication subject %2 
received error while sending event over the wire. Error : %3

Error Publication Check repository settings for valid 
configuration of the publish endpoint for 
this service. 

AER3-890006 Connection Error. Adapter stopping due to persistent connection errors to 
the SAP system(s)

Error Connection Check the SAP system(s) connected to, 
and restart the adapter.

Status Code Role Category Resolution
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AEADR3-600001 JMS Service Configured. This adapter version does not support JMS 
services, but one was found. Use the Go To button to select it.

Warning Configuration You have configured a service with 
transport type as JMS. But the AE Version 
of this adapter instance does not support 
JMS. You may change the AE Version or 
make sure that the runtime version is 
higher than this version.

AEADR3-600002 XML Wire Format found. This adapter version does not support XML Wire 
Format.

Warning Configuration You have configured a service with XML 
Wire Format. But the AE Version of this 
adapter instance does not support XML 
format. You may change the AE Version or 
make sure that the runtime version is 
higher than this version.

AEADR3-600003 Subscriber in exploded batch mode found. This adapter version does not 
support Subscriber in Explode Batch Mode.

Warning Configuration You have configured a Subscription 
service with Exploded Batch Mode. But 
the AE Version of this adapter instance 
does not support Subscriber in Exploded 
Batch Mode. You may change the AE 
Version or make sure that the runtime 
version is higher than this version.

AEADR3-600004 Connection Retry Mechanism Warning. This adapter version does not 
suspend services on connection failure. The configured value 'Adapter 
Termination Criteria' will be ignored.

Warning Configuration You have configured a service with 
Connection Retry. But the AE Version of 
this adapter instance does not suspend 
services on connection failure. You may 
change the AE Version or the value of 
'Adapter Termination Criteria' will be 
ignored.
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AEADR3-600005 Connection Retry Mechanism Warning. This adapter version does not 
suspend services on connection failure. The configured values 'Number of 
Reconnect Attempts Before Suspending Impacted Service(s)' and 'Adapter 
Termination Criteria' will be ignored.

Warning Configuration You have configured a service with 
Connection Retry. But the AE Version of 
this adapter instance does not suspend 
services on connection failure. You may 
change the AE Version or the value of 
'Adapter Termination Criteria' will be 
ignored.

AEADR3-600006 Empty Service Found. The Service is not Configured Or Class Reference or 
Endpoint Reference is Empty.

Warning Configuration You have configured an adapter instance 
with a service which has no schema 
associated with it. Such an adapter 
instance cannot be used at run-time. Make 
sure that you do not have an empty service 
before deploying the adapter instance.

AEADR3-600007 Absolute Path not Found. Field %1, Palette error. Unable to find specified 
absolute path. Make sure that you have specified the absolute path correctly.

Error Configuration Absolute path of the Plugin Directory not 
found. Check the path.

AEADR3-600011 Error copying Configuration information/Inbound Connection Type does 
not support copying of connection information from Configuration view.

Error Configuration You are trying to copy Design-Time 
parameters to Run-Time Inbound 
Connection which is not of type 
’Dedicated.’ If you want to copy, make 
sure that the default inbound connection 
type is ’Dedicated’.
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AEADR3-600012 Illegal Adapter Instance Name. Adapter Configuration names must have 
only alphanumeric characters with no embedded spaces and can be up to 80 
characters long. Type in a valid name.

Error Configuration Cannot rename the adapter instance. 
Provide a valid name. Make sure you have 
entered alphanumeric characters, no blank 
spaces, and the name is not more than 80 
characters.

AEADR3-600013 Subject Names. Do you wish to regenerate subjects set to previous defaults?

Error Configuration Click YES to regenerate. 

AEADR3-600014 Regenerate Names?. Do you wish to regenerate Subject Names, Connection 
Names and Session Parameters?

Warning Configuration Click YES to regenerate. 

AEADR3-600015 Replace Resource. The resource %1 is already defined as a type. Do you want 
to replace it?

Warning Configuration Click OK to continue.

AEADR3-600016 Illegal Operation/The new nested name is in conflict with the name of the 
resource you are editing. Rename the existing resource or choose a different 
name.

Error Configuration Conflicting resource names. Try using a 
different name.

AEADR3-600021 Reuse Schema Type. Schema for %1 already exists. Do you want to reuse 
existing schema?

Warning Schema This is a Yes/No option. Select Yes if you 
want to use the existing schema. Select No 
if you want to re-download the schema for 
the SAP R3 system.

AEADR3-600022 Deleting Operation Type. Do you want to delete %1 ?

Warning Configuration Delete confirmation. Select Yes to delete.
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AEADR3-600023 Invalid Value. Field %1, Palette error. This is not a valid value.

Error Configuration You tried to enter an invalid value in the 
connection parameters.

AEADR3-600024 Invalid Value. Palette error. Endpoint Reference cannot have null value.

Error Configuration Endpoint Reference is empty. Select a valid 
end-point reference.

AEADR3-600028 Illegal Operation. Selected Resource Can Not Be Moved

Error Configuration No resolution.

AEADR3-600029 Filter Applied to mandatory segments. You have applied the filter on the 
following mandatory segment(s) 

Warning Schema You have applied a filter on mandatory 
segments. Uncheck the filter on these 
segments.

AEADR3-600035 Error Occurred. Conflicting Services. A Publication Service, having the same 
Schema, is already configured.

Error Schema You already have a Publication service 
with the same schema. You cannot 
configure another service in the same 
adapter instance.

AEADR3-600036 Error Occurred. Conflicting Services. A Subscription Service, having the 
same Schema, is already configured.

Error Schema You already have a Subscription service 
with the same schema. You cannot 
configure another service in the same 
adapter instance.

AEADR3-600037 Error Occurred. Conflicting Services. A Request-Response Service, having 
the same Schema, is already configured.

Error Schema You already have a Request-Response 
service with the same schema. You cannot 
configure another service in the same 
adapter instance.
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AEADR3-600038 Error Occurred. Conflicting Services. A Request-Response Invocation 
Service, having the same Schema, is already configured.

Error Schema You already have a Request-Response 
Invocation service with the same schema. 
You cannot configure another service in 
the same adapter instance.

AEADR3-600039 Download Operation Schema. Schema for operation %1 is already available, 
Use existing schema?

Warning Schema Click YES to reuse existing schema. Click 
NO to re-download schema from SAP R3 
system.

AEADR3-600040 Regenerate Resources ? Do you want to regenerate endpoint and subject 
information?

Warning Configuration Click YES to regenerate.

AEADR3-600041 Regenerate Resources? Do You want to regenerate Subject Names and 
Session Parameters?

Warning Configuration Click YES to regenerate.

AEADR3-600042 Regenerate Connections. Do You want to regenerate Connection Names?

Warning Configuration Click YES to regenerate Connection 
Names.

AEADR3-600043 Error while pasting. Deserialization of Schema Failed.

Error Schema Copy/Paste of schemas failed. Try 
configuring again.

AEADR3-600044 Error while pasting. Deserialization of R3 Connections Failed.

Error Configuration Copy/Paste of connections failed. Try 
configuring again.

AEADR3-600045 Error while writing the Meta Url.

Error Configuration Error in Meta URL. Try configuring again.
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AEADR3-600046 Inbound TID Management Warning. This adapter version does not support 
Inbound TID Management.

Warning Configuration You have configured an adapter instance 
with Inbound TID Management. But the 
AE Version of this adapter instance does 
not support Inbound TID Management. 
You may change the AE Version or make 
sure that the runtime version is higher 
than this version.

AEADR3-600047 Advanced Logging Warning. This adapter version does not support 
advanced logging to a file.

Warning Configuration You have configured an adapter instance 
with advanced logging. But the AE 
Version of this adapter instance does not 
support advanced logging to a file. You 
may change the AE Version or make sure 
that the runtime version is higher than this 
version.

AEADR3-600048 Confirm Publisher Warning. This adapter version does not support confirm 
publisher on the inbound side.

Warning Configuration You have configured an adapter instance 
with advanced logging. But the AE 
Version of this adapter instance does not 
support advanced logging to a file. You 
may change the AE Version or make sure 
that the runtime version is higher than this 
version.

AEADR3-600049 Valid destination Warning. This adapter version does not support Validating 
destination on the inbound side

Warning Configuration You have configured an adapter instance 
to validate destination on the inbound 
side. But the AE Version of this adapter 
instance does not support validating 
destination on the inbound side. You may 
change the AE Version or make sure that 
the runtime version is higher than this 
version.
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AEADR3-600050 Not Checked out. Failed to update Schema. The associated Schema files are 
not checked out from source control.

Error Configuration Check out schema files from the source 
control.

AEADR3-600051 Illegal child error occurred while processing connection - %1 

Error Configuration Error while processing R3 Connection. Try 
configuring again.

AEADR3-600052 Name conflict error occurred while processing connection - %1 

Error Configuration Error while processing R3 Connection. Try 
configuring again.

AEADR3-600053 Error occurred while applying changes to connection - %1

Error Configuration Error while applying changes to R3 
Connection. Try configuring again.

AEADR3-600054 Not Checked out. Failed to update R3Connections. The connection file is not 
checked out from source control 

Error Configuration Check out the connection file from source 
control.

AEADR3-600055 Error Renaming Service. Service name must only have alphanumeric 
characters and must be at most 80 characters long.

Error Configuration Cannot rename the service. Provide a valid 
name. Make sure you have entered 
alphanumeric characters, no blank spaces, 
and the name is not more than 80 
characters.

AEADR3-600056 Global Variables File:Read-Only. Global Variable files needs to be checked 
out in order to successfully create the adapter.

Error Configuration Check out Global Variables file from 
source control.
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The following table lists error messages for which codes have been changed.

AEADR3-600057 Error During Rename : Read-Only File. The resource %1 could not be 
renamed. Rename requires the %2 should be checked out. Check out the 
resource and try renaming again. You can select the resource to be checked 
out by clicking on the Go To Resource button.

Error Configuration Check out the resource and try renaming 
again.

AEADR3-600058 Error During Delete : Read-Only File/The resource %1 could not be deleted. 
Delete requires the %2 should be checked out. Check out the resource and 
try deleting again. You can select the resource to be checked out by clicking 
on the Go To Resource button.

Error Configuration Check out the resource and try deleting 
again.

AEADR3-600059 Error During Creation of Service : Read-Only File. The service can not be 
created. Creation requires the %1 should be checked out. Check out the 
resource and try creating the service again. You can select the resource to be 
checked out by clicking on the Go To Resource button.

Error Configuration Check out the resource and try creating the 
service again. 

AEADR3-600060 Need to Add File to RCS: %1 was created during schema generation. Ensure 
that this resource is added to RCS and checked in. Click on the Go To 
Resource button to select the resource.

Warning Configuration Ensure that this resource is added to RCS 
and checked in. 

Status Code Role Category Resolution
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AER3-000000 R3-CORE-
APP-8000

INFO AD The request does 

not contain 

closure data for 

operation %1

Indicates normal 
adapter operation. No 
action necessary.
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AER3-000001 R3-CORE-
APP-8001

Error AD Invalid closure 

data for operation 

%1

Create a correct 
instance of 
RFC_CLOSURE 
defined in 
SAPAdapterSchema.x

ml and set it as closure 
data in the request to 
be sent to the inbound 
adapter. To find out 
more about closure, 
refer to TIB Adapter 
SDK documentation 
and TIBCO 2.0 
ActiveEnterprise wire 
format.

AER3-000002 R3-CORE-
APP-8002

Error AP Invalid value for 

attribute %1 for 

operation %2

Verify if you are using 
the correct class 
descriptions and value 
specified is valid and 
no mandatory values 
are omitted.

AER3-000003 R3-CORE-
APP-8003

Error AD Function call is 

transactional but 

no TID provided

When you set 
bTransactional in 
closure, you must also 
supply a value for 
TID.

AER3-000004 R3-CORE-
APP-8004

INFO S Adapter 

application %1 is 

stopped

Indicates normal 
adapter operation. No 
action necessary.
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AER3-000005 R3-CORE-
CFG-1000

Error C Could not find 

interface 

description 

element

This problem might 
also occur if the 
configuration file is 
edited manually and is 
invalidated in the 
process. After making 
any changes to the file 
make sure that the 
XML file is well 
formed. The SML file 
can be validated by 
opening it in an XML 
enabled browser.

AER3-000006 R3-CORE-
CFG-1001

Error C %1 not specified 

for %2

This problem might 
also occur if the 
configuration file is 
edited manually and is 
invalidated in the 
process. After making 
any changes to the file 
make sure that the 
XML file is well 
formed. The file can be 
validated by opening 
it in an XML enabled 
browser.

Table 25   Error Messages with Changed Codes

New 
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Code
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AER3-000007 R3-CORE-
CFG-1003

INFO C TID management is 

local

It is advisable to use a 
remote TIDManager if 
more than multiple 
adapters are running 
in a load balanced 
manner. This is to 
ensure that the failed 
transactions are not 
executed twice among 
the load balanced 
group. This means that 
it is possible to get 
duplicate messages if 
more than one 
adapters are being run 
in a load balanced 
configuration and are 
setup to do local TID 
management. 

AER3-000008 R3-CORE-
CFG-1004

Error C TID file is not 

specified

Specify the TID file 
name, attribute 
"tidFileName" in the 
adapter instance level 
Adapter Services 

tab.

AER3-000009 R3-CORE-
CFG-1005

Error C Timer %1 does not 

exist

Provide a correct 
reference to the TIB 
Adapter SDK timer in 
the server connection 
section of the 
connection manager.

AER3-000010 R3-CORE-
CFG-1006

Error C The interface %1 

does not specify 

attribute 

'classRef'

Provide a correct 
reference to the TIBCO 
Adapter SDK timer in 
the server connection 
section of the 
connection manager
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AER3-000011 R3-CORE-
CFG-1007

Error C Invalid producer 

%1

Provide a correct 
reference to an TIBCO 
Adapter SDK 
producer (publisher).

AER3-000013 R3-CORE-
CFG-1009

Error C No RpcClient 

specified for 

operation %1

Provide a valid 
reference to an TIB 
Adapter SDK RPC 
Client through 
"mbRpcClientRef" 
element in 
Deployment 
Descriptions of IDocs.

AER3-000014 R3-CORE-
CFG-1010

WARN C Interface %1 does 

not contain 

deployment 

description for 

IDocs... 

continuing...

Provide a valid 
reference to an 
MBOperation. Also 
add a reference to the 
XML document that 
contains the 
descriptions for this 
operation. This is done 
using the model 
document tag at the 
beginning of the 
configuration file in 
the document section.

The default class 
descriptions for MB 
operations, i.e. 
UserExitSchema.xml, 
can also be extended 
with class description 
for additional 
operations.
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AER3-000015 R3-CORE-
CFG-1011

INFO C Invalid producer 

%1; using default 

producer %2

Indicates normal 
adapter operation. No 
action necessary.

AER3-000016 R3-CORE-
CFG-1012

Error C Invalid consumer 

component %1

Modify your 
configuration by 
defining a consumer 
name as suggested by 
the error description.

AER3-000017 R3-CORE-
CFG-1013

Error C No components 

defined in the 

configuration 

document

Modify your 
configuration so that it 
has at least one 
component under the 
'components' section.

AER3-000018 R3-CORE-
CFG-1014

Error C No connection 

manager defined in 

the configuration 

document

Modify your 
configuration so that it 
has a 
'connectionManager' 
under the 
'connectionManagers' 
section.

AER3-000019 R3-CORE-
CFG-1015

Error C Invalid rpcServer 

%1 specified for 

interface %2

Modify your 
configuration so that it 
has a 
'connectionManager' 
under the 
'connectionManagers' 
section.

AER3-000020 R3-CORE-
CFG-1016

Error C The Subscriber 

Description does 

not specify 

consumer 

reference, 

skipping ...

Add consumerRef 
attribute in the 
configuration.
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AER3-000021 R3-CORE-
CFG-1017

Error C Consumer %1 for 

deployment 

description %2 

does not exist

ConsumerRef must 
point to a valid 
subscriber.

AER3-000022 R3-CORE-
CFG-1018

WARN C No instance 

defined for %1; 

control fields 

will not be 

replaced

You must have an 
instance defined under 
class instances.

AER3-000023 R3-CORE-
CFG-1019

WARN C Invalid reference 

for attribute 

consumerRef

ConsumerRef must 
point to a valid 
subscriber.

AER3-000024 R3-CORE-
FIL-3000

Error S Error while 

reading 

directory=%1, 

filename=%2; %3

Determine the cause 
from the error 
description.

AER3-000025 R3-CORE-
FIL-3001

WARN S directory=%1, 

filename=%2; No 

matching files 

found

There were no 
matching files. Check 
your filenames.

AER3-000026 R3-CORE-
FIL-3002

Error S Could not open %1 

for reading

The specific file could 
not be opened. Check 
permissions.

AER3-000027 R3-CORE-
FIL-3003

Error S %1 is unreadable Check whether the file 
can be opened using a 
text editor.

AER3-000028 R3-CORE-
FIL-3004

WARN S %1 is empty File is empty.

AER3-000029 R3-CORE-
FIL-3005

Error S %1 does not 

contain newline. 

Perhaps not a text 

file

The file is not a text 
file, because it does 
not contain a new line.
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AER3-000030 R3-CORE-
FIL-3006

INFO AD IDoc from file %1 

sent in %2 mode

Indicates normal 
adapter operation. No 
action necessary.

AER3-000031 R3-CORE-
IDC-7000

Error AD Unsupported 

datatype %1

The datatype is 
unsupported by SDK 
or SAP or both. 

AER3-000032 R3-CORE-
IDC-7001

WARN AD Cannot get control 

record for IDoc

The IDoc does not 
have a control record. 
If it’s not intentional, 
add a control record.

AER3-000033 R3-CORE-
IDC-7002

Error AD class name invalid 

for IDoc

The adapter received 
an IDoc but could not 
determine its class. If 
you are creating the 
IDoc meant to be 
consumed by the 
adapter, ensure that 
you are creating it 
correctly.

AER3-000034 R3-CORE-
LIB-6000

WARN AD False call to %1 See the error 
description for more 
details.

AER3-000035 R3-CORE-
LIB-6001

WARN AD Could not generate 

GUID

Even though a 
warning, this message 
is often indicative of a 
memory-low situation 
that could severely 
affect the adapter 
performance.

Table 25   Error Messages with Changed Codes

New 
Message 
Code

Old 
Message 
Code

Severity Cat. Description Resolution



 TIBCO ActiveMatrix Adapter Service Engine for SAP Configuration and Deployment

Status Messages | 187

AER3-000036 R3-CORE-
LIB-6002

Error AD No connection for 

%1

The named 
component does not 
have a valid 
connection Manager. 
Refer also to the 
description for 
'R3-CORE-CFG-1014'.

AER3-000037 R3-CORE-
LIB-6003

Error AD Could not create 

TIDManager

If the problem persists, 
repeat with remote 
TID Management. 

AER3-000038 R3-CORE-
LIB-6004

Error C Could not find 

default client 

connection

Modify your 
configuration so that 
the login parameters 
that you specify for 
'defaultClient' are 
valid and that the 
Adapter can establish 
a valid connection to 
the SAP System.

AER3-000039 R3-CORE-
LIB-6005

Error AD No proxy defined 

to process request 

for RFC function 

%1

The Adapter could not 
create a proxy for the 
named RFC function. 
Look at the earlier 
error messages in the 
log file(s) for possible 
causes.

AER3-000040 R3-CORE-
LIB-6006

INFO AD Adding RFC 

function %1

For an inbound 
configuration, the 
message means that 
the Adapter can serve 
as an RFC Client; for 
an outbound 
configuration, the 
message means that 
the Adapter can serve 
as an RFC Server.
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AER3-000041 R3-CORE-
LIB-6007

Error AD Unable to create 

RFC server 

function %1

Look at earlier error 
messages in the log 
file(s) for possible 
causes.

AER3-000042 R3-CORE-
LIB-6008

Error AD Unable to create 

request proxy for 

%1

Look at earlier error 
messages in the log 
file(s) for possible 
causes.

AER3-000043 R3-CORE-
LIB-6009

Error AD Unable to create 

RFC client for %1

Look at earlier error 
messages in the log 
file(s) for possible 
causes.

AER3-000044 R3-CORE-
LIB-6010

Error AD Unable to create 

function impl for 

%1

Look at earlier error 
messages in the log 
file(s) for possible 
causes.

AER3-000045 R3-CORE-
LIB-6011

Error AD RFC function 

initialization 

failure : %1; 

function name : %2

Look at the error 
description for the 
cause of the failure.

AER3-000046 R3-CORE-
LIB-6012

Error AD Cannot create 

publisher proxy 

for %1

Look at earlier error 
messages in the log 
file(s) for possible 
causes.
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AER3-000047 R3-CORE-
LIB-6014

Error AP %1 is not a valid 

structure or table

If the name represents 
a valid SAP structure 
(or table), ensure that 
the repository contains 
the class definition for 
this structure (or 
table). If you are 
sending data from 
your custom 
program(s) to the SAP 
Adapter, make sure 
that you're 
constructing the data 
correctly and that 
you're using valid 
classes.

AER3-000048 R3-CORE-
LIB-6015

Error AD Unpacking error: 

Invalid class type 

for structure %1

Data inappropriate for 
the named structure. 
See also 
R3-CORE-LIB-6014.

AER3-000049 R3-CORE-
LIB-6016

Error AD Unpacking error: 

Invalid class type 

for table %1

Data inappropriate for 
the named table. See 
also 
R3-CORE-LIB-6014.

AER3-000050 R3-CORE-
LIB-6017

Error AP Unpacking error: 

Row of table %1 is 

not a structure

Data inappropriate for 
the named table. See 
also 
R3-CORE-LIB-6014.

AER3-000051 R3-CORE-
LIB-6018

INFO AD User-defined 

operation called 

successfully

The Adapter invoked 
the user-defined 
operation successfully.
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AER3-000052 R3-CORE-
LIB-6019

Error AD Invalid or no data 

received from 

user-defined 

operation

Check the program 
that implements the 
user-defined operation 
and make sure that it 
returns data.

AER3-000053 R3-CORE-
LIB-6020

Error AD User-defined 

operation 

invocation 

exception; name : 

%1, data : %2

Ensure that your 
operation executes 
without any exception 
and that it returns 
valid data to the 
Adapter.

AER3-000054 R3-CORE-
LIB-6021

Error AD User-defined 

operation 

invocation timeout

Ensure that the Rpc 
Server that 
implements your 
operation is running 
and that it is reachable 
from the Adapter.

AER3-000055 R3-CORE-
LIB-6022

Error AD User-defined 

operation 

invocation : bad 

reply received

Ensure that your 
operation returns 
valid data to the 
Adapter.

AER3-000056 R3-CORE-
LIB-6023

Error AD User-defined 

operation 

invocation 

exception; name : 

%1

Ensure that your 
operation executes 
without any exception 
and that it returns 
valid data to the 
Adapter.

AER3-000057 R3-CORE-
LIB-6024

Error AD The request sent 

to user-defined 

operation contains 

invalid data

If you're constructing 
the data to be sent to 
the user-defined 
operation, ensure that 
it's being constructed 
correctly.
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AER3-000058 R3-CORE-
LIB-6025

Error AD Invalid operation 

name for IDoc %1

The Adapter found 
that the IDoc data is 
arriving from a 
function other than 
'IDOC_INBOUND_AS
YNCHRONOUS'  or 
'INBOUND_IDOC_PR
OCESS'.

AER3-000059 R3-CORE-
LIB-6026

Error AD Cannot create IDoc 

parser instance

The error indicates 
that it could not create 
a parser, either 
because of a 
memory-low problem 
or because of an earlier 
error during Adapter 
initialization.

AER3-000060 R3-CORE-
LIB-6027

Error AP Invalid RFC 

function %1

Look at earlier error 
messages in the log 
file(s) for possible 
causes.

AER3-000061 R3-CORE-
LIB-6028

WARN AD The IDoc %1 could 

not be exploded

See 
R3-CORE-LIB-6026.

AER3-000062 R3-CORE-
LIB-6029

Error AD Unable to create 

reply listener for 

operation %1

See earlier messages in 
the log file(s) for 
possible causes.

AER3-000063 R3-CORE-
LIB-6030

Error AD RFC invocation 

timeout for 

function %1; 

description : %2

The named RFC 
function invocation 
timed out. See error 
description for more 
details.
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AER3-000064 R3-CORE-
LIB-6031

Error AD RFC invocation bad 

reply for function 

%1; description : 

%2

The named RFC 
function returned a 
bad reply. See error 
description for more 
details.

AER3-000065 R3-CORE-
LIB-6032

Error AD RFC invocation 

remote exception; 

name : %1, 

description : %2

The named RFC 
function caused a 
remote exception. See 
error description for 
more details.

AER3-000066 R3-CORE-
LIB-6033

Error AD Cannot create IDoc 

parser instance 

for subscriber %1

The error indicates 
that it could not create 
a parser, either 
because of a 
memory-low problem 
or because of an earlier 
error during Adapter 
initialization.

AER3-000067 R3-CORE-
LIB-6034

WARN AD Invalid MTree data 

received for 

subscriber

See earlier error 
messages in the log 
file(s) for possible 
causes.
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AER3-000068 R3-CORE-
LIB-6035

Error AD Cannot create IDoc 

data instance from 

received IDoc tree

The adapter subscriber 
received MTree data 
but the received data 
could not be converted 
to an MInstance. 
Because an MInstance 
is an MTree bounded 
by a class, the error 
implies that the 
received MTree is 
incorrect. If it is your 
application that is 
sending the offending 
data to the adapter 
subscriber, make sure 
that your data is valid.

AER3-000069 R3-CORE-
LIB-6036

Error AD Cannot implode 

IDoc %1

Either the adapter 
encountered a 
low-memory 
condition or the 
received data is 
incorrect. If it is your 
application that is 
sending the offending 
data to the adapter 
subscriber, make sure 
that your data is valid.

AER3-000070 R3-CORE-
LIB-6037

Error AD Cannot get RFC 

client function %1

Make sure that SAP 
login parameters are 
correct and that the 
subscriber adapter can 
reach the SAP system. 
Also check earlier 
error messages in the 
log file(s) for possible 
causes.
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AER3-000071 R3-CORE-
LIB-6038

Error AD Cannot get 

marshaller for RFC 

client function %1

The subscriber adapter 
could not get 
marshaller to convert 
between adapter data 
and SAP data, perhaps 
because of a 
low-memory problem 
or because of an error 
encountered earlier 
during initialization. 
Check the earlier error 
messages in the log 
file(s) for possible 
causes.

AER3-000072 R3-CORE-
LIB-6039

Error AP Client connection 

%1 is invalid

Ensure that the login 
parameters are correct 
and that the Adapter 
can reach the SAP 
system.

AER3-000073 R3-CORE-
LIB-6040

Error AP Cannot get RFC 

connection for 

client %1

See R3-CORE-LIB-60.

AER3-000074 R3-CORE-
LIB-6041

Error AD Operation %1 timed 

out

Make sure that the 
RPC Server that 
corresponds to the 
named operation is 
executing and is 
accessible from the 
Adapter.

AER3-000075 R3-CORE-
LIB-6042

WARN AD Operation %1 

returned a bad 

reply %2

The named operation 
returned a bad reply. 
Look at the error 
message description 
for more details.
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AER3-000076 R3-CORE-
LIB-6043

Error AD Initialization 

exception type : 

%1, operation : 

%2, description : 

%3

The named operation 
returned the named 
exception. Look at the 
error message 
description for more 
details.

AER3-000078 R3-CORE-
LIB-6045

INFO AD Successfully added 

RFC function %1

The Adapter 
successfully added the 
named RFC function. 
Depending on the 
configuration, the 
adapter can function 
as an RFC client, RFC 
Server, or both.

AER3-000079 R3-CORE-
LIB-6046

Error AD Unpacking error The Adapter 
encountered an error 
either because of 
low-memory 
condition or because 
of an error earlier 
during the 
initialization. Check 
the earlier error 
messages in the log 
file(s) for possible 
causes.

AER3-000080 R3-CORE-
LIB-6047

WARN AD Could not create 

TIBCO RV advisory 

handlers; 

exception type : 

%1, description : 

%2

The Adapter could not 
create the license 
expiry advisories. 
Look at the error 
description for more 
details.
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AER3-000081 R3-CORE-
LIB-6048

WARN AD Could not create 

TIBCO Hawk 

implants; 

exception type : 

%1, description : 

%2

The adapter could not 
create TIBCO Hawk 
implants. Look at the 
error description for 
more details.

AER3-000082 R3-CORE-
LIB-6049

INFO AD Successful 

initialization of 

Adapter

Indicates normal 
adapter operation. No 
action necessary.

AER3-000083 R3-CORE-
LIB-6050

Error AD Unable to create 

operation request 

for function : %1, 

class : %2, 

rpcClient : %3

The Adapter could not 
create Operation 
request for the named 
function. Look at the 
error description for 
more details.

AER3-000084 R3-CORE-
LIB-6051

INFO AP Received IDoc 

Name/Number/Receiv

ing Partner: %1, 

Count: %2

Indicates normal 
adapter operation. No 
action necessary.

AER3-000085 R3-CORE-
LIB-6052

INFO AD IDoc sent in %1 

mode

Indicates normal 
adapter operation. No 
action necessary.

AER3-000086 R3-CORE-
LIB-6053

INFO AD IDoc received in 

%1 mode

Indicates normal 
adapter operation. No 
action necessary.

AER3-000087 R3-CORE-
LIB-6054

INFO AD IDoc Sent to SAP 

System

Indicates normal 
adapter operation. No 
action necessary.

AER3-000088 R3-CORE-
LIB-6055

INFO AD IDoc sent as a 

Business Document

Indicates normal 
adapter operation. No 
action necessary.

AER3-000089 R3-CORE-
LIB-6056

INFO AD IDoc received as a 

Business Document

Indicates normal 
adapter operation. No 
action necessary.
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AER3-000090 R3-CORE-
LIB-6057

INFO C The Destination %1 

in not defined, 

IDoc is logged to 

file %2

Indicates normal 
adapter operation. No 
action necessary.

AER3-000091 R3-CORE-
LIB-6058

INFO AD Total IDocs 

processed: %1

Indicates normal 
adapter operation. No 
action necessary.

AER3-000092 R3-CORE-
LIB-6059

INFO AD The subscriber for 

this IDoc message 

could not be 

determined

Indicates normal 
adapter operation. No 
action necessary.

AER3-000093 R3-CORE-
LIB-6060

INFO AD IDoc Message 

sequence number %1 

confirmed to %2

Indicates normal 
adapter operation. No 
action necessary.

AER3-000094 R3-CORE-
LIB-6061

INFO AD Preparing to send 

IDoc to client %1

Indicates normal 
adapter operation. No 
action necessary.

AER3-000095 R3-CORE-
LIB-6062

INFO AD IDoc sent to 

client %1

Indicates normal 
adapter operation. No 
action necessary.

AER3-000096 R3-CORE-
LIB-6064

INFO AD IDoc Message 

sequence number %1 

could not be 

confirmed to %2, 

Use 

pre-registration 

of subscribers

Indicates normal 
adapter operation. No 
action necessary.

AER3-000097 R3-CORE-
LIB-6065

INFO C IDoc Message could 

not be confirmed, 

validation must be 

turned off, if 10X 

Publishers used

Indicates normal 
adapter operation. No 
action necessary.
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AER3-000098 R3-CORE-
LIB-6066

INFO AP IDoc RFC Function 

invoked: %1

Indicates normal 
adapter operation. No 
action necessary.

AER3-000099 R3-CORE-
LIB-6067

INFO AD RFC Function 

invoked: %1

Indicates normal 
adapter operation. No 
action necessary.

AER3-000100 R3-CORE-
LIB-6068

WARN C User-defined 

operation: 

operation not 

specified, 

assuming 

'transform'

If the default transfer 
is not desired, name 
your operation 
explicitly.

AER3-000101 R3-CORE-
LIB-6069

WARN C User-defined 

operation 

reference: 

operationRpcClient

Ref not specified, 

operation will not 

be invoked

The operation requires 
an rpcClient, specific 
through 
operationRpcClientRef
. Specify this client.

AER3-000102 R3-CORE-
LIB-6070

Error AD TID operation 

timed out. Make 

sure that 

TIDManager is 

running

Make sure 
TIDManager is 
running and is 
accessible from the 
Adapter. Also, ensure 
that subject names 
match.

AER3-000103 R3-CORE-
LIB-6071

INFO AD Adding %1 

parameter %2, Type 

%3

Indicates normal 
adapter operation. No 
action necessary.

AER3-000104 R3-CORE-
LIB-6072

INFO AD Setting up Imports 

and Exports for 

RFC function %1

Indicates normal 
adapter operation. No 
action necessary.

AER3-000105 R3-CORE-
LIB-6073

INFO AD RFC function has 

%1 imports, %2 

exports

Indicates normal 
adapter operation. No 
action necessary.
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AER3-000106 R3-CORE-
LIB-6074

INFO AD    %1 = { %2 } Indicates normal 
adapter operation. No 
action necessary.

AER3-000107 R3-CORE-
LIB-6075

INFO AD Number of records 

in table %1 = %2

Indicates normal 
adapter operation. No 
action necessary.

AER3-000108 R3-CORE-
LIB-6076

INFO AD Invoking function: 

%1 ...

Indicates normal 
adapter operation. No 
action necessary.

AER3-000109 R3-CORE-
LIB-6077

INFO AD Successfully 

invoked function: 

%1

Indicates normal 
adapter operation. No 
action necessary.

AER3-000110 R3-CORE-
LIB-6078

INFO AD Reply sent for 

function: %1

Indicates normal 
adapter operation. No 
action necessary.

AER3-000111 R3-CORE-
LIB-6079

INFO AD Received reply 

for: %1 ...

Indicates normal 
adapter operation. No 
action necessary.

AER3-000112 R3-CORE-
LIB-6080

INFO AD Data sent back to 

SAP System

Indicates normal 
adapter operation. No 
action necessary.

AER3-000113 R3-CORE-
LIB-6081

INFO AD Performing one way 

invocation on the 

server

Indicates normal 
adapter operation. No 
action necessary.

AER3-000114 R3-CORE-
LIB-6082

INFO AD Received 

invocation request 

for %1 from SAP 

System

Indicates normal 
adapter operation. No 
action necessary.

AER3-000115 R3-CORE-
LIB-6083

INFO AD Performing 

invocation on the 

server

Indicates normal 
adapter operation. No 
action necessary.
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AER3-000116 R3-CORE-
LIB-6084

INFO AD Function call is 

transactional, 

TID: %1

Indicates normal 
adapter operation. No 
action necessary.

AER3-000117 R3-CORE-
LIB-6085

INFO AD Received 

invocation request 

for %1

Indicates normal 
adapter operation. No 
action necessary.

AER3-000118 R3-CORE-
LIB-6086

INFO AD Invoking RFC 

function %1 in SAP 

System

Indicates normal 
adapter operation. No 
action necessary.

AER3-000119 R3-CORE-
LIB-6087

INFO AD Received one way 

invocation request 

for %1

Indicates normal 
adapter operation. No 
action necessary.

AER3-000120 R3-CORE-
LIB-6088

INFO AD Invoking 

transactional RFC 

function %1 in SAP 

System

Indicates normal 
adapter operation. No 
action necessary.

AER3-000121 R3-CORE-
LIB-6089

INFO C Cannot get class 

descriptions for 

control record of 

IDoc class %1

Indicates normal 
adapter operation. No 
action necessary.

AER3-000122 R3-CORE-
LIB-6090

Error AP The IDoc %1 does 

not contain a 

control record

Make sure that the 
IDoc contains a control 
record.

AER3-000123 R3-CORE-
LIB-6091

Error C Cannot get class 

descriptions for 

data record of 

IDoc class %1

During configuration 
ensure that you are 
downloading the class 
descriptions.

AER3-000124 R3-CORE-
LIB-6092

Error AD The received IDoc 

tree in exploded 

form is null

Make sure that the 
Tree (MTree in SDK) is 
created correctly and 
corresponds to an 
IDoc.
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AER3-000125 R3-CORE-
LIB-6093

Error C Class descriptions 

cannot be obtained 

for received IDoc 

tree

During configuration 
ensure that you are 
downloading the class 
descriptions.

AER3-000126 R3-CORE-
LIB-6094

Error C %1 is not of a 

sequence type

The named sequence 
does not have a valid 
definition. Check the 
configuration.

AER3-000127 R3-CORE-
LIB-6095

Error C Sequence %1 does 

not have a 

contained class 

description

A sequence is a 
sequence of objects of 
type T. The adapter 
could not determine T, 
probably because the 
definitions don’t exist 
in the configuration.

AER3-000128 R3-CORE-
LIB-6096

Error C Sequence %1 for 

the segment holder 

could not be 

obtained

Check configuration 
and make sure that a 
valid definition exists 
for the named 
sequence.

AER3-000129 R3-CORE-
LIB-6097

Error C Segment %1 does 

not have 

attribute: %2

The data mentioned 
contains the named 
attribute, but the class 
definition does not. 
Check the 
configuration and how 
the IDoc is being 
created.

AER3-000130 R3-CORE-
LIB-6098

Error C Cannot obtain 

field class 

description for 

IDoc Segment

Check configuration.
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AER3-000131 R3-CORE-
LIB-6099

Error AD Cannot get EDIDD 

header attribute 

from the fields 

for segment %1

Check the data. It must 
include the EDIDD 
header.

AER3-000132 R3-CORE-
LIB-6100

Error C Cannot obtain 

class description 

for segment %1 

attribute %2

Check the segment 
name as well as the 
attribute and make 
sure that a definition 
exists in the 
configuration.

AER3-000133 R3-CORE-
LIB-6101

INFO AD The segment 

instance %1 does 

not contain 

attribute %2

Indicates normal 
adapter operation. No 
action necessary.

AER3-000134 R3-CORE-
LIB-6102

INFO AD The default values 

will be used

Indicates normal 
adapter operation. No 
action necessary.

AER3-000135 R3-CORE-
LIB-6103

INFO AD Segment name: %1 

added

Indicates normal 
adapter operation. No 
action necessary.

AER3-000136 R3-CORE-
LIB-6104

Error AD The %1 record 

sequence does not 

contain a valid 

control record

Check the data first. 
Make any changes. 
Check the 
configuration for an 
appropriate definition.

AER3-000137 R3-CORE-
LIB-6105

Error C The %1 record of 

the IDoc does not 

have a valid class 

description

Check the data first. 
Make any changes. 
Check the 
configuration for an 
appropriate definition.

AER3-000138 R3-CORE-
LIB-6106

INFO AD The %1 record does 

not contain 

attribute %2

Indicates normal 
adapter operation. No 
action necessary.
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AER3-000139 R3-CORE-
LIB-6107

INFO AD trying to recover 

the received 

message ...

Indicates normal 
adapter operation. No 
action necessary.

AER3-000140 R3-CORE-
LIB-6108

INFO AD Subscriber: %1, 

Exception occurred 

on receiving the 

message

Indicates normal 
adapter operation. No 
action necessary.

AER3-000141 R3-CORE-
LIB-6109

Error AD Subscriber: %1, 

the message could 

not be recovered

Indicates normal 
adapter operation. No 
action necessary.

AER3-000142 R3-CORE-
LIB-6110

INFO AD Subscriber: %1, 

The 10X Opaque 

message type is 

not supported

Indicates normal 
adapter operation. No 
action necessary.

AER3-000143 R3-CORE-
LIB-6111

INFO AD the received 

message was 

recovered

Indicates normal 
adapter operation. No 
action necessary.

AER3-000144 R3-CORE-
LIB-6112

INFO AD The IDoc message 

received in 10X 

format does not 

contain %1field

Indicates normal 
adapter operation. No 
action necessary.

AER3-000145 R3-CORE-
LIB-6113

Error C The class 

descriptions for 

IDoc base classes 

cannot be obtained 

from the registry

During configuration 
ensure that you’ve 
downloaded the class 
definition.

AER3-000146 R3-CORE-
LIB-6114

INFO AD Function called 

transactionally 

but Transaction 

Identifier (TID) 

not supplied

Indicates normal 
adapter operation. No 
action necessary.
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AER3-000147 R3-CORE-
LIB-6115

Error S Could not open 

file %1 for 

writing

File could not be 
opened. Check 
permissions and 
whether you’ve 
adequate space on 
your disk.

AER3-000148 R3-CORE-
LIB-6116

Error AD CIDocIterator: The 

IDoc container 

does not contain 

any IDocs

Check the log file for 
any previous errors 
that may have led to 
this situation.

AER3-000149 R3-CORE-
LIB-6117

Error AD The IDoc %1 does 

not contain %2

The IDoc does not 
contain a data record 
section. Check the 
IDoc data.

AER3-000150 R3-CORE-
LIB-6118

Error AD No control record 

instance for the 

%1 IDoc in the 

packet

The named IDoc does 
not have a control 
record. Check the data.

AER3-000151 R3-CORE-
LIB-6119

Error AD No data record 

instance for the 

%1 IDoc in the 

packet

The IDoc does not 
contain a data record 
section. Check the 
data.

AER3-000152 R3-CORE-
LIB-6120

Error AD %1 record of the 

data record 

instance does not 

contain mandatory 

attribute DOCNUM

DOCNUM is a 
mandatory attribute 
for data record. Check 
the data and modify it 
to include DOCNUM.

AER3-000153 R3-CORE-
LIB-6121

INFO AD %1 row of the data 

record instance of 

the %2 IDoc 

instance of type 

%3 could not be 

obtained

Indicates normal 
adapter operation. No 
action necessary.
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AER3-000154 R3-CORE-
LIB-6122

Error S The IDoc instance 

could not be 

written to file, 

the instance is 

invalid

The Instance could not 
be written because it 
was empty. Check the 
IDoc data.

AER3-000155 R3-CORE-
LIB-6123

Error AD The IDoc does not 

contain a data 

record

The IDoc does not 
contain a data record 
section. Check the 
IDoc data.

AER3-000156 R3-CORE-
LIB-6124

INFO AD Writing IDoc %1, 

Number %2 to file: 

%3

Indicates normal 
adapter operation. No 
action necessary.

AER3-000157 R3-CORE-
LIB-6125

INFO AD Invocation for RFC 

function %1 still 

pending

Indicates normal 
adapter operation. No 
action necessary.

AER3-000158 R3-CORE-
LIB-6126

INFO AD Adapters 

initialization 

mode:%1

Indicates normal 
adapter operation. No 
action necessary.

AER3-000159 R3-CORE-
LIB-6127

WARN AD Cannot find 

communication 

client for 

TIDManager, TID 

Management will be 

local

The configuration 
does not specify the 
rpcClient for 
TIDManager, hence 
the TID management 
will be local.

AER3-000160 R3-CORE-
LIB-6128

INFO AD Connection: 

waiting for reply 

from server ...

Indicates normal 
adapter operation. No 
action necessary.

AER3-000161 R3-CORE-
LIB-6129

INFO AD No component for 

the RFC call; 

Exception=%1

Indicates normal 
adapter operation. No 
action necessary.

AER3-000162 R3-CORE-
LIB-6130

INFO AD Active connection 

is null

Indicates normal 
adapter operation. No 
action necessary.
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AER3-000163 R3-CORE-
LIB-6131

INFO AD Checking for 

connections

Indicates normal 
adapter operation. No 
action necessary.

AER3-000164 R3-CORE-
LIB-6132

INFO AD Connection 

disconnected

Indicates normal 
adapter operation. No 
action necessary.

AER3-000165 R3-CORE-
LIB-6133

INFO AD Connection 

re-established

Indicates normal 
adapter operation. No 
action necessary.

AER3-000166 R3-CORE-
LIB-6134

INFO AD Connection State: 

Available

Indicates normal 
adapter operation. No 
action necessary.

AER3-000167 R3-CORE-
LIB-6135

INFO AD Connection State: 

Pending invocation

Indicates normal 
adapter operation. No 
action necessary.

AER3-000168 --NEW-- INFO AD %1 connection 

could not be 

removed

Indicates normal 
adapter operation. No 
action necessary.

AER3-000169 R3-CORE-
LIB-6136

WARN AD Subscriber %1 

could not be 

suspended

The named subscriber 
could not be 
suspended. No action 
necessary.

AER3-000170 R3-CORE-
LIB-6137

WARN AD Stop Adapter: 

Correct consumer 

reference could 

not be obtained 

from deployment 

description %1, 

skipping...

The configuration did 
not specify 
consumerRef. No 
action necessary.

AER3-000171 R3-CORE-
LIB-6138

INFO AD Adapter is waiting 

for invocation 

response before 

shutdown can 

proceed...

Indicates normal 
adapter operation. No 
action necessary.
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AER3-000172 R3-CORE-
LIB-6139

INFO AD Adapter stop 

method called

Indicates normal 
adapter operation. No 
action necessary.

AER3-000173 R3-CORE-
LIB-6141

INFO AD Subscriber %1 

suspended

Indicates normal 
adapter operation. No 
action necessary.

AER3-000174 R3-CORE-
LIB-6142

INFO AD Connection Manager 

%1 stopped

Indicates normal 
adapter operation. No 
action necessary.

AER3-000175 R3-CORE-
LIB-6143

INFO AD Component %1 

stopped

Indicates normal 
adapter operation. No 
action necessary.

AER3-000176 R3-CORE-
LIB-6144

INFO AD Deactivating stop 

scheduler

Indicates normal 
adapter operation. No 
action necessary.

AER3-000177 R3-CORE-
LIB-6145

INFO AD Stopping Adapter 

%1 instance on 

host %2

Indicates normal 
adapter operation. No 
action necessary.

AER3-000178 R3-CORE-
LIB-6146

INFO AD Stop notification 

received via TIBCO 

RV

Indicates normal 
adapter operation. No 
action necessary.

AER3-000179 R3-CORE-
LIB-6147

Error AD Remote Exception: 

Exception Name: 

%1, Exception 

Data: %2 

See the error 
description for details.

AER3-000180 R3-CORE-
RVD-9000

WARN AD ADV_CLASS/ADV_SOUR

CE/ADV_NAME: %1, 

ADV_DESC : %2 %3 

See the error 
description for more 
details.
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AER3-000181 R3-CORE-
RVD-9001

Error AD ADV_CLASS/ADV_SOUR

CE/ADV_NAME: %1, 

ADV_DESC : %2 %3

The adapter responds 
'license expiry' 
warning from the 
daemon with this 
message.

AER3-000182 R3-CORE-
RVD-9002

Error AD ADV_CLASS : %1, 

ADV_SOURCE : %2, 

ADV_NAME : %3

The adapter responds 
'registration collision' 
error from the daemon 
with this message.

AER3-000183 R3-CORE-
SAP-4000

Error AP RFC error; Group : 

%1, Key : %2, 

Message : %3

Look at the error 
description for details 
about the SAP 
Exception. Also check 
your connection 
parameters.

AER3-000184 R3-CORE-
SAP-4001

Error AP RFC connection 

invalid for %1

The adapter could not 
get a valid connection 
to the SAP system. 
Check your login 
parameters. Also make 
sure that the adapter 
can reach the SAP 
system.

AER3-000185 R3-CORE-
SAP-4002

Error AP CallReceive failed 

for operation %1; 

exception : %2, 

RFC error; 

Group/Key/Message: 

%3

Look at the error 
description for details 
about the SAP 
Exception.

AER3-000186 R3-CORE-
SAP-4003

INFO AP Transaction %1 

skipped

The Adapter did not 
execute this 
transaction because it 
was already executed.
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AER3-000187 R3-CORE-
SAP-4004

WARN AP Invalid 

transaction state 

received from 

TIDManager for 

transaction %1

The Adapter received 
an invalid stated from 
TIDManager. Check 
the tidmanager 
display for possible 
causes.

AER3-000188 R3-CORE-
SAP-4005

WARN AD Failed to %1 Tid The Adapter could not 
perform the named 
TID/Manager 
function. Check the 
TID/Manager display 
for possible causes.

AER3-000189 R3-CORE-
SAP-4007

Error AP RFC function 

initialization 

error for function 

%1; RFC Error; 

Group/Key/Message 

: %2

Look at the error 
description for details 
about the SAP 
Exception.

AER3-000190 R3-CORE-
SAP-4008

WARN AD RFC remote 

function %1 

implementation 

exception %2

Look at the error 
description for details 
about the SAP 
Exception.

AER3-000191 R3-CORE-
SAP-4009

Error AP Indirect call 

error while 

sending IDoc; RFC 

Error; Group : %1, 

Key : %2, Message 

: %3

Look at the error 
description for details 
about the SAP 
Exception.

AER3-000192 R3-CORE-
SAP-4010

Error AP RFC error; Group : 

%1, Key : %2, 

Message : %3, 

Attempt to connect 

timed out

See the error 
description for details.
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AER3-000193 R3-CORE-
SAP-4011

Error AD Connection not 

available for 

client %1, 

retrying ...

See the error 
description for details.

AER3-000194 R3-CORE-
SAP-4012

INFO AD Invalid RFC client 

connection object 

for client %1

Indicates normal 
adapter operation. No 
action necessary.

AER3-000195 R3-CORE-
SAP-4013

INFO AD Transaction 

created %1

Indicates normal 
adapter operation. No 
action necessary.

AER3-000196 R3-CORE-
SAP-4014

INFO AD Transaction 

skipped %1

Indicates normal 
adapter operation. No 
action necessary.

AER3-000197 R3-CORE-
SAP-4015

INFO AD Transaction 

committed %1

Indicates normal 
adapter operation. No 
action necessary.

AER3-000198 R3-CORE-
SAP-4016

INFO AD Transaction 

confirmed %1

Indicates normal 
adapter operation. No 
action necessary.

AER3-000199 R3-CORE-
SAP-4017

INFO AD Transaction rolled 

back %1

Indicates normal 
adapter operation. No 
action necessary.

AER3-000200 R3-CORE-
SAP-4018

Error AD Failed to update 

state for 

transaction %1. 

Ensure that the 

user has write 

permissions for 

tidFile.tid

Look at the earlier 
error messages in the 
log-file(s) for possible 
causes. One of the 
reasons for this error 
could be that, you do 
not have write 
permissions for the 
tidFile.tid.
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AER3-000201 R3-CORE-
SAP-4019

INFO AD Starting Inbound 

transaction %1

Indicates normal 
adapter operation. No 
action necessary.

AER3-000202 R3-CORE-
SAP-4020

INFO AD Inbound 

transaction %1 

completed

Indicates normal 
adapter operation. No 
action necessary.

AER3-000203 R3-CORE-
SCH-5000

Error C No class 

definition exists 

for %1

The named class is 
invalid or does not 
exist. Check the 
repository to make 
sure that a valid class 
exists with that name.

AER3-000204 R3-CORE-
SCH-5001

Error C %1 is not a 

modeled class

The named class is 
invalid, non-existent, 
or does not represent a 
modeled class. Check 
the repository to make 
sure that a valid class 
exists with that name.

AER3-000205 R3-CORE-
SCH-5002

Error C No operations 

defined in class 

%1

Modify the class 
definition to include 
operations.

AER3-000206 R3-CORE-
SCH-5003

Error C The operation %1 

does not have any 

parameters

Modify the class 
definition to include 
parameters.
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AER3-000207 R3-CORE-
SCH-5004

Error C The class %1 does 

not specify 

attribute %2

The attribute is invalid 
for the named class. 
Check the repository. 
Re-create the class 
definition (if you 
suspect it has been 
incorrectly created) or 
modify the class 
definition to include 
the named attribute.

AER3-000208 R3-CORE-
SCH-5005

Error C Operation 

description not 

available for %1

The named operation 
is invalid or 
non-existent. Check 
the repository to make 
sure that an operation 
exists with the 
specified name.

AER3-000209 R3-CORE-
SCH-5006

Error C No IDoc operations 

defined in class 

%1

The named class does 
not have IDoc 
operations defined. 
Check the repository 
to make sure that the 
class definition is 
correct. 

AER3-000210 R3-CORE-
SCH-5008

Error C Attribute %1 in 

class %2 is 

invalid

Check the 
configuration.

AER3-000211 R3-CORE-
SCH-5009

Error AD Unsupported type 

%1 for attribute 

%2 in class %3

The named type is 
unsupported by SDK 
or SAP or both.
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AER3-000212 R3-CORE-
SCH-5010

Error AD Unexpected %1 : 

%2; inform 

technical support

Unexpected error. You 
cannot determine the 
cause from the 
description. Contact 
technical support: 
support@tibco.com.

AER3-000213 R3-CORE-
SCH-5011

WARN C Control field 

replacements 

specify an 

attribute %1 which 

does not exist in 

the control record

Control field 
replacements in 
classInstances specify 
an attribute that does 
not exist in control 
record. Check spelling.

AER3-000214 R3-CORE-
SDK-2000

Error AD Cannot access 

class registry

You specified an 
attribute that does not 
exist in the control 
record. Either omit 
that attribute or 
replace it with an 
attribute that exists.

AER3-000215 R3-CORE-
SDK-2001

Error AD Subscriber %1 

received a message 

that has invalid 

wire format

There was an 
exception in the 
Adapter upon receive 
of this message.

AER3-000261 --NEW-- INFO AD Using ini file %1 Indicates normal 
adapter operation. No 
action necessary.

AER3-000262 --NEW-- INFO AD No program ID 

defined in the ini 

file, using 

destination %1 as 

program ID

Indicates normal 
adapter operation. No 
action necessary.

AER3-000263 --NEW-- INFO AD Using Logon Groups Indicates normal 
adapter operation. No 
action necessary.
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AER3-000264 --NEW-- INFO AD Using a dedicated 

connection

Indicates normal 
adapter operation. No 
action necessary.

AER3-000265 --NEW-- INFO AD Creating a Server 

connection

Indicates normal 
adapter operation. No 
action necessary.

AER3-000266 --NEW-- INFO AD Initialized 

successfully

Indicates normal 
adapter operation. No 
action necessary.

AER3-000267 --NEW-- INFO AD CREATED %1 Indicates normal 
adapter operation. No 
action necessary.

AER3-000268 --NEW-- INFO AD EXECUTED %1 Indicates normal 
adapter operation. No 
action necessary.

AER3-000269 --NEW-- INFO AD CONFIRMED %1 Indicates normal 
adapter operation. No 
action necessary.

AER3-000270 --NEW-- Error AD Invalid client 

function specified 

in removeClient 

call

Because this message 
appears during 
shutdown, no action is 
necessary.

AER3-000271 --NEW-- Error C Invalid poolRef 

name %1

poolRef must point to 
a valid pool definition.

AER3-000272 --NEW-- Error C Pool reference not 

provided in Server 

Component

Provide a value that 
corresponds to a valid 
definition.

AER3-000273 --NEW-- Error AD Invalid Connection 

for pool %1

Check the pool 
definitions to ensure 
that they are valid.
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AER3-000274 --NEW-- Error AD Invalid default 

Connection for 

pool %1

Check the pool 
definitions to ensure 
that they are valid.

AER3-000275 --NEW-- Error C No default session 

defined

The configuration 
must either specify a 
valid value for start 
up/default session or 
define at least one 
rvSession/rvCmSessio
n.

AER3-000276 --NEW-- Error AD Duplicate DEST 

parameter defined 

in %1 : %2

Remove duplicate 
definition.

AER3-000277 --NEW-- Error AD Destination %1 not 

defined in %2

Define destination 
given in message.

AER3-000278 --NEW-- INFO AD Received message 

is written to file 

%1

Indicates normal 
adapter operation. No 
action necessary.

AER3-000279 --NEW-- Error AD Exception while 

initializing 

adapter; exception 

type : %1, 

description : %2

Refer to the 
description and take 
the required action.

AER3-000280 --NEW-- Error AD Error: Could not 

send reply for 

function: %1

Refer to the 
accompanying error 
messages for 
additional details.

AER3-000281 --NEW-- Error AD Error while 

invoking 

User-defined 

operation: %1

Refer to the 
accompanying error 
messages for 
additional details.
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AER3-000282 --NEW-- Error AD Receive reply 

failed for: %1

Refer to the 
accompanying error 
messages for 
additional details.

AER3-000283 --NEW-- Error AD Exception during 

one way invocation 

of function: %1, 

Type: %2, 

Description: %3

Refer to the 
accompanying error 
messages for 
additional details.

AER3-000284 --NEW-- INFO AD Request written to 

file: %1 for 

operation: %2

Indicates normal 
adapter operation. No 
action necessary.

AER3-000285 --NEW-- Error AD Error code: %1, 

Message: %2

Refer to the 
description and take 
the required action.

AER3-000286 --NEW-- INFO C 'userExit' class 

does not exist or 

it does not 

contain operation 

%1, operation will 

not be invoked

Indicates normal 
adapter operation. No 
action necessary.

AER3-000287 --NEW-- INFO C There is no 

RpcClient named: 

%1, operation will 

not be invoked

Indicates normal 
adapter operation. No 
action necessary.

AER3-000288 --NEW-- INFO AD Untransformed IDoc 

data sent

Indicates normal 
adapter operation. No 
action necessary.

AER3-000289 --NEW-- INFO AD Performing 

asynchronous 

invocation for 

User-defined 

function: %1

Indicates normal 
adapter operation. No 
action necessary.
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AER3-000290 --NEW-- WARN C No R/3 client 

configured for %1, 

using 

default-client %2

There is no 
deployment-descriptio
n configured for the 
RFC. If not intentional, 
ensure that the client is 
specified in the 
deployment-descriptio
ns for the RFC.

AER3-000291 --NEW-- INFO AD Received request 

for logon to SAP 

R/3 System

Indicates normal 
adapter operation. No 
action necessary.

AER3-000292 --NEW-- INFO AD Successfully 

logged-on to SAP 

R/3 System

Indicates normal 
adapter operation. No 
action necessary.

AER3-000293 --NEW-- INFO AD Received request 

for logoff from 

SAP R/3 System

Indicates normal 
adapter operation. No 
action necessary.

AER3-000294 --NEW-- INFO AD Successfully 

logged-off from 

SAP R/3 System

Indicates normal 
adapter operation. No 
action necessary.

AER3-000295 --NEW-- Error AD No session id 

exists in the 

logoff request

The sessionID 
obtained on 
logging-on to SAP 
system through 
design-time-adapter 
should be passed in 
the RFCCLOSURE 
along with the logoff 
request to successfully 
logoff from SAP 
system
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AER3-000296 --NEW-- Error AD No logon session 

exists for the 

session ID

The sessionID 
obtained on 
logging-on to SAP 
system through 
design-time-adapter 
should be passed in 
the RFCCLOSURE 
along with the logoff 
request to successfully 
logoff from SAP 
system.

AER3-000300 --NEW-- INFO M Created discovery 

subscriber 

successfully using 

subject %1

Indicates normal 
adapter operation. No 
action necessary.

AER3-000301 --NEW-- INFO M Attempting to 

create dynamic 

connection to SAP 

R/3 system

Indicates normal 
adapter operation. No 
action necessary.

AER3-000302 --NEW-- INFO M Attempting to 

close dynamic 

connection from 

SAP R/3 system

Indicates normal 
adapter operation. No 
action necessary.

AER3-000303 --NEW-- INFO M Retrieving list of 

function modules 

from SAP R/3 

system

Indicates normal 
adapter operation. No 
action necessary.

AER3-000304 --NEW-- INFO M Retrieving schema 

for IDoc %1 FROM 

SAP R/3 system

Indicates normal 
adapter operation. No 
action necessary.

AER3-000305 --NEW-- INFO M Retrieving entries 

for table %1 FROM 

SAP R/3 system

Indicates normal 
adapter operation. No 
action necessary.
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AER3-000306 --NEW-- INFO M Retrieving schema 

for 

structure/table %1 

FROM SAP R/3 

system

Indicates normal 
adapter operation. No 
action necessary.

AER3-000307 -NEW-- INFO M Received unknown 

operation %1

TIBCO Designer sent 
an invalid request to 
the design-time 
adapter. If problem 
persists contact 
technical support: 
support@tibco.com

AER3-000308 -NEW-- INFO M Metadata adapter 

operation 

failure:%1; 

operation name : 

%2

Refer to the 
surrounding error 
messages for 
additional details.

AER3-000309 -NEW-- INFO M Retrieving schema 

for RFC/BAPI %1 

from SAP R/3 

system

Indicates normal 
adapter operation. No 
action necessary.

AER3-000310 -NEW-- ERROR AD Received Error 

Advisory Message: 

%1, Subject: %2

This is an error 
advisory thrown by a 
TIBCO Infrastructure 
component. The 
message %1 is 
context-sensitive. 
Report the error to 
TIBCO Support.

AER3-000400 --NEW-- INFO AD Invalid connection 

detected. Message 

: %

Indicates normal 
adapter operation. No 
action necessary.

AER3-000401 --NEW-- INFO AD %1 RFCServers 

registered with 

SAP R/3 system 

with program-id %2 

on GatewayHost %3

Indicates normal 
adapter operation. No 
action necessary.
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AER3-000402 --NEW-- Error AD No session id in 

request for 

operation %1

If the request is for an 
RFC that requires an 
explicit logon to SAP 
system, then the 
sessionID obtained on 
logging-on to SAP /3 
system has to be 
passed in the 
RFCCLOSURE along 
with the RFC request.

AER3-000403 --NEW-- Error AD Unable to obtain 

context for 

implementation of 

operation %1

Look at earlier error 
messages in the 
log-file(s) for possible 
causes.

AER3-000405 --NEW-- Error AD Invalid session id 

passed in request 

for operation %1

The sessionID should 
be a valid string.
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AER3-000406 --NEW-- Error AD Invalid session id 

passed for 

operation %1

If the sessionID was 
obtained after 
logging-on to the SAP 
system, ensure that the 
sessionID passed in 
the RFCCLOSURE 
while invoking a 
request on the 
InboundRFC instance 
is the same as the one 
obtained. Instead, if 
the sessionID was 
obtained for a 
subsequent 
BAPI_TRANSACTIO
N_COMMIT call, 
ensure that the same 
sessionID was passed 
with 
BAPI_TRANSACTIO
N_COMMIT 
invocation. Also check 
if the session created 
for commit/rollback 
has already timed-out 
as specified by the 
'commitExpiry' 
parameter. 

AER3-000407 --NEW-- Error AD Invalid call 

received, 

connection closed 

for thread

The adapter received 
an invalid call from 
the SAP system that 
caused a connection to 
be closed. Ensure that 
the adapter 
connections to SAP 
system are alive.
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AER3-000408 --NEW-- Error AD Server thread 

unable to dispatch 

call, call 

skipped. message : 

%1

The adapter entered 
an invalid state 
because of an invalid 
call from the SAP 
system. See message 
description for more 
details. Ensure that the 
adapter connections to 
SAP system are alive.

AER3-000409 --NEW-- Error AD Server thread 

unable to dispatch 

call, connection 

invalidated

The adapter entered 
an invalid state 
because of an invalid 
call from the SAP 
system. See message 
description for more 
details. Ensure that the 
adapter connections 
with SAP system are 
alive.

AER3-000410 --NEW-- WARN AD Server thread 

exited, message : 

%1

The adapter 
encountered an 
exception condition 
that caused the server 
thread to exit. Look at 
earlier messages in the 
log-file(s) for possible 
causes. No resolution 
necessary.

AER3-000411 --NEW-- Error C No poolRef 

specified for 

operation %1

The RFC does not have 
a 'poolRef' attribute in 
its deployment 
description. Ensure 
that a valid 'poolRef' is 
specified for the RFC.
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AER3-000412 --NEW-- INFO AD Obtaining 

connection for R/3 

client %1 for %2

Indicates normal 
adapter operation. No 
action necessary.

AER3-000413 --NEW-- Error AD The session for 

commit/rollback 

timed out for 

operation %1

Ensure that the 
BAPI_TRANSACTIO
N_COMMIT call is 
triggered in the SAP 
system before the 
session for 
commit/rollback 
times out as specified 
by the 'commitExpiry' 
parameter.

AER3-000414 --NEW-- INFO C No session timeout 

specified for 

commit/rollback 

for operation %1, 

defaulting to %2 

seconds...

The 'commitExpiry' 
parameter defaults to 
60 seconds if it is not 
specified. If this value 
is insufficient, ensure 
that a higher value is 
specified for the 
parameter.

AER3-000415 --NEW-- INFO AD Session timeout 

for 

commit/rollback 

for operation %1 

set to %2 seconds

Indicates normal 
adapter operation. No 
action necessary.

AER3-000417 --NEW-- INFO AD Connection pending 

commit for 

operation %1

Indicates normal 
adapter operation. No 
action necessary.
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AER3-000418 --NEW-- Error AD Invalid client 

specified : %1
Ensure that a valid 
client is specified for 
the RFC/IDoc in their 
respective deployment 
descriptions, if any. 
Else ensure that the 
'defaultClient' 
attribute specified in 
client connectionpool 
is a valid client.

AER3-000419 --NEW-- INFO AD Created new thread 

for RFCServer
Indicates normal 
adapter operation. No 
action necessary.

AER3-000420 --NEW-- INFO AD Server thread(s) 

stopped for 

Component %1

Indicates normal 
adapter operation. No 
action necessary.

AER3-000421 --NEW-- Error AD No valid 

connection handle 

available for 

server for 

operation %1

The outbound adapter 
could not get a valid 
connection handle to 
the SAP system. Look 
at earlier messages in 
the log-file(s) for 
possible causes

AER3-000422 --NEW-- Error C No client 

specified in 

deployment 

description for 

operation %1

Ensure that a client is 
configured for the 
operation

AER3-000423 --NEW-- Error C No poolRef 

specified for 

operation %1

Ensure that a poolRef 
is specified for the 
operation

AER3-000424 --NEW-- Error C No default client 

specified for 

operation %1

Ensure that a 
defaultClient is 
specified for the 
operation
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AER3-000425 --NEW-- Error C Invalid poolRef 

specified in 

deployment : %1

Ensure that a valid 
poolRef is specified in 
the deployment 
description for the 
RFC/IDoc

AER3-000426 --NEW-- INFO AD Thread monitor 

started for %1 

server thread(s)

Indicates normal 
adapter operation. No 
action necessary.

AER3-000427 --NEW-- Error AD No active 

connections 

available in 

configuration, 

exiting...

This indicates that all 
the SAP systems the 
adapter is connected 
to, are down and none 
of the connections 
established by the 
adapter with the SAP 
system are active. 
Ensure that the SAP 
systems are up and 
running.

AER3-000428 --NEW-- WARN C Interface %1 does 

not contain 

deployment 

description for 

RFCs... 

continuing...

The adapter could not 
find deployment 
descriptions for any 
RFC. If it is not 
intentional, ensure 
that the RFC 
configuration is 
correct.

AER3-000429 --NEW-- WARN C No deployment 

description 

available for idoc 

%1...using 

default…

The adapter could not 
find deployment 
descriptions for the 
specified IDoc. If it is 
not intentional, ensure 
that the IDoc 
configuration is 
correct.

Table 25   Error Messages with Changed Codes
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AER3-000430 --NEW-- INFO AD Total requests 

processed : %1
Indicates normal 
adapter operation. No 
action necessary.

AER3-000431 --NEW-- Error AD Unable to create 

marshaller for 

operation %1

Look at earlier error 
messages in the 
log-file(s) for possible 
causes.

AER3-000432 --NEW-- Error AD Unable to clone 

proxy for 

operation %1

Look at earlier error 
messages in the 
log-file(s) for possible 
causes.

AER3-000433 --NEW-- Error AD Unable to clone 

RFC client for %1

Look at earlier error 
messages in the 
log-file(s) for possible 
causes.

AER3-000434 --NEW-- Error AD Unable to clone 

function 

implementation for 

operation %1

Look at earlier error 
messages in the 
log-file(s) for possible 
causes.

AER3-000435 --NEW-- Error AD Unable to create 

listener for 

call-operation

Look at earlier error 
messages in the 
log-file(s) for possible 
causes.

AER3-000436 --NEW-- Error AD Unable to create 

reply listener for 

operation %1

Look at earlier error 
messages in the 
log-file(s) for possible 
causes.

AER3-000437 --NEW-- Error AD Unable to clone 

subscriber 

implementation

Look at earlier error 
messages in the 
log-file(s) for possible 
causes.
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AER3-000438 --NEW-- Error AD Unable to generate 

transaction-id. 

message : %1

Look at earlier error 
messages in the 
log-file(s) for possible 
causes.

AER3-000439 --NEW-- Error AD Unable to create 

implementation for 

thread

Look at earlier error 
messages in the 
log-file(s) for possible 
causes.

AER3-000440 --NEW-- Error AD Unable to create 

server thread

Look at earlier error 
messages in the 
log-file(s) for possible 
causes.

AER3-000441 --NEW-- INFO C TID management is 

remote

Look at earlier error 
messages in the 
log-file(s) for possible 
causes.

AER3-000442 --NEW-- Error AD Connection context 

lost. Operation %1 

failed

Look at earlier error 
messages in the 
log-file(s) for possible 
causes.

AER3-000443 --NEW-- Error AD Logon to SAP R/3 

system failed. 

message : %1

Look at earlier error 
messages in the 
log-file(s) for possible 
causes.

AER3-000444 --NEW-- Error AD Error writing to 

TID file for 

transaction %1

Ensure that the TID 
file has write 
permissions.
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AER3-000446 --NEW-- Error AD No active 

connections in 

connection-pool 

%1. All retry 

attempts 

exhausted. 

Connections for 

this pool 

deactivated.

Ensure that the SAP 
system pointed to by 
the connection-pool 
%1 is up and running.

AER3-000447 --NEW-- Error AD No active 

connections in 

connection-pool 

%1. All retry 

attempts 

exhausted. 

Exiting...

This indicates that all 
the SAP systems the 
adapter is connected 
to, are down and none 
of the connections 
established by the 
adapter with the SAP 
system are active. 
Ensure that the SAP 
systems are up and 
running.

AER3-000448 --NEW-- INFO AD Suspended endpoint 

component %1
None.

AER3-000449 --NEW-- INFO AD The Application 

Manager has been 

flagged to restart 

on re-establishing 

connection to R/3.

None.

AER3-000450 --NEW-- INFO AD Created timer to 

check connectivity 

to R/3.

None.
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AER3-000451 --NEW-- WARN AD Adapter 

application will 

restart now

The adapter is 
recovering missed 
messages by 
performing an 
internal-restart. 
Ensure that the 
adapter has performed 
a restarted 
successfully by 
checking the adapter 
log files.

AER3-000452 --NEW-- INFO AD Adapter 

application %1 is 

restarting on host 

%2.

None.

AER3-000453 --NEW-- WARN C Invalid 

control-field 

replacement 

attribute %1 

skipped.

A control-field name 
%1 not present in the 
IDoc's control record 
was specified for 
replacement. Ensure 
that the field name is 
one of those defined 
for the IDoc's control 
record.

AER3-000454 --NEW-- INFO AD Performing oneway 

invocation for 

User-defined 

function: %1

None.

AER3-000455 --NEW-- Error C No class 

description 

available for 

explode sequence 

%1

Check the repository 
under 
/tibco/public/adap

ter/SAPAdapter40/<

sap 

version>/IDOCS/ for 
the class description 
for class %1.
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AER3-000456 --NEW-- Error C No attribute 

description for 

explode sequence 

%1

Check the repository 
for attribute 
description for 
explode sequence %1.

AER3-000457 --NEW-- Error AD Operation %1 

requires external 

logon. The request 

does not contain 

sessionID in the 

closure data.

Supply the session-id 
parameter in the 
RFCCLOSURE data of 
the incoming request.

AER3-000500 --NEW-- WARN AD Unsupported 

datatype: class  

%1. Parameter: %2

This datatype is not 
supported.

AER3-000461 --NEW-- Error AD Connection Error. 
Unable to create a 
connection with the 
target application %1 
using connection 
parameters %2 and 
the target application 
error is %3

Ensure that valid 
connection parameters 
have been specified 
and that the SAP 
server is not down.
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